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Welcome to EFM Feedback   

Vovici is pleased to announce the release of EFM Feedback. 
 
With this new release, we have introduced many new features and you will notice major 
changes to the User Interface.  This new design has been created to enhance the ease of 
use of the application as well as present a product environment that is easy to comprehend. 
 
This EFM Feedback User Guide provides you details on all of the features of the EFM 
Feedback product.  It also includes a Table of Contents, Glossary and Index for easy 
navigation to find what you need quickly.  

Note:   The current most up-to-date documentation source will always be the 
Online Help that accompanies the EFM Feedback Application as it is updated often. 
 
The User Guide is broken down by tab section separators as well as chapters within those 
tabs.  The main tabs (with chapter designations are listed below). 
 

• Getting Started 
o Overview 
o System Requirements 
o Product Overview 
o Navigating in the New User Interface 

• Feedback 
o Chapter One Feedback Home Page 
o Chapter Two Creating a Survey 
o Chapter Three Options Once You Create Your Survey 
o Chapter Four How to Add questions to Your Survey 
o Chapter Five Survey Question Types 
o Chapter Six Survey Question Editing 
o Chapter Seven Publishing Your Survey 

• Mailing Lists/Campaigns 
o Chapter Eight Mailing List Home Page 
o Chapter Nine Invite People to Take Your Survey (Campaigns) 

• Survey Management 
o Chapter Ten Survey Management 

• Survey Editing 
o Chapter Eleven Survey Editing Properties 
o Chapter Twelve Survey Editing Actions 

• Analyzing/Reporting Your Results 
o Chapter Thirteen Analyzing and Reporting Your Results 

• My Account 
o Chapter Fourteen My Account Home Page 

• Administration 
o Chapter Fifteen Administration Home Page 

• Polls 
o Chapter Sixteen Polls 

• Chapter Seventeen How Do I Login 
• Frequently Asked Questions 
• Glossary/Index 
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Getting Started Overview 

We've created Flash tutorials to help you get started quickly and easily.  Click the links to 
begin each video while in the Online Help System. 
 

FLASH 
TUTORIALS 

 

 

Four Phases of Survey Creation Tutorial 

Survey Creation Tutorial 

Mailing Lists/Campaigns Tutorial 

Analysis Tutorial 

Administration Tutorial 
 

 
 
This section will help you get started using the Vovici EFM Feedback application quickly 
and easily.  It contains information on the steps needed to get your survey up and running.   
 
The primary steps to getting started are: 
 

1. Create your survey 
2. Edit your survey 
3. Publish your survey 
4. Send invitations to users 
5. Analyze your results 
6. Report on your results 

  

Create your survey 

The first time you view your survey workspace, chances are that the workspace is empty.  If 
you have an empty workspace, then you will begin by clicking the Create New Survey 
button.  You'll be presented with a selection page containing the following options: 
 

Start with a blank survey 
Build your survey by adding questions and response options.  Questions can be 
manually added or selected and inserted from a question library. 
Open a sample survey (not publishable) 
Peruse our powerful analysis and reporting tools using the sample data provided. 
Copy a survey  
You can duplicate a survey that already exists in your account. 
Create a survey from a template 
You can select a survey template to use from our library, and then make edits as 
necessary. 
Build a survey from a MS Word (.doc) file/Upload a WebSurveyor Desktop 
(.wsx) file 
You can import a Word document as the basis for your survey, or upload a 
WebSurveyor Desktop file to work with. 
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There are various types of questions that can be used in your survey.  To learn more about 
these question types, see the Standard Question Types topic.  

 
Add questions to your survey by clicking on the New Question button when you select Edit 
Survey.  You can also quickly create questions by using the Question Library feature.  
 
After you have entered your questions you will want to confirm that your survey Properties 
information is correct.  The Title, Text & Limits option contains fields for text that can be 
included in your survey as well as security settings that can be applied to control access to 
your survey.  You can Preview your survey and try changing the Presentation options to 
enhance the display.  Once you are satisfied with the look and feel of your survey, you're 
ready to publish it and start collecting results.  
 
 

Publish Your Survey 

The process of publishing your survey generates the survey link that will be provided to 
your end users.  You provide this link to your survey recipients when you send them an 
invitation to take your survey.  
 
 

Send Invitations to Users 

Once your survey is published, you'll need to let your users know how to access and take 
your survey so you can begin collecting results.  You can send invitations to users through 
our Mailing Lists feature, which allows you to send the survey to all your recipients at once 
and track status of your invitations.  You'll see actual counts covering base number of 
recipients, number sent, number bounced, how many recipients clicked the URL and how 
many recipients submitted your survey. 
 
 

Analyze Your Results 

Once your survey is published and people have submitted the survey, you can begin to 
analyze the results. You can view your data in a variety of ways.  You'll be able to create a 
variety of reports to view within the application or online (public report).  You can filter your 
data and work with a subset of results, and you can view the raw data as well.  For more 
detailed explanations, please view the Analysis section of Help.  
 
 

The Survey Process 

For a better understanding of the life cycle of a typical survey please see the Product 
Overview.  
 
 

Additional Information for New Users 

If you are new to Vovici, please visit the FAQ section. 
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System Requirements 

HTML 

All HTML code shall conform to HTML 4.01 guidelines. 
 

Note! 
All survey HTML generated by EFM Feedback conforms to HTML 4.01 guidelines and 
is Section 508 compliant.  (However, this may not include HTML that a survey 
author adds or customizes.) 

  

Survey Creation 

Internet Explorer version 6.0 and higher 
Firefox version 1.5 and higher 

 

Survey Taking 

Internet Explorer version 5.0 and higher 
Firefox version 1.0 and higher 
Safari version 2.0 and higher 
 

Intranet Server Solution 

Windows 2000 Server and Advanced Server (32-bit) is supported 
Windows 2003 Server (32-bit only) is supported 

 

Intranet Server System Requirements 

Standard web browser 
32-bit version of Windows 2000 or 2003 server platforms 
Microsoft MSDE or SQL Server 2000 
Microsoft IIS with ASP scripting enabled 
Public IP Address 
1GB system memory (2GB recommended) 
Minimum of 150MB free disk space 
Internet Connection 
Server License Key (provided by Vovici) 
Microsoft .NET Framework 2.0 
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Product Overview 

In this topic we discuss the Survey Life Cycle process for Vovici EFM Feedback and 
Reporting.  Our goal is to help you gain a better understanding of the product's inner 
workings. 
 
We also want you to understand how each step of the process is important in helping you 
gather the information you need from your employees, clients and partners, which in turn 
will help you make well-informed decisions based on your survey results. 
 

The Survey Life Cycle 

There are typically five basic stages in the life cycle of a survey.  For more information on 
each process, see the topics below. 
 

1. Edit Survey - Edit and review your survey questions and properties. 
2. Publish Survey - Create the link to make the survey available to users on the 

internet. 
3. Invite Respondents - Create a Campaign and invite people to take your survey. 
4. Analyze Data - Analyze and export your survey data. 
5. Create Basic Report - Create, modify and make public your survey results.  Create 

basic and advanced reports. 
 
A survey begins when you create a new survey.  When a new survey is created, it is stored 
in the List Pane of your Feedback Page.  Once this survey has been finalized and tested 
and you are ready for people to take your survey, you "publish" it.  Publishing a survey 
creates a copy of your survey in the Published Area, and creates the URL (link) that you 
send out to people in your invitation message campaign. 
 
Note! 
Any changes you make to your working version will not appear in the public 
version until you "republish" the survey.  
 
Once the survey has been published the response collection period begins.  As soon as the 
survey starts collecting responses, you can begin analyzing the results. 
 
 
See related topics:  View/Edit the Data, Reset Results
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Navigating in the New User Interface 

Naming Conventions and the New User Interface 

Provided below is a screen shot of the New User Interface along with the Naming 
Conventions that have been applied for each section.  Become familiar with this terminology 
as it will aid you in getting started quickly and navigating to where you want to be.  These 
terms are used throughout the Help System. 
 

 
Feedback Page
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Question Editor Dialog 
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Navigating in the Online Help System 

 About Context Sensitive Help 

With the release of EFM Feedback, Vovici has introduced a new Context-Sensitive Help 
System.  The term “Context-Sensitive” Help means that help is available from within the 
Application itself.  You can get help quickly anytime by accessing help through links and 
icons on your screen throughout the application. 
 

Help Link Description 

Help Displays the complete help system 

Help with this Page Displays a context-sensitive help topic relevant to your 
current task 

 
Displays a context-sensitive help topic relevant to your 
current task 

 

 
Quick tips are available throughout the application and they 
are relevant to where you currently are in the application.  
Click the tip title and that topic will display in a separate 
window.   
 
You also have Frequently Asked Questions (FAQs) available.  
Click this link and a list of FAQs is displayed relevant to 
where you are in the application. 
 
The complete User Guide (PDF) can be downloaded to a 
location of your choice.  Click this link and you are asked if 
you want to save or open the file. 

Table of Help Links 
 
 
The EFM Feedback Help system covers all of the main functional areas of Feedback, Polls, 
Mailing Lists, My Account and Administration.  It is then broken down into individual 
concise topics to provide comprehensive coverage of all of the features of the application. 
 
The Help system is displayed in a Tripane format environment.  There is a Navigation Bar 
along the top that houses the Contents, Index, Glossary and Search buttons.  The Contents 
button is selected by default when the help opens, therefore, the table of contents displays 
in the left Navigation Pane.  The right pane is the Topic Information Pane and displays the 
topic details of the current topic that you have selected from the Contents within the 
Navigation Pane.  
 
The Table of Contents format is broken down into 'books' with related topics under each 
book.  You simply click a book to view topics within that book structure and click a topic and 
it is displayed in the Topic Information Pane on the right. 
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Within each topic there are links to other related topics to the current subject matter.  You 
click the link to go directly to that topic and click the “Previous Topic” button in the 
Navigation Bar to return to your original topic.  Note:  You can also right click in the 
Information Pane and select back to return to your original topic. 
 
There is a 'welcome' page that guides the user to 'Getting Started' and 'What's New' topics.  
From within these topics the user is linked to other related topics if they feel they need 
additional information. 
 
Screenshots are included in most topics to give the user a visual reference.  The system also 
has “Show Me” links.  “Show Me” links are simply links to a screen shot that pops up for 
quick reference and closes once you click out of the popup area.  They provide the user a 
quick look at what the documentation text is referencing.   

 

Tripane Window Environment and Help Details 

 

 
EFM Feedback Help System 
 
 
 

The Tripane Window Environment includes 

1. A Navigation Bar 
2. A Navigation Pane 
3. A Topic Information Pane 
4. Keyword Search 
5. Browse Sequence Arrows
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1. Navigation Bar 

Button Description 
Contents The help system opens with the Table of Contents showing in the 

Navigation Pane.  This is the default.  The Table of Contents provides you 
navigation throughout all of the help topics.  Click on any topic in the 
Contents and that topic is displayed in the Topic Information Pane. 
 

Index Select the Index button if you want to see a full index of all of the topic 
keywords contained in the help system in alphabetical order.  Once the 
Index button is selected the index displays in the Navigation Pane. You can 
click on any word in the Index and you will be taken to the topic that 
contains that index word.    
 

Search Select the Search button, if you want to conduct a keyword search in the 
help system.  Click Search and the search text box opens.  Type in the 
word(s) you want to search for in the text box and click the Go button.       
 
You will be presented with a list of topics where your search word was 
found.   Click any topic and that topic will be displayed in the Topic 
Information Pane.   
 

Glossary Select the Glossary button if you want to see a Glossary of terms along 
with their definitions that are used throughout the Help System.     
 

Previous 
Topic 

The Previous Topic button takes you back to the topic you viewed 
previous to the one you are currently in.  There is no limit as to how many 
times you can click this button (except when you get back to your original 
topic and there are no other topics in your back history)   
 
For example, if you clicked around in the navigation pane on several 
different topics and you wanted to get back to your original topic you 
clicked first, you just click the Previous Topic button until you get back to 
where you want to be.  You can also use the Table of Contents to take 
you back, simply click on the topic in the Navigation Pane and that topic is 
displayed. 
 

Navigation Bar Table 
 
 
 

2.  Navigation Pane 

The Navigation Pane contains specific information depending on what button is selected in 
the Navigation Bar.  The choices are Contents, Index, Search, and Glossary.  These 
buttons are explained in the Navigation Bar table above.    
 
When the Navigation Pane displays the table of contents, you simply click the topic that you 
want to see and it is displayed in the Topic Information Pane. 
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There are ? icons that represent a topic and book icons that represent a folder that contains 
topics.  If you click a topic that has the ? icon, that topic displays in the Topic Information 
Pane.  When you click the book icon it displays all of the topics contained in that book.  Then 
you select a topic and it displays in the Topic Information Pane. 
 
 

 
Topic and Book Icons 
 
 

3.  Topic Information Pane 

The Topic Information Pane is used to display topics.  You use this area to read the 
current topic and link to other related topics from within this area as well.  
 
Throughout the help topics you will come across "See Also" links.  These are links to other 
topics that are related to the topic you are currently in.  Click the topic subject and that topic 
will display. 
 
 

4. Keyword Search 

Keyword search is used to search for key terms within the Help system.  There are two 
ways to start a search.  You click inside the Keyword Search text box, type your word(s) and 
select Go.  Or you click the "Search" button on the Navigation Bar and the search text box 
opens in the Navigation Pane and you type your word(s) and select Go.   
 
You will be presented with a list of topics where your search word was found.   Click any 
topic and that topic will be displayed in the Topic Information Pane.   

  

5. Browse Sequence Arrows 

 
Browse Sequence Arrows 
 
 
The arrows located in the screen shot above are your Browse Sequence Arrows.  When you 
click a topic in the Navigation Pane, that topic displays.  If you click on a topic that is under 
a book icon, that topic displays, and you have the option to use the Browse "Sequence 
Arrows" to browse to the next topic in the book sequence.  Simply click the arrows back and 
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forth to navigate through the book of topics.  The left arrow takes you back a topic and the 
right arrow takes you to the next topic in the sequence. 
 

 
Book and ? Icons 
 
 
Tips: 

You can close the navigation pane by selecting the  
red X.  You can reopen by clicking the contents button on the navigation bar. 
 
You can also resize the Navigation Pane by placing your mouse on the vertical line 
that separates the Navigation Pane from the Topic Information Pane.  When you 
see the double arrows appear, left click and drag the line to the left or right 
depending on if you want to make it smaller or larger respectively. 
 

June 2007                                                                                                             Page 21 of 291 



EFM Feedback User Guide  Surveys/Feedback Overview 

 
 
 

Chapter One 

Surveys/Feedback Overview 
 
 
 
 
 
 
 
 
 

Discussed in this Chapter 
Main Surveys Page 
List Pane 
Options Pane 
Info Pane 
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Feedback Home Page (Surveys) 

Feedback Page (Surveys) 

Use:  The Feedback Page is the default landing page that displays when you login to your 
account.  A list of your surveys is shown and there are various actions that can be taken for 
a survey. 
 
There are navigation tabs across the top of the page to take you to other major functions 
of the application. 
 
The tabs are as follows: 
 

• Feedback 
• Polls 
• Mailing Lists 
• Reporting 
• My Account 
• Administration 

 
 

 
Navigation Tabs 
 
 
Directly under the Navigation Tabs is the Create New Survey button. 
 
To create a new survey, make a copy of an existing survey, or open a sample survey, click 
the Create New Survey button.  For more information, please go to Getting Started. 
 
The Feedback Page is broken up into panes, each giving you access to information about 
your account and your surveys.   
 
The Feedback Page contains: 
 

• List Pane 
• Options Pane 
• Info Pane 

 
 
Visit the topics above for more information.
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List Pane 

The List Pane is located on the left side of the Feedback Page.  The List Pane displays a 
list of your current surveys and their status.     
 
The List Tool Bar controls actions that can be taken against your survey, as well as 
additional information on each survey including the survey title, the date it was created, the 
date of the last response received and the number of responses.  Icons displayed to the left 
of the survey name show its status. 
 

 
Feedback List Pane
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Options Pane 

The Options Pane is located in the center of the main Feedback Page and contains links 
to the five options that are available to you once you create a survey.  Visit the topics below 
for more information. 
 

• Edit Survey 
• Publish Survey 
• Invite Respondents 
• Analyze Data 
• Create Basic Report 

 
The options will be available according to the current stage of your survey.   

 
 

 
Feedback Options Pane
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Information Pane 

The Info Pane is located on the far right of the main Feedback Page and displays a 
graphical representation of the survey that you have currently selected in the List Pane.  An 
example is shown below. 
 
The survey name will be shown and the number of total responses received.  The graph will 
show when responses were received, and provide percentages for completion and 
abandonment of the survey. 
 

 
Feedback Info Pane 

June 2007                                                                                                             Page 26 of 291 



EFM Feedback User Guide  Creating a Survey 

Chapter Two 

Creating a Survey 
 
 
 
 
 
 
 
 

Discussed in this Chapter 
Create New Survey 
Start With a Blank Survey 
Open a Sample Survey 
Copy an Existing Survey 
Create Survey from Template 
Create New Survey from Word File 
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Creating a Survey 

Create New Survey 

From the Feedback Home Page, click the Create New Survey button, and then create 
your survey by selecting one of the following options from the Create Survey Wizard dialog: 
 
 
Start with A Blank Survey 
Begin to build your survey by adding questions and response options.  Questions can be 
manually added or selected from a question library. 

 
Open a Sample Survey (Not Publishable) 
View our powerful analysis and reporting tools using the sample data provided. 
 
Sample surveys can be edited but cannot be published.  If you want to base your survey off 
the sample, you must first copy the sample survey. The copy will be treated as a new survey 
and editing/publishing access will be available as normal. 

 
Note! 
Remember that you must first add the Sample Survey to your account through 
'Create New Survey' before you can copy it. 

 
Copy a Survey  
You can duplicate a survey that already exists in your account.  A new, unpublished survey 
will be created. 
 
Note! 
The responses that were included with the original survey will not be carried over 
to the new survey. 

 
Create a survey from a template 
You can select a survey template from our library and make any edits you desire. 
 
Build a survey from a MS Word (.doc) file/Upload a WebSurveyor Desktop (.wsx) 
file 
You can import a Word document as the basis for your survey, or upload a WebSurveyor 
Desktop survey file to work with. 
 
Use the Browse button to locate the Word file you want to use.
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Create Survey Wizard
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Start with a Blank Survey 

You can build your survey by adding questions and response options.  Your questions can be 
manually added or selected from a question library. 
 

Steps 

1. From the main Feedback Page, click Create New Survey. 
2. From the Create Survey Wizard dialog, select Start with a Blank Survey. 
3. Click OK. 
4. A dialog to Enter the survey details is displayed. 
5. Fill in your Survey Title. 
6. Enter an Introductory message.  This is the text that will be displayed at the 

beginning of your survey.  Example:  Please take my survey. 
7. Enter a Closing message.  This is the text that will be displayed at the end of 

your survey.  Example:  Thank you for taking my survey.  
8. You can enter descriptive comments for your own use in the Comment text box. 
9. Click Finish. 
10. Click New Question to start adding questions to your survey. 
 
 

Note! 
Entering your survey title, introductory or closing message is optional at this 
point.  You can enter them here, or they can be entered through the Title, Text & 
Limits option under Properties when you select Edit Survey. 
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Create Survey Wizard
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Open a Sample Survey 

Your sample surveys are completed surveys that include sample results.  They provide 
valuable information that helps you build your own surveys. 
 
Sample surveys also help you test the functionality of the tool, and experience the 
capabilities of the Analysis and Reporting options. 
 
You can copy and edit sample surveys. 
 
Note! 
A sample survey cannot be published. 

Steps 

1. From the main Feedback Page, click Create New Survey. 
2. From the Create Survey Wizard dialog, select Open a Sample. 
3. Click OK. 
4. Select the sample survey to be added to your account. 
5. Click Open Sample. 

 

 
Create Survey Wizard
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Copy an Existing Survey 

You can use the Copy a Survey option to duplicate an existing survey in your account. 
 

To copy an existing survey 

1. While in the main Feedback Page, click the Create New Survey button. 
2. From the Create Survey Wizard dialog, select Copy a Survey. 
3. Click OK. 
4. A dialog box displays with a list of your current surveys.  Select the survey 

you wish to copy from the list. 
5. Click Next. 
6. A dialog to Enter the survey details is displayed. 
7. Fill in your Survey Title. 
8. Enter an Introductory message.  This is the text that will be displayed at 

the beginning of your survey.  Example:  Please take my survey. 
9. Enter a Closing message.  This is the text that will be displayed at the end of 

your survey.  Example:  Thank you for taking my survey. 
10. You can enter descriptive comments for your own use in the Comment text 

box. 
11. Click Finish. 
12. You are now taken to the Question List Pane where you can begin editing 

your survey. 
 
Note! 
If you decide not to enter a title for your survey and the survey was previously 
published, the name will show in the survey list as (Untitled)(##.htm), where 
'##.htm' represents the last node in the survey URL. 
 
If you decide not to enter a title for your survey and the survey has never been 
published, it will show in the list as (Untitled). 
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Create Survey Wizard
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Create a Survey from a Template 

You can create your survey by using one of the existing predefined templates from our 
library.   
 
When a survey is selected from within a category, a brief description of what it contains is 
displayed. 
 

Steps 

1. From the main Feedback Page, click Create New Survey. 
2. From the Create Survey Wizard dialog, select Use an existing template 

from our library. 
3. Click OK. 
4. Select a template category, click Next. 
5. A dialog box displays with the surveys that are available. 
6. Select one of the survey templates within that category, click Next. 
7. Enter text for Survey specific parameters, click Next. 
8. Select a template for your survey from the Survey presentation dialog 

box.  Once you select a template, a preview of that template is displayed in 
the box to the right. 

9. Click Next. 
10. Fill in your Survey Title. 
11. Enter an Introductory message.  This is the text that will be displayed at 

the beginning of your survey.  Example:  Please take my survey. 
12. Enter a Closing message.  This is the text that will be displayed at the end of 

your survey.  Example:  Thank you for taking my survey. 
13. You can enter descriptive comments for your own use in the Comment text 

box. 
14. Click Finish. 

 
Note! 
Entering your company name, survey title, introductory or closing message is 
optional at this point. You can enter them here, or they can be entered through the 
Title, Text & Limits option under Properties when you select Edit Survey. 
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Create Survey Wizard
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Create a New Survey from a MS Word File 

You can create a survey in your account from a MS Word file. 
 
Note! 
Your MS Word document must be properly formatted in order for survey questions 
to import correctly.   
 
See related topics:  Importing a Survey from a Word Document, Creating Survey 
Questions Using MS Word 
 

Steps 

1. From the main Feedback Page, click Create New Survey. 
2. From the Create Survey Wizard dialog, select Build a survey from a MS 

Word (.doc) file. 
3. Click Browse to navigate to the MS Word file you want to use. 
4. Click OK to import the MS Word file into the application.   
5. You will be placed in the question list where you can begin to edit the survey. 

 
Note! 
You can also upload a WebSurveyor Desktop survey file (.wsx) using this same 
procedure. 
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Create Survey Wizard 
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Importing a Survey from a Word Document Overview 

You can create a survey by importing a properly formatted MS Word document into EFM 
Feedback.  Basic formatting requirements for your MS Word document are described 
below.  For detailed information about properly formatting your questions and responses in 
MS Word refer to the 'Creating Survey Questions Using MS Word' topic.   
 
See related topics:  Create New Survey from Word File, Creating Survey Questions 
Using MS Word 
 
 
Note! 
EFM Feedback is compatible with MS Word versions 97 through 2003. 
For the best results in survey creation, Vovici recommends you use the EFM 
Feedback tool to create your surveys. 
 
 
If you choose to design surveys in MS Word, check the following default options in MS Word 
to ensure proper survey formatting. 
 
In MS Word, select Tools | AutoCorrect Options from the menu bar.  
 

• On the AutoCorrect tab, clear the check box for 'Capitalize first letter of sentences.' 
• On the AutoFormat As You Type tab, clear the check boxes for 'Automatic bulleted 

lists,' 'Automatic numbered lists' and 'Border lines.'  
 

Formatting Requirements 

Formatting  Description 

Page break 
To add a page break to the survey, simply add a page break in MS 
Word.  Either Ctrl+Enter or Insert | Break, Page Break. 

S. or s. (Section) 

A section is used to separate areas within a page. 
A section begins with S. or s. 
Text imports as an HTML snippet. 
 
**Note:  Space should be manually added after the section header 
by coding a hard return (<br>) in MS Word, or by enclosing your 
section text inside HTML paragraph tags (<p>section text 
here</p>).  You can also add hard returns (hit Enter key) when 
editing the HTML Snippet in EFM Feedback. 

Text formatting  

We currently support Bold Italic Underline Subscript Superscript 
Color and Highlight. 
Additional formatting properties may easily be added within EFM 
Feedback. 
We also support Unicode. 

Basic Formatting Requirements
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Creating Survey Questions Using MS Word 

 

What You Will Enter in 
 MS Word 

What You Will See in EFM Feedback 
 

Notes 
 

 
Question Headings 

 
1.   This is my question text. 
2)  This is my question text. 

1)  This is my question text. 
2)  This is my question text. 

Each question must start 
with a question 
heading.  A question 
heading is designated 
by a number and must 
be followed by a period or 
by a right parenthesis.  
 
In the question heading 
example please note that 
it does not matter if you 
use a period or right 
parenthesis in MS Word, 
they both invoke the 
same output in EFM 
Feedback which is a 
numbered question with a 
parenthesis as this is the 
default setting. 
 

 
Alert! 
Questions must have response options defined or they will be displayed as HTML snippets in 
EFM Feedback even when a question heading is used. 
 
The auto-numbering feature in MS Word cannot be used to set up the survey questions. 
 

 
HTML Snippet 

 
This is an HTML snippet. This is an HTML snippet. Any text that is not 

related to a question 
heading will be imported 
as an HTML Snippet (plain 
text). 
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What You Will Enter in 
 MS Word 

What You Will See in EFM Feedback 
 

Notes 
 

 
Question Examples 

 
Choose One (show all) Question 
 
m  Choice 1 
m  Choice 2 
m  Choice 3 
m  Other __________ 
 
OR 
 
()  Choice 1 
()  Choice 2 
()  Choice 3 
()  Other __________ 
 

 This is a Choose One 
(show all) question. 
 
An “Other” may be 
included by adding a 
series of underscores to a 
choice.  Only a single 
“Other” is supported, so 
more than one will be 
ignored 

Choose One (horizontal display) Question 
 
m Choice 1  <tab>  
m Choice 2  <tab> 
m Choice 3 
 
OR 
 
() Choice 1  <tab> 
() Choice 2  <tab> 
() Choice 3 

 

This is a Choose One 
(horizontal display). 
 
Alert! 
Use tabs to separate 
the response options in 
MS Word to ensure that 
they will display 
correctly when 
imported into EFM 
Feedback. 
 

 
 
Tip! 
The layout for response options for Choose One questions can also be changed in the 
question editor within EFM Feedback to display the response options in a horizontal, vertical 
or a drop-down list format.  The change is made on the Advanced tab when editing the 
question. 
 
 
Choose All That Apply Question 
 
q  Choice 1 
q  Choice 2 
q  Choice 3 
q  Other __________ 
 
OR 
 
[]  Choice 1 
[]  Choice 2 
[]  Choice 3 
[]  Other __________ 
 

This is a Choose All That 
Apply question. 
 
An “Other” may be 
included by adding a 
series of underscores to a 
choice.  Only a single 
“Other” is supported, so 
more than one will be 
ignored. 
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What You Will Enter in 

What You Will See in EFM Feedback Notes 
 MS Word 

 
Choose All That Apply (horizontal display) Question 
 
q Choice 1  <tab> 
q Choice 2  <tab> 
q Choice 3 
 
OR 
 
[] Choice 1  <tab> 
[] Choice 2  <tab> 
[] Choice 3 
 

This is a Choose All That 
Apply (horizontal 
display) question. 
 
Alert! 
Use tabs to separate 
the response options in 
MS Word to ensure that 
they will display 
correctly when 
imported into EFM 
Feedback. 
 

 
Tip! 
The layout for response options for Choose All That Apply questions can be changed in the 
question editor within EFM Feedback to display in a horizontal or vertical layout.  The change 
is made on the Advanced tab when editing the question. 
 
Fill In The Blank (limited text) Question 
 
5. This is a Fill In The Blank 
(limited text) question. 
 
Item _______________  

This is a Fill In The 
Blank (limited text) 
question. 
 
The number of 
underscores you enter 
determines the length of 
the text. 
 

Essay (unlimited text) Question 
 
6. This is an Essay 
(unlimited text) question. 
 
_________________  

Please note that the line 
representing the text 
input area is entered with 
no text preceding it. 
 

Data Block Question 
 
7. This is a data block 
question. 
 
Item 1 _____________ 
Item 2 _____________ 
Item 3 _____________ 

 

This is a data block 
question.  
 
The number of 
underscores you enter 
determines the length of 
the text. All the items are 
created and defined as 
Text. 
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Matrix Questions 

To define a matrix question in MS Word, you will need to set up the question categories and the 
response/rating options in a table.  In MS Word, go to the Table menu at the top of your screen and 
click on Insert Table.  Designate the number of columns and rows as needed - generally, one (1) row 
and two (2) columns for standard matrix questions.  A side-by-side matrix question will require 
additional columns and/or rows depending on the parameters of the question. 
 
 

Choose One Matrix Question 
 

What You Will Enter in MS Word 
 
8. This is a Choose One Matrix question.  
 

This software 
That software 
Other software 
 
 

m Very Poor 
m Poor 
m Average 
m Good 
m Very Good 

 
 
 
Note! 
The column on the left represents the matrix categories. 
The column on the right represents the rating choices that will be applied to the 
categories. 
In a Choose One Matrix question, the choices may be defined using m or (). 
 
 
 

What You Will See in EFM Feedback 
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Choose All That Apply Matrix Question 
 

What You Will Enter in MS Word 
 
9. This is a Choose All That Apply Matrix question. 
 

This software 
That software 
Other software 
 
 

q Choice One 
q Choice Two 
q Choice Three 
q Choice Four 
q Choice Five 

 
 
 
Note! 
The column on the left represents the matrix categories. 
The column on the right represents the rating choices that will be applied to the 
categories. 
In a Choose All That Apply Matrix question, the choices may be defined using q or []. 
 
 
 

What You Will See in EFM Feedback 
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Chapter Three 

Options Once You Create Your Survey 
 
 
 
 
 
 
 
 
Discussed in this Chapter 

Edit Questionnaire 
Publish Survey 
Send invitations 
Analyze & Export 
Reports 
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Options Once You Create Your Survey 

Edit Survey 

 
 
Edit Survey contains all of the editing functions that you use when you create and build 
your survey, or need to edit one that already exists. When you select Create New Survey, or 
select an existing survey to edit, you are placed in the Question List Pane, which is the 
main working area for creating your survey questions, editing them, and setting up their 
specific properties. 
 
From this area, you can add new questions, manipulate existing questions, preview your 
survey to see how it will look to your users, Print your survey, and even export your work to 
a MS Word or an Adobe PDF file. 
 

 
Question List Pane 
 
 
For more information, you can check the Managing the Question List and Standard 
Question Types topics in the Help system.
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Publish Survey 

 
 
Once your survey has been finalized you will need to publish it to make it available to your 
users.  The publishing process produces the link to be used to access the survey. 
 

Steps 

1. Go to the Feedback Page. 
2. Select the survey you want to publish from the Feedback List Pane. 
3. With the survey highlighted, select Publish Survey from the Options Pane.  
4. Click the Publish button in the upper left corner of the tool bar. 

 
For more detailed information on the publishing process, see Publishing/Republishing 
Your Survey.
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Invite Respondents 

 
 
Once your survey has been published, you can use the Invite Respondents feature to 
invite users to take the survey.   
 
There are four methods that can be used to invite users to participate in your survey.  Click 
on Hyperlink, Popup Invitation or Popup Survey to expand these options and see more 
details.  The four methods are: 
 

1. Email List - Use the Mailing Lists tool to send out an E-mail invitation and track 
user statistics such as the date the invitation is sent, who clicked on the survey link, 
who completed the survey and which E-mail addresses are not valid.  Vovici strongly 
recommends this option to send invitations to your survey audience. 

 
2. Hyperlink (HTML) - Use this snippet of code wherever HTML is supported, such as a 

web page, when you want people to click on a link to open the survey.  This method 
WILL work with popup blockers. 

 
3. Popup Invitation (HTML) - Use this snippet of code wherever HTML and JavaScript 

are supported, such as a web page, when you want to display a popup dialog box 
asking someone to take your survey.  Please note that popup blockers may prevent 
this method from working as expected. 

 
4. Popup Survey (HTML) - Use this snippet of code wherever HTML and JavaScript are 

supported, such as a web page, when you want to open a new window to your 
actual survey.  Please note that popup blockers may prevent this method from 
working as expected.  
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Analyze Data 

 
 
Once your survey has started to collect responses, you can use the Analyze Data option to 
analyze your data in a variety of ways. 
 
The Analyze Tab contains various options for viewing your data within the 
application.  Results are graphed for individual questions.  You can set up the chart type and 
properties to tailor the display.  Results can be updated through this tab and you can work 
with the raw data as well. 
 
If you prefer to analyze your data outside of the application, you can export the results 
into a CSV (Comma Separated Values) file which can then be saved as an Excel 
spreadsheet.  Data can also be exported to a file compatible for analysis in SPSS. 
 
Note! 
SPSS (Statistical Package for the Social Sciences) is a statistical and data 
management software package for analysts and researchers. 
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Create Basic Report 

 
 
 
You can generate a report based on your survey results.  The report option allows you to 
choose the questions to be included, and to set up specific parameters for what other 
information you want included in the report such as text responses provided by your users, 
executive summary text or user analysis comments that you enter. 
 
The information that is contained in the report is determined by selections you make on the 
Report Tab in conjunction with selections that are made on the Analyze Tab.  
 
Reports can be generated in a standard basic report format as well as a cluster report or 
public report, and can be run as many times as necessary.  A report can also be exported 
to a MS Word file, an Adobe PDF file, or a MS PowerPoint file. 
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Chapter Four 

 How to Add Questions to Your Survey 
 
 
 
 
 
 
 
 
Discussed in this Chapter 

Question Library 
New Question 
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How to Add Questions to Your Survey 

Question Library 

Using the Question Library to add questions to your survey can be very efficient, and 
reduce the time and effort needed to create your survey. Once the questions have been 
inserted into your survey, they can be edited as desired. 
 
The Library drop-down menu contains various categories of predefined questions to choose 
from.  Simply select the desired category from the menu to view the questions and make 
your selections. 
 

Adding a Question from The Question Library 

1. Click the New Question button in the Editing Tool Bar. 
2. Click the Library tab to begin the process. 
3. Select the appropriate question category from the Library drop-down menu, or from 

My Library (your personal libraries). 
4. Click the check box next to the question(s) you want to add to your survey. 
5. Use the Insert Question drop-down list to position the question(s) in your survey. 
6. Click OK. 

 
Note! 
You can add multiple questions at the same time by selecting the check boxes next 
to all your desired selections.  Then, use the Insert Question drop-down list to 
position the question(s) in your survey, click OK. 
 
Tip! 
You can select all of the questions from the current library by selecting the check 
box at the top left corner of the dialog.  Clicking the check box again will remove 
the selections. 
 

June 2007                                                                                                             Page 52 of 291 



EFM Feedback User Guide  How to Add Questions to Your Survey 

 

 
Adding a Question from the Question Library 
 
 

Adding Existing Questions to Your Library 

To add a particular question to your personal library: 
 

1. Select the check box next to the question you want to add. 
2. Click the Add To Library icon in the Editing Tool Bar. 
3. Click OK. 

 

 
Adding a Question to your Personal Library 
 
 
This action adds the selected question(s) to your personal library.  The question(s) can now 
be selected from your personal library for use in other surveys you create. 
.
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New Question 

To begin building your survey, your first step will be to add questions.  If you are creating 
a new survey, you are automatically placed in the Edit Survey option once you create your 
survey.  If you are adding questions to a survey that already exists, you will click your 
survey title and select the Edit Survey option.  
 
There are two ways to begin adding questions to your survey.  When you click New 
Question you can choose a question style from the Select Question Type tab shown and 
build it yourself, or you can choose a question from a predefined Question Library under the 
Library tab. 
 

Adding a Question from Select Question Type 

1. Click the New Question button. 
2. Select a question type to create from the Question Type box on the left.  When a 

question type is highlighted, a sample version of that question type will display in the 
Sample dialog box on the right.  This will serve as a visual guide to show how the 
question will be displayed in your survey. 

3. Use the Insert Question drop-down list to position the question in your 
survey.  Questions can be placed at the beginning, after a particular question already 
in your survey (all of your current questions display), or at the end.  

4. Click OK. 
5. You are now placed in the Question Edit dialog, where you will enter question text 

and/or response options for your questions. 
 
See related topics in the online Help system:  Managing the Question List, Standard 
Question Types. 
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Chapter Five 

 Survey Question Types 
 
 
 
 
 
 
 

 
Discussed in this Chapter 

Standard Question Types 
Choose One (Show All) 
Choose One (Horizontal Layout) 
Choose One (Pull Down Menu) 
Choose All That Apply 
Fill In the Blank (Limited Text) 
Essay (Unlimited Text) 
Numeric Value 
Date Value 
Choose One Matrix 
Choose All That Apply Matrix 
Side-By-Side Matrix 
Data Block 
Rank Order 
HTML Snippet 
Hidden Field 
Page Break/Conditional Logic 
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Survey Question Types 

Standard Question Types 

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  
 
There are various question types that can be utilized in your survey, as well as different 
attributes that can be set for those questions.  You can get more information on each of the 
different question types by visiting the sections below: 
 

Choose One (Show All) 
Choose One (Horizontal Layout) 
Choose One (Pull Down Menu) 
Choose All That Apply 
Fill In The Blank (Limited Text) 
Essay (Unlimited Text) 
Numeric Value 
Date Value 
Choose One Matrix 
Choose All That Apply Matrix 
Side-By-Side Matrix 
Data Block 
Rank Order 
HTML Snippet 
Hidden Field 
Page Break/Conditional Logic 

 

Internal IDs 

Each question and response option in your survey has a unique wsb number (Internal ID 
number).  This value appears to the right of the question and will show as 'wsbXX' where 
'XX' is a number assigned by the application.  These ID numbers are used to uniquely 
identify and help map data to the proper question/response in your survey. 
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Choose One 

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  
 
A Choose One question allows the respondent to choose only one response from the 
available response options for that question.  The responses can be displayed in three 
different ways: 
 

• vertical 
• horizontal 
• drop-down menu 

 

 
Sample Choose One Question (vertical) 
 

To Create a Choose One Question 

1. Click the New Question button. 
2. Select Choose One as the Question Type.  You can choose any of the three response 

layout styles from the Question Type list.  The response layout can be changed if 
necessary on the Advanced Tab. 

3. Use the Insert Question drop-down list to position the question in your survey. 
4. Click OK. 

 

Basic Tab 

The question text is entered in the text box and can be formatted using the Editing Tool 
Bar.   
 
Response Type 
The Response Type drop-down menu allows you to change the response type.  It is located 
directly above the Editing Tool Bar.   
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The response type drop-down menu options are: 
 

• Single Select  
• Multiple Select  

 
 
Note! 
Once the survey has been published, the option to change the response types is no 
longer available. 
 
If the question is added to a survey that has been previously published, the option 
to change the response types is not available. 
 
Add the response items in the text box at the bottom.  You can add the response items 
one at a time, or use the Add Multiple Responses feature to add them all at the same 
time. 
 

Advanced Tab 

The options on this tab are: 
 

Disable:  Select the check box to disable the question in the survey without deleting it. 
Required:  Select the check box to require the user to answer the question.  
Randomize:  Select the check box to have the response options appear in a random 
order each time the survey is accessed.   
Include a 'Comments' Field:  Select the check box to include a 'Comments' field 
with this question. 
Response Layout:  You can select a horizontal, vertical or pull-down display for your 
response options. 

 

Preview Tab 

Click the Preview tab to see how the question will appear in your survey. 
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Choose All That Apply 

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  
 
A Choose All That Apply question allows the respondent to choose multiple responses from 
the available response options for that question.   
 

 
Sample Choose All That Apply Question 
 

To Create a Choose All That Apply Question 

1. Click the New Question button. 
2. Select Choose All That Apply as the Question Type. 
3. Use the Insert Question drop-down list to position the question in your survey. 
4. Click OK. 

 

Basic Tab 

The question text is entered in the text box and can be formatted using the Editing Tool 
Bar.   
 
Response Type 
The Response Type drop-down menu allows you to change the response type.  It is located 
directly above the Editing Tool Bar.    
 
The response type drop-down menu options are: 

• Single Select  
• Multiple Select  

 
Note! 
Once the survey has been published, the option to change the response types is no 
longer available. 
 
If the question is added to a survey that has been previously published, the option 
to change the response types is not available. 
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Add the response items in the text box at the bottom.  You can add the response items 
one at a time, or use the Add Multiple Responses feature to add them all at the same 
time. 
 
 

Advanced Tab 

The options on this tab are: 
 

Disable:  Select the check box to disable the question in the survey without deleting it. 
Required:  Select the check box to require the user to answer the question.  Use the 
drop-down lists to further specify the conditions of the response.  
Randomize:  Select the check box to have the response options appear in a random 
order each time the survey is accessed.   
Include a 'Comments' Field:  Select the check box to include a 'Comments' field 
with this question. 
Response Layout:  You can select a horizontal or vertical display for your response 
options.  For a vertical layout, you can use the drop-down list to specify how many 
columns to use for the display. 

 
 

Preview Tab 

Click the Preview tab to see how the question will appear in your survey. 
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Fill in the Blank (Limited Text) 

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  
 
The Fill In The Blank (Limited Text) question provides a text box for respondents to fill in 
requested information. 
 

 
Sample Open Ended Text Limited Question 
 

To Create a Fill In The Blank (Limited Text) Question 

1. Click the New Question button. 
2. Select Fill In The Blank (Limited Text) as the Question Type. 
3. Use the Insert Question drop-down list to position the question in your survey. 
4. Click OK. 

 

Basic Tab 

The question text is entered in the text box and can be formatted using the Editing Tool 
Bar.   
 
Select Fill In The Blank (Limited Text) to define the question as limited.  Enter a value in 
the Limit text to box to define the length of the acceptable answer (1-250 alphanumeric 
characters).  The default is usually 40 characters and is set under My Preferences. 
 
A text mask can be defined to ensure that all answers are in the same format.  The mask is 
stringent and will determine the type of characters that are acceptable as well as the length 
of the answer.   
 
Example: 
If you set a mask of 99999, this mask will require an entry of all numbers, and will require 
five (5) digits as shown.  If the entry is less than five (5) digits, a validation script will show 
as follows:
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Pre-Field Text is user-defined text that will display before the text box in the item. 
Post-Field Text is user-defined text that will display after the text box in the item. 
 
Tip! 
When specifying Pre-Field or Post-Field text, use &nbsp; (nonbreaking space) 
before or after your text to separate it from the text box. 

  

Advanced Tab  

Disable Question 
Select the check box to disable the question in the survey without deleting it. 
 
Required Question 
Select the check box to require the user to answer the question. 
 
 

Preview Tab 

Click the Preview tab to see how the question will appear in your survey. 
 
 
See related topic:  Essay (Unlimited Text) 
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Essay (Unlimited Text) 

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  
 
The Essay (Unlimited Text) question provides a text box for respondents to fill in 
requested information. 
 

 
Sample Open Ended Text Unlimited Question 
 
 

To Create an Essay (Unlimited Text) Question 

1. Click the New Question button. 
2. Select Essay (Unlimited Text) as the Question Type. 
3. Use the Insert Question drop-down list to position the question in your survey. 
4. Click OK. 

 

Basic Tab 

The question text is entered in the text box and can be formatted using the Editing Tool 
Bar.   
 
Select Essay (Unlimited Text) to define the question as unlimited.  Do not enter a value in 
the Limit text to box. 
 
A text mask can be defined to ensure that all answers are in the same format.  The mask is 
stringent and will determine the type of characters that are acceptable as well as the length 
of the answer.   
 
Example: 
If you set a mask of 99999, this mask will require an entry of all numbers, and will require 
five (5) digits as shown.  If the entry is less than five (5) digits, a validation script will show 
as follows:
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Pre-Field Text is user-defined text that will display before the text box in the item. 
Post-Field Text is user-defined text that will display after the text box in the item. 
 
Tip! 
When specifying Pre-Field or Post-Field text, use &nbsp; (nonbreaking space) 
before or after your text to separate it from the text box. 

  

Advanced Tab  

Disable Question 
Select the check box to disable the question in the survey without deleting it. 
 
Required Question 
Select the check box to require the user to answer the question. 
 

 

Preview Tab 

Click the Preview tab to see how the question will appear in your survey. 
 
 
See related topic:  Fill In the Blank (Limited Text) 
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Numeric Value 

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  
 
A Numeric Value question requires the respondent to enter a response in numeric format 
within a specified range. 
 

 
Sample Numeric Value Question 
 
 

To Create a Numeric Value Question 

1. Click the New Question button. 
2. Select Numeric Value as the Question Type. 
3. Use the Insert Question drop-down list to position the question in your survey. 
4. Click OK. 

 
 

Basic Tab 

The question text is entered in the text box and can be formatted using the Editing Tool 
Bar.   
 
When the question is defined, minimum and maximum values are required to create the 
range of acceptable values for this question. 
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Pre-Field Text is user-defined text that will display before the text box in the item. 
Post-Field Text is user-defined text that will display after the text box in the item. 
 

 
Numeric Question - Basic Tab Options 
 
Alert! 
The numeric range setting is not displayed in the survey unless it is entered as part 
of the question, or as Pre-Field or Post-Field text. 
 
Tip! 
When specifying Pre-Field or Post-Field text, use &nbsp; (nonbreaking space) 
before or after your text to separate it from the text box. 
 
 

Advanced Tab  

Disable Question 
Select the check box to disable the question in the survey without deleting it. 
 
Required Question 
Select the check box to require the user to answer the question. 
 
 

Preview Tab 

Click the Preview tab to see how the question will appear in your survey. 
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Date Value 

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  
 
The Date Value question type requires the respondent to enter a specific 
date.  Respondents will be asked to enter the date in YYYY-MM-DD format which conforms 
with ISO 8601:1988 format standard.    
 
 

 
Sample Date Value Question 
 

To create a Date Value question 

1. Click the New Question button. 
2. Select Date Value as the question type. 
3. Use the Insert Question drop-down list to position the question in your survey. 
4. Click OK. 

 

Basic Tab 

The question text is entered in the text box and can be formatted using the Editing Tool 
Bar.   
 
Specify the acceptable type of date for the question from the Date Range drop-down list: 
 

• Accept any date 
• Date is on or before 
• Date is on or after 
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Pre-Field Text is user-defined text that will display before the text box in the item. 
Post-Field Text is user-defined text that will display after the text box in the item. 
 
Alert! 
The Date Range setting is not displayed in the survey unless it is entered as part of 
the question, or as Pre-Field or Post-Field text. 
 
Tip! 
When specifying Pre-Field or Post-Field text, use &nbsp; (nonbreaking space) 
before or after your text to separate it from the text box. 

 

Advanced Tab 

Disable Question 
Select the check box to disable the question in the survey without deleting it. 
 
Required Question 
Select the check box to require the user to answer the question. 

 
Note! 
You can also require the question by selecting the check box for that question in 
the Question List Pane then clicking the "Required" button. 

 

Preview Tab 

Click the Preview tab to see how the question will appear in your survey. 
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Choose One Matrix 

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  
 
The Choose One Matrix question presents a compact way to ask the respondent for 
feedback on a range of categories.  Each row of the matrix question contains a category 
to be evaluated, and each column of the matrix question contains a response option used 
for evaluating the categories. 
 
In a Choose One Matrix question, only one response option per category can be selected.   
 
In the Question Edit dialog, the Choose Only One Matrix will have tabs for Basic, 
Advanced and Preview. 
 

Example 

In the Choose One Matrix question below, the categories are: 
 

Speed 
Graphics 
Information 
Related Links 
 

The response options are: 
 

Excellent 
Very Good 
Good 
Fair 
Poor 

 

 
Choose One Matrix Question
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Tip! 
It is recommended that question text, categories and response options be kept as 
short as possible as the length of these fields will affect the display of the graphs 
in Analysis and column headers when you Export Data.  Question/response text 
will not wrap on the graphs or legend.  Matrix categories and response options 
have the option to define Analysis or Export Versions as desired.  
 
Tip! 
If your matrix question text is lengthy, try putting the text into an HTML snippet 
question.  Then, set up a matrix question without question text, and define the 
categories and response options as normal. 
 

To Create a Select Only One Matrix Question 

1. Click the New Question button. 
2. Select Choose One Matrix as the Question Type. 
3. Use the Insert Question drop-down list to position the question in your survey. 
4. Under the Basic Tab, enter the question text in the text box. 
5. Categories are listed in the left section below the question text box.  Type 

your categories in the text box at the bottom one at a time, clicking the Add 
button after each one.  You can also use the Add Multiple Categories... 
button to add all your categories at once. 

6. Responses are listed in the right section below the question text box.  Type 
your categories in the text box one at a time, clicking the Add button after 
each one.  You can also add responses from a Response Library or use the 
Add Multiple Responses feature to add all your responses at once. 

7. Click OK. 

 

Basic Tab 

The question text is entered in the text box and can be formatted using the Editing Tool 
Bar.   
 
Response Type 
The Response Type drop-down menu allows you to change the response type.  It is located 
directly above the Editing Tool Bar.    
 
The response type drop-down menu options are: 
 

• Single Select  
• Multiple Select  
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Note! 
Once the survey has been published, the option to change the response types is no 
longer available. 
 
If the question is added to a survey that has been previously published, the option 
to change the response types is not available. 
 
Include a 'Comments' Field:  Select the check box to include a 'Comments' field with this 
question. 
 
Add the categories in the text box at the bottom left.  
 
Add the responses in the text box at the bottom right.  You can add the response items 
one at a time, or use the Add Multiple Responses feature to add them all at the same 
time. 
 

 

Advanced Tab 

The options on this tab are: 
 

Disable:  Select the check box to disable the question in the survey without deleting it. 
Suppress Question Numbers:  Select the check box to suppress question numbers 
on the categories.  
Randomize:  Select the check box to have the categories appear in a random order 
each time the survey is accessed.   
Set Fixed Column Width:  You can set the width of categories or rows so that they 
display uniformly. 
Response Layout:  You can select a horizontal or vertical display for your response 
options. 
Colors:  You can set the colors for your question display by clicking the color palette 
icon and selecting a color.  Colors can be applied to rows or columns.  If you know the 
HTML hexadecimal value for the color you want, you can type it in. 

 

 

Preview Tab 

Click the Preview tab to see how the question will appear in your survey. 
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Choose All That Apply Matrix 

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  
 
The Choose All That Apply Matrix question presents a compact way to ask the respondent 
for feedback on a range of categories.  Each row of the matrix question contains a 
category to be evaluated, and each column of the matrix question contains a response 
option used for evaluating the categories. 
 
In a Choose All That Apply Matrix question, multiple response options for each category 
can be selected.   
 
In the Question Edit dialog, the Choose All That Apply Matrix will have tabs for Basic, 
Advanced and Preview. 
 

Example 

In the Choose All That Apply Matrix question below, the categories are: 
 

Speed 
Graphics 
Information 
Related Links 
 

The response options are: 
 

Excellent 
Very Good 
Good 
Fair 
Poor 

 

 
Choose All That Apply Matrix Question
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Tip! 
It is recommended that question text, categories and response options be kept as 
short as possible as the length of these fields will affect the display of the graphs 
in Analysis and column headers when you Export Data.  Question/response text 
will not wrap on the graphs or legend.  Matrix categories and response options 
have the option to define Analysis or Export Versions as desired.  
 
Tip! 
If your matrix question text is lengthy, try putting the text into an HTML snippet 
question.  Then, set up a matrix question without question text immediately after 
the snippet and define the categories and response options as normal. 
 

To Create a Choose All That Apply Matrix Question 

1. Click the New Question button. 
2. Select Choose All That Apply Matrix as the Question Type. 
3. Use the Insert Question drop-down list to position the question in your survey. 
4. Under the Basic Tab, enter the question text in the text box. 
5. Categories are listed in the left section below the question text box.  Type 

your categories in the text box at the bottom one at a time, clicking the Add 
button after each one.  You can also use the Add Multiple Categories... 
button to add all your categories at once. 

6. Responses are listed in the right section below the question text box.  Type 
your categories in the text box one at a time, clicking the Add button after 
each one.  You can also add responses from a Response Library or use the 
Add Multiple Responses feature to add all your responses at once. 

7. Click OK. 

 

Basic Tab 

The question text is entered in the text box and can be formatted using the Editing Tool 
Bar.   
 
Response Type 
The Response Type drop-down menu allows you to change the response type.  It is located 
directly above the Editing Tool Bar.    
 
The response type drop-down menu options are: 
 

• Single Select  
• Multiple Select  
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Note! 
Once the survey has been published, the option to change the response types is no 
longer available. 
 
If the question is added to a survey that has been previously published, the option 
to change the response types is not available. 
 
Include a 'Comments' Field:  Select the check box to include a 'Comments' field with this 
question. 
 
Add the categories in the text box at the bottom left.  
 
Add the responses in the text box at the bottom right.  You can add the response items 
one at a time, or use the Add Multiple Responses feature to add them all at the same 
time. 

 

Advanced Tab 

The options on this tab are: 
 

Disable:  Select the check box to disable the question in the survey without deleting it. 
Suppress Question Numbers:  Select the check box to suppress question numbers 
on the categories.  
Randomize:  Select the check box to have the categories appear in a random order 
each time the survey is accessed.   
Set Fixed Column Width:  You can set the width of categories or rows so that they 
display uniformly. 
Colors:  You can set the colors for your question display by clicking the color palette 
icon and selecting a color.  Colors can be applied to rows or columns.  If you know the 
HTML hexadecimal value for the color you want, you can type it in. 
Required:  Select the check boxes for any categories that you want to require the 
respondent to answer.   

 

 

Preview Tab 

Click the Preview tab to see how the question will appear in your survey. 
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Side-By-Side Matrix 

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  
 
The Side-By-Side Matrix question presents a compact way to ask the respondent for 
feedback on a range of categories.  Each row of the matrix question contains a category 
to be evaluated, and each column of the matrix question contains a response option used 
for evaluating the categories. 
 
An added feature is that response types can be mixed in a side-by-side matrix, e.g., one 
'side' can be defined as choose one while another 'side' is defined as choose all that 
apply.  Sides that are defined as choose one can use either a horizontal layout or a 
drop-down list for the response options. 
 
Categories are only added once for the entire question and will display on the left next to 
the first 'side'.  Additional 'sides' will be displayed adjacent to each other with the 
response options for that side along the top as column headers.  The title of the side 
spans the top of the columns above the response options. 
 
 
Note! 
The example below utilizes Choose All That Apply for Side One, Choose One 
horizontal for Side Two, and Choose One drop-down list for Side Three. 
 
 

 
Side-By-Side Matrix Question 
 

 

How to Create A Side-By-Side Matrix Question 

1. Click the New Question button. 
2. Choose Side-By-Side Matrix as the Question Type. 
3. Use the Insert Question drop-down list to position the question in your survey. 
4. Enter overall question text in text box.
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5. Categories are created in the lower left section.  Enter your categories one at 

a time in the bottom left text box.  Click Add.  You can also use the Add 
Multiple Categories... button to add all your categories at once. 

6. Sides are created in the lower right section.  To add a Side, choose the 
response type from the drop-down list at the bottom right (choose one or 
choose all that apply).  Click Add Side.   

7. On the Sides Tab, enter the text to be used for the title heading in the text 
box at top.   

8. Enter response options in the box at bottom, click Add.  As with other 
question types, you can also add responses using the Response Library 
option, or Add Multiple Responses.  You can change the Response Type by 
using the Response Type drop-down list at the top of the Sides Tab. 

9. Click OK. 

 

Sides Tab 

The question text is entered in the text box and can be formatted using the Editing Tool 
Bar.   
 
Response Type 
The Response Type drop-down menu allows you to change the response type.  It is located 
directly above the Editing Tool Bar.   
 
The response type drop-down menu options are: 
 

• Single Select  
• Multiple Select  

 
Note! 
Once the survey has been published, the option to change the response types is no 
longer available. 
 
If the question is added to a survey that has been previously published, the option 
to change the response types is not available. 
 
Add the response items in the text box at the bottom.  You can add the response items 
one at a time, or add them using the Add Multiple Responses or Response Library 
options. 
 
 

Advanced Tab 

This tab contains settings to be applied to the specific side you are editing.   
 
Include a 'Comments' Field 
You can include a Comments field which will be added to the bottom of the selected side. 
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Colors 
 
You can use the color palette icon to select colors to be applied to the selected side.  You 
can also enter the HTML hexadecimal value for the color you want in the text box.  Colors 
can be applied to alternating rows or columns. 
 
Question Numbers 
Select the check box to suppress question numbers on the categories. 
 
Response Layout 
This option is present only on single select sides.  You can select horizontal or pull down 
to display the response options. 
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Data Block Question 

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  
 
Data block questions are used to present a data entry area for respondents to fill in 
requested information.   
 
A data block question consists of the question text and the response fields which are 
labeled text box fields where the information is entered.  The data block is presented in a 
tabular format in your survey rather than as individual questions.   
 

 
Sample Data Block Question 
 
 
The response fields in a data block question can be defined as: 
 

• Fill In The Blank (Limited Text) (up to a maximum of 250 characters) 
• Essay (Unlimited Text) 
• Numeric Value 
• Date Value
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Data Block Question Edit 
 
 
Note! 
By default Numeric Value defined response fields will require you to enter a range 
using minimum and maximum values.  Any number entered in the response field 
by a respondent must be within the defined range.  If it is not, a script validation 
alert will show when you click Next Page or Submit. 
 

 
Numeric Range Validation Alert
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Numeric Value and Pre-Field/Post Field Text 
 
 

Create a Data Block Question 

A typical data block question contains the title text and several response fields where 
information is entered by the respondent. 

Steps 

1. Click the New Question button, select Data Block as the Question Type. 
2. Use the Insert Question drop-down list to position the question in your survey. 
3. Enter the question text on the Basic Tab of the Data Block Question Edit dialog. 
4. Select the type of Response Field to add from the drop-down list at the bottom of 

the dialog. 
5. Click Add. 
6. The Question Edit dialog will display.  Enter the name of the response 

field.  Define any appropriate parameters as shown such as a character limit, text 
mask, pre-field text or post-field text. 

7. Click OK. 
 

June 2007                                                                                                             Page 80 of 291 



EFM Feedback User Guide  Survey Question Types  
 

Text mask is a user-defined format that requires responses for that field to be in the 
designated format. 
Pre-Field Text is user-defined text that will display before the text box in the item. 
Post-Field Text is user-defined text that will display after the text box in the item. 
 
Tip! 
When specifying Pre-Field or Post-Field text, use &nbsp; (nonbreaking space) 
before or after your text to separate it from the text box. 
 

 

Advanced Tab of Response Field 

Disable option turns off this question in the survey. 
 

• You can disable the question from the Question List Tool Bar by selecting the 
question then clicking the Disabled button. 

• You can also disable the question by selecting the check box under the Advanced 
Tab of the Data Block Question Edit dialog. 

 
Required means user (recipient of your survey) must answer this response item. 
 

• You can require the question from the Question List Tool Bar by selecting the 
question then clicking the Required button. 

• You can require specific response fields by selecting the check box for 'Require this 
question to be answered in the survey' on the Question Edit dialog. 

  

 

June 2007                                                                                                             Page 81 of 291 



EFM Feedback User Guide  Survey Question Types  
 

Data Block Sum-To 

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  

 

Create a Sum-To Data Block Question 

You can set up a sum-to data block where a set of numeric entries is required to add up 
to a certain total.  This is typically used in a percentage scenario where the respondent's 
entries have to total to a certain number, usually 100%. 

 

Steps 

1. Click the New Question button, select Data Block as the Question Type. 
2. Use the Insert Question drop-down list to position the question in your survey. 
3. Select Numeric as the item type to be added, click Add. 
4. When all numeric response fields have been created, go to Advanced Tab. 
5. Select the checkbox for Enable "sum to," with another box beneath it that reads 

'Sum of all responses must equal' where you will specify the required total.  
6. Click OK. 

 
Note! 
Validation on a sum-to data block question requires the user to enter values and 
requires that they add up correctly.  If they do not, a script validation alert as 
shown below will display when you click Next Page or Submit. 
 

 
Example of a Sum-To Data Block Question with Validation Alert
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Text mask is a user-defined format that requires responses for that field to be in the 
designated format. 
Pre-Field Text is user-defined text that will display before the text box in the item. 
Post-Field Text is user-defined text that will display after the text box in the item. 
 
Tip! 
When specifying Pre-Field or Post-Field text, use &nbsp; (nonbreaking space) 
before or after your text to separate it from the text box. 
 
 
Disable option turns off this question in the survey. 
 

• You can disable the question from the Question List Tool Bar by selecting the 
question then clicking the Disabled button. 
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Rank Order  

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  
 
The Rank Order question is used to display a series of items you would like the respondent 
to rank in a particular order.  The Rank Order question renders in a survey as a series of 
drop-down lists, one for each of the ranks you would like the user to choose.  Each drop-
down list contains all of the response options and the ranks will be selected from the entire 
list. 
 

 
Sample Rank Order Question 
 
 
Tip! 
The most effective ranking questions contain 3-5 items to rank.  Ten (10) items is 
the maximum you should ask a user to rank.  While you can have a large number of 
response options to choose from, the number of ranks available should be 
relatively low.   
 
Note! 
Validation script for the Rank Order question requires that options that are ranked 
be unique.  If the user has selected an option for more than one rank, the last item 
that is redundantly selected will not be applied and a warning dialog will be 
presented (below) prompting the user to choose another selection.  
 

 
Rank Order Validation Alert 
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To Create a Rank Order Question 

1. Click the New Question button. 
2. Select Rank Order as the Question Type. 
3. Use the Insert Question drop-down list to position the question in your survey. 
4. Click OK. 

 

Basic Tab 

The question text is entered in the text box and can be formatted using the Editing Tool 
Bar.   
 
Add the response items to be ranked in the text box at the bottom.  You can add the 
response items one at a time, or use the Add Multiple Responses feature to add them all 
at the same time. 
 
 

Advanced Tab 

The options on this tab are: 
 

Disable:  Select the check box to disable the question in the survey without deleting it. 
Required:  Select the check box to require the user to answer the question.  
Randomize:  Select the check box to have the response options appear in a random 
order each time the survey is accessed.   
Number of Ranks Available:  Select the number of ranks you want from the drop-
down list.  The total number of ranks possible corresponds to the total number of 
response options. 

 
 

Preview Tab 

Click the Preview tab to see how the question will appear in your survey. 
 
 

Analysis for Rank Order Question 

When analyzing a Rank Order question, each of the ranks selected is assigned a point 
value.  This point value is based on the number of ranks and the order in which an item is 
selected.
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In the example below, the question uses six (6) response options while the number of ranks 
is set to three (3).  The maximum number of points for a number one rank selection is the 
number of ranks that are available.  Therefore, selecting an item first results in 3 points 
being applied to that item, selecting an item second results in 2 points applied to that item, 
and the third item selected would be assigned 1 point.  If there are more selections than 
there are ranks, then the items not selected will be assigned 0 points.  
 
The best chart type for rank order analysis is the horizontal bar chart.  Since percentages 
have no real impact on the results, simple value counts should be used to determine the 
ranking order.  See Chart Properties for more information. 
The display legend shows the total number of points that each selection received.  
 

 
 
The response options to be ranked were:  
 

Marketing 
Sales 
Development/Engineering 
Customer Support 
MIS/Information Technology 
Finance 
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There were a total of seven (7) responses submitted to the survey.  Since this question 
asked people to rank the top three (3) items out of six (6) possible selections, the points will 
be awarded in this manner: 
 

Rank #1 = 3 points 
Rank #2 = 2 points 
Rank #3 = 1 point  

 
After exporting the data for this question to MS Excel (see CSV representation in the table 
below), you can see that four (4) of the seven (7) people who completed the survey ranked 
"Customer Support" first, and three (3) of the seven (7) people ranked "Customer Support" 
second.  So, 12 points come from the four (4) people who ranked "Customer Support" first 
(4 * 3 = 12 points), and 6 points come from the three (3) people who ranked "Customer 
Support" second (3 * 2 = 6 points).  
 
12 + 6 = 18  
 

 
 
 
Customer Support received a total of 18 points and that point value is displayed in the 
legend of the bar chart.  
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HTML Snippet 

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  
 
The HTML Snippet question type can be used to insert HTML-formatted text between 
questions in your survey.  It is a good way to place section headings into a survey and 
format them so they stand out, or to add explanatory text before a question or section. 
 

To add an HTML Snippet: 

1. Click the New Question button. 
2. Select HTML Snippet as the Question Type. 
3. Use the Insert Question drop-down list to position the question in your survey. 
4. Click OK. 

  

Basic Tab 

The Basic tab is where you add the text to be displayed.  You can use the Editing Tool Bar 
above the question text box to insert the desired formatting, or you can code the HTML 
yourself.    
 
 

Advanced Tab 

Disable - Select the check box to disable the question in the survey without deleting it. 
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Hidden Field 

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  
 
You can incorporate data into your survey or results without requiring the user to enter any 
values by using a hidden field.  The hidden field is a variable in your survey that will be 
populated with a specific value.  You must first add the hidden field question to your 
survey, then it is populated when the user takes the survey. 
 

 
Sample Hidden Field Question Edit 
 
 

To Add A Hidden Field to Your Survey 

1. Click the New Question button. 
2. Select Hidden Field as the question type. 
3. Use the Insert Question drop-down list to position the hidden field question at the 

beginning of your survey. 
4. Click OK. 
5. Enter a Field Name for the hidden field.  A Default Value can be entered also but is 

not required. 
6. Click OK. 

 
Note! 
Default Value is displayed when there is no corresponding value for the hidden 
field in your mailing list for a particular respondent.  If no default value is defined, 
the hidden field will be blank in the survey results for that entry. 
 
 
Tip! 
Hidden fields should always be placed at the top of your question list so they are 
easy to locate for analysis and to reference for troubleshooting.  Doing so will also 
place them up front in your actual data immediately following the normal system 
fields.   
 
 
Passing Data 
There are two methods for passing data into your survey through a hidden field. 
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Method One 
 
The most common method is to use a Mailing List to send out your survey invitations 
where the list contains all the data values to be passed. The hidden field will be 
represented in your survey results with its own column the same as any other 
question.  When a value is passed from a list to populate the hidden field it will display in 
your survey results without the user having to enter it.  The field mapping step used when 
sending out a campaign is what synchronizes the hidden field in the survey with the data in 
the list. 
 

Example: 
If you have a column in your Mailing List for Department and you want to see those 
values in your actual results, you can add a hidden field to your survey named 
Department.  This will create a column in your Actual Data called 
Department.  When the user takes the survey, their value for Department will be 
pulled from the mailing list and populated in this column in the survey results. 

 
Method Two 
You can use a hidden field to pass data manually by appending the hidden field values onto 
the end of your survey URL using the wsb number. The value will show in the hidden field 
column in your survey results.  If you don't use the Mailing List option, you have to pass 
values manually, which means that each user will have their own URL (base survey URL plus 
their appended values). 
 
Note! 
WSB numbers are unique internal id numbers assigned by the application to each 
question and/or response option.  They are displayed in the Question List to the 
right of each question, and are always visible unless you select the option to hide 
them under My Preferences.   
   

Example: 
Begin with the base survey URL that the application produces when you publish your 
survey. 
 
Assume that your survey contains a hidden field named Department and that it has a 
wsb number of 1 (wsb1).  The hidden field will show in the survey results as a 
column named Department. 
 
A delimiter (?) must be used to indicate to the server that additional parameters are 
being passed in.  Our syntax requires that the wsb number of the hidden field be 
used instead of the field name to pass the value. 
 
You have to append the hidden field wsb number and its value onto the end of the 
survey URL as follows: 
 
http://surveyURL?wsb1=Sales 
 

The example above would populate the hidden field Department with a value of 
Sales.
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Alert! 
It is important that the exact wsb number of the hidden field(s) in your survey be 
used in the URL syntax.  Your wsb values may differ from those used in the 
example.   
 
If you have more than one hidden field in your survey, you can append multiple values to 
the base URL by using another delimiter (&) between the wsb values. 
 

Example: 
If you have two hidden fields, Department (wsb1) and CodeNumber (wsb2), your 
appended URL would look like this: 
 
http://surveyURL?wsb1=Sales&wsb2=3333 

 
Once these values have been captured, they can be used the same as other responses when 
analyzing your data. 
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Page Break/Conditional Logic 

From the Feedback tab, select a survey from the List Pane.  Next click Edit Survey from 
the Options Pane and the Edit tab is displayed.  Click the New Question button and then 
choose the Select Question Type tab.  
 
You can insert page breaks into your survey to help keep it more manageable and decrease 
scrolling for your respondents. 
 
The page break is implemented by adding a new question in your survey and selecting 
Page Break/Conditional Logic as the question type.  A page break can be implemented 
as a simple page break or a conditional page break.   
 
The page break will be viewed in the Question List as a regular question and can be edited 
the same as any other question.  In the survey, the page break will be represented by the 
Next Page button. 
 

To Create a Simple Page Break 

This type of page break is added to create sections in the survey. 
 

1. Click the New Question button. 
2. Select Page Break/Conditional Logic as the Question Type. 
3. Use the Insert Question drop-down list to position the question in your survey. 
4. Click OK. 
5. Select Simple as the type of page break to be created from the Page Break Type 

drop-down list. 
6. Select the action that will be associated with the page break (see explanations below). 
7. Click OK. 

 
 
Perform The Following Action 
There are four actions associated with the simple page break: 
 

• Jump to the next question 
• Jump to a specific question (drop-down list displays to select question to jump 

to) 
• Jump to a web address (text box displays for you to enter web address) 
• Submit survey now 
 

Note! 
Using "Jump to a web address" or "Submit survey now" will take the respondent 
out of the survey.   
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To Create a Conditional Page Break 

A conditional page break allows you to branch the user through your survey, having them 
answer only the questions that you want them to see. Break conditions or branches are set 
up in the page break that send the user to a forward location in the survey based on an 
answer or answers in any question before the page break.  Multiple branches can be set 
up within the same conditional break. 
 
Note! 
You should never have back-to-back page breaks in your survey.  Branching can 
only be done forward in the survey.  You cannot branch backward to a previous 
question or perform looping. 
 
 
 

 
Create a Conditional Page Break 
 
 
 
 
 

1. Click the New Question button. 
2. Select Page Break/Conditional Logic as the Question Type. 
3. Use the Insert Question drop-down list to position the question in your survey. 
4. Click OK. 
5. Select Conditional as the type of page break to be created from the Page Break 

Type drop-down list. 
6. The Current Branch Conditions list box will be displayed where you will create your 

conditional branches. 
7. Click the New Branch button.   
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8. From the In Question drop-down list, select the question you want to base your 
branch on.  When a question is selected, the Response Condition and Responses 
drop-down lists will change to match the selected question.  (see example below). 

9. Under Response Condition, choose the appropriate option from the drop-down list. 
10. Under Responses, choose the response that you want to test against. 
11. Click Add to create the branch and display it in the Current Branch Logic list. 
12. Select an action from the Perform the action drop-down list. 
13. Click OK. 

 
 

 
Create Conditional Branch 
 
 
In Question 

Select the question you want to test against.  The drop-down list will show all available 
questions to branch against.  These questions will all be prior to your page break in 
the survey.   
 

Response Condition 
Choose a condition (selected, did not select, greater than, less than, contains, etc.).   
 

Responses 
These are the responses for the question you chose to test against.  If you chose a 
text fill-in question or hidden field to test against, you have to type in the value to test 
for. 
 

Add To Page Break Logic List Below 
Click Add to enter your conditional branch in the list. 
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Branch Logic Will Be Connected Using 
 

The And/Or operator is used when you are building a complex condition that checks 
against more than one response.  This could mean more than one response from the 
same question, or from multiple questions. 

 
Perform the Action 

There are four actions associated with the conditional page break: 
 

• Jump to next question 
• Jump to specific question (drop-down list to select question) 
• Jump to web address (text box to enter Web address) 
• Submit survey now 

 
Select A Location To Jump To 

This option will only be used when you select jump to a specific question or jump 
to a web address.  You will select the specific question to jump to from the drop-
down list, or enter the Web address in the text box.
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Chapter Six 

Survey Question Editing 
 
 
 
 
 
 
 
 

Discussed in this Chapter 
Response Library 
Add Multiple Responses 
Data Piping 
Required Questions 
Disable/Enable a Question 
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Survey Question Editing 

Response Library 

You can use the Response Library button to add predefined response options to your 
question.  A drop-down menu displays the various categories of response options that are 
available. 
 
Response option categories are: 
 

• My Library 
• Demographics 
• Job Related 
• Miscellaneous 
• Monetary 
• Rating 
• Technology 
• Time Based 
• Days Of Week 
• Yes or No 

 

To Add Responses from a Response Library 

1. Click the Response Library button on the List Edit Tool Bar. 
2. Select a category of responses from the menu. 
3. When clicked, the responses from that category are added to your survey question. 
4. Click OK. 

 

 

Create Your Own Response Library 

You can also create your own Response Libraries which can be stored and used for future 
surveys.  These libraries will display under the My Library category above.   
 

 

Steps 

1. In your survey question, select the response options to be added to the library by 
clicking the check box next to them, or click the check box on the left side of the 
List Edit Tool Bar to select all check boxes. 

2. Click the Add To Library icon in the List Edit Tool Bar.  You will be prompted to 
give the library a name. (see below) 

3. Click OK.
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Name Your Response Library 

 

 

To Add Responses from My Library 

1. Click the Response Library button. 
2. Select My Library. 
3. Select the saved library that you want and those responses will be added to your 

question. 
 
 
 

Add Multiple Responses 

You can add multiple response options to your questions by using the Add Multiple 
Responses button on the List Edit Tool Bar. 
 

 

To Add Multiple Responses 

1. Click the Add Multiple Responses button on the List Edit Tool Bar. 
2. Type or copy/paste your response options into the text box provided, with one 

response option per line. 
3. Click the Add Responses button. 

 
 

June 2007                                                                                                             Page 98 of 291 



EFM Feedback User Guide  Survey Question Editing 
 

Data Piping 

You can take data entered or selected as a response and pass it forward to be displayed at 
another location in the survey with the Data Piping feature.  It is recommended that you 
have all your survey questions created first.   
 
Note! 
You cannot pipe data from matrix, side-by-side matrix, or HTML snippet question 
types.  
 
Note! 
You must have a Page Break before the receiving question in your question list for 
the data to be piped in.  
 
To pipe data, a special syntax is required to pass the piped field and display it.  Piping 
syntax is inserted into the receiving question.  The syntax uses the wsb number (ID 
number) of the question as follows: 
 

%q0lbl% 
 

• 'q0' in the syntax example above represents the question in your 
survey you are piping from with an ID number of 0 (wsb0 in your 
question list) 

• 'lbl' enables the actual response text to display 
 
 
Note! 
If the piping syntax does not contain the 'lbl' designator,  the ID number of the 
selected response will be displayed instead of the response text. 

 
If you cannot see your wsb numbers, check My Preferences to make sure they are not set to 
be hidden from view.  Navigate to this option by clicking the My Account tab and selecting 
the My Preferences tab. 
 

 

How to Set Up Data Piping 

Piping syntax can be inserted in your receiving question using the Insert Piped icon (see 
image below) on Editing Tool Bar, or you can type it in manually.   

Method One (auto) 

1. Click on your receiving question to edit it.  You will leave space in the question text 
where the piped value will be displayed.   

2. With you cursor in the location where the piped data is to be displayed, click the 
Insert Piped button. 

3. A dialog is displayed with a drop-down list of the available questions to pipe from. 
4. Select the data to be piped from the drop-down list. 
5. Click OK to close the piping dialog. 
6. The piping syntax is now inserted into your question text in the Question Edit dialog. 
7. Click OK to close the Question Edit dialog.
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Method Two (manual) 

1. Click on your receiving question to edit it.  You will leave space in the question text 
where the piped value will be displayed.   

2. With your cursor in the location where the piped data is to be displayed, click the 
HTML icon. 

3. The question is changed to HTML edit mode. 
4. Type in the piping syntax in the appropriate location in the question text. 
5. Clicking the Design icon will return the question view to normal. 
6. The piping syntax is now inserted into your question text in the Question Edit 

dialog. 
7. Click OK. 

 

 
Data Piping Setup 
 
 
Example: 
Assume you have a Choose One question: 
 

What is your favorite color? 
 

• red 
• yellow 
• green 
• blue 

 
This question has an ID number of wsb0. 
 

-----SIMPLE PAGE BREAK----- 
 
Your receiving question will look like this: 
 

Why is %q0lbl% your favorite color? 
 

When the survey is taken, the syntax in the receiving question (%q0lbl%) will be replaced 
by whatever response the user selected in the first question.
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Required Questions 

You can set your question to be required so that respondents must answer the question 
before moving to another page of the survey or submitting the survey.   
 
If a required question is not answered and the respondent attempts to navigate to another 
page or submit the survey, a popup message alert will display advising the respondent that 
an answer is required.  Different question types have different messages in the alert 
box.  The alert messages can be edited by navigating to Properties/Languages & 
Messages/Validation Message from the Question List Pane. 
 
There are two methods for requiring questions: 
 

• within the individual question 
• from the Question List Pane  

 

Set required from within the question 

You can make the following question types required by going to the Advanced tab of the 
question while in editing mode and selecting the check box for 'Require this question to 
be answered in the survey ': 
 

• Choose One 
• Choose All That Apply 
• Fill In The Blank 
• Essay 
• Numeric Value 
• Date Value 
• Rank Order 

 
You can make the following question type required by selecting the Advanced tab of the 
response field while in editing mode and selecting the check box for 'Require this 
question to be answered in the survey ': 
 

• Data Block 
  All response fields or only particular ones can be required. 
 

You can make the following question types required by selecting the Advanced tab when in 
editing mode, and then selecting the check box for each category in the Required box at 
the bottom left of the dialog: 
 

• Choose One Matrix 
• Choose All That Apply Matrix 
• Side-By-Side Matrix (select a side then select the Advanced tab) 

  All categories or only particular ones can be required.
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Set required from the Question List Pane 

Questions can be required from the Question List Tool Bar. 
 

1. Select the check box of the question you want to require. 
2. Click the Required button on the right side of the tool bar. 
3. The question will have the required icon placed in the far right column. 

 
 
Note! 
You can require all of your questions at once by selecting the check box on the far 
left side of the Question List Tool Bar and then clicking the Required button. 
 
You can remove the required status by selecting the check boxes then clicking the 
Required button. 
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Disable/Enable a Question 

Disabling a question turns off the question without deleting it so that it is not visible in your 
survey. 
 

 

Disable a Question from the Advanced Tab 

1. Select the question to be disabled in the Question List Pane. 
2. Select the Advanced Tab. 
3. Select the check box that reads 'Disable this question in the survey.'  
4. Click OK. 

 
Note! 
For Side-By-Side Matrix questions, the disable function is located on the Basic tab 
just under the question text box. 
 

 

Disable a Question from the Question List Pane 

1. Select the check box to the left of the question to be disabled. 
2. Click the Disabled button on the right side of the List Edit Tool Bar. 
3. The question is disabled and the disabled status icon is placed in the far right column. 

 

 

Enable a Question from the Advanced Tab 

Enabling a question turns on a question that has been disabled so that it is again visible in 
your survey. 
 

1. Select the question to be enabled by clicking on the question text in the Question 
List Pane. 

2. Select the Advanced Tab. 
3. Clear the check box that reads 'Disable this question in the survey.'  
4. Click OK. 

 

 

Enable a Question from the Question List Pane 

1. Select the check box to the left of the question to be disabled. 
2. Click the Disabled button on the right side of the List Edit Tool Bar. 
3. The icon is cleared and the question is enabled.
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Chapter Seven 

Publishing Your Survey 
 
 
 
 
 
 
 
 
 

Discussed in this Chapter 
Publishing/Republishing Your Survey 
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Publishing Your Survey 

 

Publishing Your Survey 

Once your survey has been finalized you will need to publish it to make it available to your 
respondents.  The publishing process produces the link (URL) your respondents will use to 
access the survey. 
 

Steps 

1. Go to the main Feedback Page. 
2. Select the survey you want to publish from the Survey List Pane. 
3. With the survey highlighted, select Publish Survey from the Options Pane.  
4. Click the Publish button in the tool bar. 

 

 

Ensure survey is accessible through SSL 

You can publish your survey as a Secure Survey, which is protected by 128-bit SSL 
encryption.  You can enable the Secure Survey feature (SSL) from the Publish Tab by 
selecting the check box to 'Ensure survey is accessible through SSL.'   
 

 

Republishing 

Once you have published a survey, you may decide to make cosmetic changes to it.  Initially 
your changes are contained in a working version of the survey.  In order for changes to take 
effect in the published version, you have to republish the survey. 
 
To republish a survey, select Publish Survey from the Options Pane.  The survey URL 
will be displayed and the button on the Publish Tab will now read 'Republish.'  Click the 
Republish button to update the survey. 
 
 
Warning! 
Use great caution when editing a survey that has already been published and has 
collected data.  Each question and response option has a unique wsb number 
(internal ID number) that was assigned when it was created.  If you delete a 
question or response option, then add it back into the survey, the wsb number 
changes.  Any data that had been collected against the original wsb number will be 
orphaned and you won't be able to view it. 
 
If you have to make changes to questions or response options in a live survey, edit 
only the text label portion without deleting the entire item. 
 
Republishing will permanently apply the changes.
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Chapter Eight 

Mailing Lists 
 
 
 
 
 
 

Discussed in this Chapter 
 
Mailing Lists 

Mailing Lists Overview 
Mailing Lists - Getting Started 

How to Create a Mailing List 
How to Create a Mailing List 
Add New Record 
Add Multiple Emails 
Export List 
Import CSV List 
Column Headers 
Unsubscribe Recipients 
Field Mapping a Mailing List 

Mailing List Properties Menu 
Mailing Lists Properties 
Overview 

Mailing List Actions Menu 
Mailing Lists Actions Overview 

Working with Gateway Pages 
Create New Gateway 
Editing Your Gateway Template 
Field Mapping a Gateway Page 

Recipient Filters 
Filtering Your Mailing List 
Create New List Filter 
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Mailing Lists Home Page 

Mailing Lists Overview 

Use:  The Mailing Lists feature is used to create an invitation for recipients to take your 
survey, and then send it to all the recipients in your mailing list.   
 
Go to the Mailing Lists Getting Started section for more details. 
 
There are four main components in the Mailing Lists Options Pane: 
 

• Edit Mailing List 
• Manage E-mail Campaigns 
• Gateway Surveys 
• Edit Recipient Filters 

 

 

Edit Mailing List 

The Mailing List is the list of recipients that will be invited to take your survey.  It will 
contain the E-mail addresses of the recipients as well as any other information that may be 
passed into the survey results.  This option is where you will create, edit and review your 
mailing lists. 
 

 

Manage Campaigns 

A campaign is the message you will send via E-mail inviting recipients to take your 
survey.  The message can be in standard text format and also supports HTML formatting, 
and contains the link to your survey.  This option is where you will create the message to be 
sent and set parameters for the campaign. 
 

 

Gateway Surveys 

Using the gateway feature, you can restrict access to your survey and require that 
respondents log in to access your survey.  You can select a 'UserID' field to require login for 
the survey, or you can select a 'Password' field which would require both login and 
password for the survey. 
 

 

Edit Recipient Filters 

You can set up filters for your mailing list and send the campaign (your E-mail invitation) to 
a specific set of people on your list.
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Mailing Lists Getting Started 

 
The main steps in setting up a mailing list and sending an invitation to take your survey are: 
 

• Create a Mailing List 
• Create a Campaign 
• Field Mapping 

 
Other features that can be utilized are: 
 

• Setting up a Gateway Page 
• Scheduling a Campaign 
• Setting up a Recipient Filter 
• Sending Reminder, Follow-up and Thank You jobs 

 

 

Create a Mailing List 

You must first create a list which will contain all the recipients to be invited to take your 
survey.  The list will contain the E-mail address of each recipient as well as any other 
information you want to include such as First Name, Last Name, etc. 
 
When you first create your list structure, you are placed in the List Edit mode and the list 
column headers are displayed.  The list has predefined columns for Unique ID and E-mail 
as well as 20 additional columns that can be used to hold other information such as Name, 
Last Name, etc. These columns can be renamed (recommended) so that the column 
headers are meaningful and relate to the data that will be stored there. Renaming these 
columns will also simplify the field mapping step if you import your data from a CSV file into 
the list.   
 
Once your list structure has been created, the next step is to add the data to your list.  The 
most common method of adding data to a mailing list is to import the data from a CSV 
(comma separated values) file.  Data can also be added to a list manually or through the 
Add Multiple E-Mails feature. 
 
Note! 
Survey results also have predefined columns for UniqueID and Email.  These 
columns are empty unless values are forced into them. Using the field mapping 
process when you create your campaign, you can have designated values from 
your mailing list display in these columns in your survey results.  This is useful 
when it is necessary to identify who responded to your survey. 
 

Create a Campaign 

When you have created your mailing list, you then have to create a campaign which is 
the message to be sent to your mailing list recipients inviting them to take your survey.  The 
campaign is linked to the mailing list through the Field Mapping tab.  Field mapping 
connects the appropriate data columns in the mailing list to values that may be used in your 
message.
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Field Mapping 

Field mapping in your mailing list is used to connect specific fields in your CSV file 
(usually viewed in Excel) to data columns in your mailing list. 
 
Field mapping a campaign is used to associate your survey with your mailing list.  The 
field mapping process may also include linking hidden fields used in your survey to the 
appropriate data columns in your mailing list to capture data from your recipients without 
requesting them to enter it.  The values are pulled from the mailing list and populated in 
your survey results. 
 
Tip! 
If you want to track who responded to your survey, and you do not have any 
hidden fields in your survey, you can map the E-Mail field from your mailing list to 
UniqueID when you set up your campaign.  This will populate the UniqueID column 
in your survey results with the respondent's E-mail address from the list.
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How to Create a Mailing List 

Creating a mailing list involves two main steps.  You have to create the list structure and 
give it a name, and you have to populate the list with the recipient data. 
 

Create the List Structure (List Properties) 

1. From the Mailing Lists Home Page, click the Create Mailing List button and a Create 
New List dialog is displayed. 

2. Provide a List Name in the text box and select the check box for the Vovici Anti-
Spam policy.   

3. Click OK. 
4. You will be placed in Edit mode to create your list (see example below).  Columns 

are predefined for UniqueID and Email address.  The additional 20 columns can be 
used to hold any other data that you want in your list.  Examples are First Name, 
Last Name, etc. 

5. To rename the Column Headings, click the down arrow next to the Properties drop-
down menu and select the Column Headers option. The Rename Column Headers 
dialog displays (see example below). 

6. Enter column names in the text boxes provided for each column you want to rename. 
7. Click OK.  The list display is updated to show the Column Headers you added (see 

example below).  You are now ready to add data to your list. 
 
Tip! 
You can change your list name (if necessary) by selecting List Name from the 
Properties drop-down menu while in Edit mode and entering the new list name. 
 
 

 
Mailing Lists - Edit Mode
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Mailing Lists - Rename Column Headers 
 
 

 
Mailing Lists - Column Headers Applied
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Gateway 

Using the gateway feature, you can restrict access to your survey and require that 
respondents log in to be able to access your survey.  You can select a 'UserID' field to 
require a login ID for the survey, or you can select a 'Password' field which would require 
both a login ID and a password for the survey.   
 
 

Add Your List Data 

Note the Actions drop-down menu just above the List Pane containing these options: 
• Add Multiple E-Mails - You can use this method to quickly enter a list of simple E-

mail addresses. 
• Import CSV List - You can use this method to import your data from a CSV file. 
• Export List - You can export your list to a CSV or XML file. 
• Unsubscribe Recipient(s) - You can include a link in your campaign to allow users 

to unsubscribe. Clicking the unsubscribe link will delete their record from your mailing 
list. 

You can also populate your mailing list by adding new records manually. 
 
Alert! 
When adding data to your list, the E-mail addresses must be in the predefined E-
Mail column in order for the invitations to be sent. 

 

Add New Record Manually 

You can add records to your mailing list manually.  This method is best suited for situations 
where the survey audience is small, and the amount of data to be entered in the list is 
minimal. 
 

 

Steps 

1. From the Mailing Lists Home Page, click the list name to be edited and select Edit 
Mailing List from the Options Pane. 

2. Click the Add New Record button (see example below). 
3. Enter appropriate data in fields as needed (see example below). 
4. Click OK. 
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To edit a record that already exists 

1. Select the list to be edited and click Edit Mailing List. 
2. Click the E-mail address of the record to be edited. 
3. Edit the fields as needed, click OK. 

 
 

 
Mailing Lists - Add New Record Manually 
 

 
Mailing Lists - Add Record Data Manually

June 2007                                                                                                             Page 113 of 291 



EFM Feedback User Guide  Mailing Lists 
 

Add Multiple E-Mails 

To navigate to the Add Multiple E-Mails option, go to the Mailing Lists Home Page and 
select a mailing list from the List Pane.  Click Edit Mailing List and you are placed in the 
Edit Tab. 
 
The Add Multiple E-Mails option is located under the Actions drop-down menu.  
 
This option is used when you want to add a list of simple E-mail addresses.  All the E-mail 
addresses will be inserted into your mailing list at the same time. 

 

Steps 

1. From the Mailing Lists Home Page, click on the name of your mailing list then select 
Edit Mailing List from the Options Pane. 

2. From the Actions drop-down menu, select Add Multiple E-Mails. 
3. A page displays with a text box where you enter your E-mail addresses, one per 

line.  E-mail addresses can be typed in or copied and pasted from another 
application.  Each E-mail address will be a separate record in your mailing list (see 
example below).   

4. Click OK.   
 
 

 
Mailing Lists - Add Multiple E-mails
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Import CSV List 

To navigate to the Import CSV List option, go to the Mailing Lists Home Page and select a 
mailing list from the List Pane.  Click Edit Mailing List and you are placed in the Edit Tab. 
 
The Import CSV List option is located under the Actions drop-down menu. 
 
It is recommended that you use Excel to work with your CSV (Comma Separated Values) 
file.  The file should be created with the first row containing column headers and must be 
saved in CSV format to facilitate proper importing. 

Steps to create your CSV file 

1. To create a CSV file, open an Excel spreadsheet. 
2. Create column headings in the first row of the CSV file. 
3. Enter the appropriate data in the columns. 
4. Save the file as a CSV file.  (In the “Save as Type” text box, select the down arrow 

and choose CSV from the list file types). 

Steps to Import your CSV file 

1. Go back to your EFM Feedback application and while in Edit mode (edit tab), select 
Import CSV List from the Actions drop-down menu. 

2. On the CSV Import page, select Append.  This will add your data to the mailing 
list.  Selecting Replace will overwrite data in an existing list with the information 
contained in the CSV file. 

3. Select 'Update existing records that match' if you want to update only those 
existing records that match a certain field selected from the drop-down list. 

4. Click Browse to navigate to your CSV file. 
5. Select the check box for 'The first row in the CSV file contains the column 

headings.' 
6. Click Next. 
7. Click OK. 
8. On the Choose field mapping screen, you will use the drop-down lists to link the 

data from your CSV file to the correct column in your mailing list.  The names in the 
left columns represent your mailing list, and the names in the drop-down lists 
represent your CSV file.  

9. Match the name on the left with the corresponding name in the drop-down list on the 
right.  The field for Unique ID is optional.  You can leave it blank if you do not have 
a unique ID.   

10. Click Finish. 
 
Alert! 
The Email drop-down menu MUST be mapped for your campaign to be sent. 
 
The CSV data is imported into your mailing list and you are again placed in the Edit mode 
of the mailing list.   
 
If you need to edit a record after you have imported the data, you can do so by clicking on 
the E-Mail address of the record.  The Edit Record dialog will display and you can make any 
necessary changes.
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CSV File in MS Excel 

When the file is saved, select CSV as the Save as Type and save in the folder of your choice. 
 

 
CSV Save as Type 
 
 
 
   CSV Import – Field Mapping 

 

Column Headers 

 
To navigate to the Column Headers option, go to the Mailing Lists Home Page and select a 
mailing list from the List Pane.  Click Edit Mailing List and you are placed in the Edit Tab. 
 
The Column Headers option is located under the Properties drop-down menu.  
 
When you create a mailing list structure, there are columns that are predefined for 
UniqueID and Email address.  There are 20 additional available columns that can be used 
to hold other data that you may need to have in your list.  They are referred to as UDF 
(user defined fields).  Each one has a default name of 'Column #' followed by a text box. 
 
You should name these columns to match the data columns in your CSV file (viewed as Excel 
spreadsheet).   

To name columns 

1. Select Column Headers from the Properties drop-down menu. 
2. Enter your column name in the text box.  
3. Click OK. 

 
 
 
CSV Import – Choose field mapping
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Example: 
UDF fields (User Defined Fields) are often used in a campaign to personalize the invitation 
that is being sent to recipients.  These UDF fields in your campaign get their names from the 
Column Headers in your mailing list. 
 
Assume your mailing list has a column of data for the First Name of your recipients. 
 

• Under Properties/Column Headers, enter 'First Name' in the Column 1 text box. 
• Click OK. 

 
When you create a campaign and type your campaign message, the Column names will be 
listed to the right of the message text in the Available Fields box.   
 

 
Available Fields 
 

• Click First Name in the Available Fields box and that UDF field is inserted into your 
message.  UDF fields are placed at the bottom of the message by default. 

• Use 'cut' (Ctl-x) to remove the field from the bottom of the message.  Place your 
cursor in the desired location in the message then 'paste' (Ctl-v) the UDF field.  The 
UDF field is linked to your mailing list and is used to insert the data from the First 
Name column in your list into your campaign message as shown below: 

 

 
UDF Field Usage in a Campaign Message 
 
When the message is sent to the recipient, their first name will replace the UDF value in the 
message and the greeting will be personalized.
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Export List 

 
To navigate to the Export List option, go to the Mailing Lists Home Page and select a 
mailing list from the List Pane.  Click Edit Mailing List and you are placed in the Edit Tab. 
 
The Export List option is located under the Actions drop-down menu. 
 
You can export your mailing list to a CSV file (Comma Separated Values) or to an XML file 
(Extensible Markup Language). 
 
Alert! 
If you are exporting a very large list to a CSV file, file size limitations in Excel could 
prevent you from being able to export the entire list. 
 

 

Steps 

1. Select Export List from the Actions drop-down menu on the Mailing Lists Edit Tab. 
2. Select CSV (Comma Separated Values) or XML (Extensible Markup Language). 
3. Click Export. 
4. Select Open or Save.  If you save the file to your computer, navigate to the location 

where you want to save the file and click Save. 
 
 
Note! 
You can rename the file or save it with the default name provided.
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Unsubscribe Recipient(s) 

To navigate to the Unsubscribe Recipient(s) option, go to the Mailing Lists Home Page 
and select a mailing list from the List Pane.  Click Edit Mailing List and you are placed in 
the Edit Tab. 
 
The Unsubscribe Recipient(s) option is located under the Actions drop-down menu.  
 
Use this option to remove unwanted E-mail addresses from your mailing list.   
 

First create a text file with all of the E-mail addresses you want to remove from your 
mailing list. 

 
Note:  Copy and paste the E-mail addresses to the text file or simply type them.  You 
should have only one address per line. 
 
Example: 
asmith@myemail.com 
bsmith@myemail.com 
csmith@myemail.com 
 
Save the text file and follow the steps below to delete the E-mails you compiled in 
your text file from your selected mailing list. 

 

Steps 

1. Select a mailing list by clicking on its title from the Mailing Lists Home Page. 
2. Click Edit Mailing List. 
3. In the Actions drop-down menu, select Unsubscribe Recipient(s).  
4. Use the Browse button to navigate to the text file containing the unsubscribe 

addresses.  
5. Click Unsubscribe. 
6. The E-Mail addresses are removed from your mailing list. 

 
 
Tip! 
You can also remove recipients from your mailing list by adding the 'Unsubscribe 
URL' to your invitation message from the Available Fields box on the Campaigns 
Message Edit Tab.  If one of your recipients desires to be removed from your 
mailing list, they simply click the 'Unsubscribe' URL and they are automatically 
deleted from your list.
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Field Mapping a Mailing List 

When you import a mailing list from a CSV file (usually viewed in Excel), it is necessary to 
choose field mapping to ensure that data from your CSV file is imported into the proper 
columns in your mailing list.  There are two columns of drop-down lists displayed on the 
Choose field mapping page.   
 
There are predefined column names for Unique ID and Email on the left side.  There are 
20 additional fields that can be used to hold data that you may want to pass into your 
survey results.  You should rename these fields to match field names in your CSV 
file.  Your CSV file should be saved with the first row containing the column header 
names. 
 
Note! 
A mailing list has predefined columns for Unique ID and Email which do not have 
to be renamed.  Data values for Unique ID are not required but may be helpful.  A 
Unique ID could be something as simple as a chronological number (i.e., 1,2,3) 
 
Alert! 
The Email drop-down text box MUST be mapped for your campaign to be sent.  In 
your mailing list, the E-mail addresses must be in the predefined E-Mail 
column.  Map E-mail in your mailing list to Email in your drop-down text box.  This 
will ensure that all of your E-mail addresses are placed in the proper column in 
your mailing list to be used in sending your campaign. 

 

Steps 

1. To navigate to the Edit Tab, from the Mailing Lists Home Page select a mailing list 
from the List Pane and click Edit Mailing List. 

2. Select Import CSV List from the Actions drop-down menu, or select it from the 
Editing Tool Bar. 

3. On the CSV File to Import page, select Append if this is a new list or you are 
adding to another list.  Select Replace to overwrite an existing list.  

4. Select 'update existing record that match' if you want to update only those 
existing records that match a certain field selected from the drop-down list. 

5. Click Browse to navigate to your CSV file. 
6. Select the check box for 'The first row in the CSV file contains the column 

headings.' 
7. Click Next. 
8. On the Choose field mapping screen, you will use the drop-down lists to link the 

data from your CSV file to the correct column in your mailing list.  The names in the 
left columns represent your mailing list, and the names in the drop-down lists 
represent your CSV file. 

9. Match the name on the left with the corresponding name in the drop-down list on the 
right.  The field for Unique ID is optional.  You can leave it blank if you do not have 
a unique ID.   

10. Click Finish. 
 
You can also perform field mapping when setting up your campaign to enable tracking of 
your survey respondents or to pass information from the mailing list into your survey results.
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Mailing Lists Properties Menu 

Mailing Lists Properties Overview 

The Properties drop-down menu is accessed when you select Edit Mailing List.  To 
navigate to this location, from the Mailing Lists Home Page, select a mailing list from the List 
Pane and click Edit Mailing List. 
 
There are three options on the Properties menu: 
 

• Column Headers 
• Gateway 
• List Name 

 

 

Column Headers 

When you create a mailing list structure, there are columns that are predefined for 
UniqueID and Email address.  There are 20 additional available columns that can be used 
to hold other data that you may need to have in your list.  They are referred to as UDF 
(user defined fields). Each one has a default name of 'Column #' followed by a text box. 
 
You can name these columns to match data columns in your CSV file.   

To rename columns: 

1. Enter your column name in the text box. 
2. Click OK. 

 

 

Gateway 

If you want to restrict access to your survey, you can set it up with a Gateway Page which 
requires the respondent to login to take your survey. 
 
The login values are set through the Gateway option under the Properties drop-down 
menu when the list structure is created.  If the login values are not specified in this 
option when the list is created, they can be specified from the Basic Tab under the Create 
New Gateway option.  
 
A gateway page can be set up using one login value for a User ID field, or two login values 
can be used to require the respondent to enter a User ID and Password.   
 
If you wish to change the login values to be used, you can do so through the Gateway 
option under the Properties drop-down menu when you Edit your mailing list.  You can 
also change login values by editing the gateway field mapping on the Gateways Tab under 
Mailing Lists.
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List Name 

When you create a mailing list the first thing that is required is that you name the list.  You 
simply provide a list name in the text box and click OK. 
 
If you need to change the list name at a later time, you can do so by selecting the List 
Name option under the Properties drop-down menu when you select Edit Mailing List.
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Mailing Lists Actions Menu 

Mailing Lists Actions Overview 

The Actions drop-down menu is accessed when you select Edit Mailing List.  To navigate 
to this location, from the Mailing Lists Home Page, select a mailing list from the List Pane 
and click Edit Mailing List. 
 
There are four options on this menu: 
 

• Add Multiple Emails 
• Import CSV List 
• Export List 
• Unsubscribe Recipients 

 

Add Multiple Emails 

This option is best suited for mailing lists that will contain only Email addresses. 
 
You can enter your email addresses in the text box provided, one E-mail address per line, 
and add them all into your mailing list at the same time. Punctuation is not necessary.   
 
 

Import CSV List 

This option is the most frequently used method for adding data to your mailing list.  The CSV 
(Comma Separated Values) file will contain all your list data.  Each column of data will have 
a column header which will be utilized in the field mapping process during the import to 
help associate the data in your CSV file with the proper column in your mailing list. 
 
Note! 
To properly import your list, it must be in CSV format.  If you create the list 
yourself, you can create it in Excel and save it as a CSV file. Simply select the CSV 
file type from the drop-down list when you save the file. 
 
 

Export List 

With this option you can export your mailing list out of the application into either a CSV 
(Comma Separated Values) file or to an XML (Extensible Markup Language) file. 
 
Alert! 
If you are exporting a very large list to a CSV file, file size limitations in Excel could 
prevent you from being able to export the entire list.
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Unsubscribe Recipients 

 
You can use this option to remove email addresses from your mailing list if recipients no 
want to receive invitations.  The addresses are saved in a text file with one address per 
line.  When the unsubscribe option is applied, the addresses in the text file are deleted 
from your mailing list.
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Working with Gateway Pages 

Create New Gateway 

You can limit the people who have access to your survey by enabling a gateway page which 
will require them to log in using values from your Mailing List.  The login values on the 
gateway page are verified against the values in your mailing list. 
 
The Create New Gateway feature can be accessed by selecting Mailing Lists from the 
Page Navigation tabs at the top of the page, selecting a mailing list from the List Pane and 
then selecting Gateway Surveys from the Options Pane. 
 
A gateway page can be setup using one login value for a UserID field, or two login values 
can be used to require the user to enter a UserID and Password.  The login values are set 
through the Gateway option under the Properties drop-down menu when the list structure 
is created.  If the login values are not specified when the list is created, they can be 
specified from the Basic Tab under the Create New Gateway option. 
 
If you wish to change the login values to be used, you can do so through the Gateway 
option under the Properties drop-down menu when you select Edit Mailing List.  You can 
also change login values by editing the gateway field mapping on the Gateways Tab under 
Mailing Lists. 
 
Note! 
Once the gateway login fields have been defined for a particular mailing list, that 
gateway can be attached to other surveys.  However, all surveys using that 
gateway will have the same login fields.  Login fields cannot be changed for 
different surveys using the same gateway. 
 

Steps 

1. From the Mailing Lists Page, select a mailing list name then click Gateway 
Surveys in the Options Pane. 

2. Click Create New Gateway. 
3. Select the survey you want to use from the drop-down list.  
4. Click Add Survey Gateway. 
5. On the Basic Tab, if you want to restrict survey access to one submission per user, 

select the check box to 'Allow only one response per authenticated user.' 
6. Select the login fields to be used for UserID and/or Password from the drop-down 

lists.  The values in the drop-down lists correspond to fields in your Mailing List.  The 
names of the fields that are selected will be the text for the login boxes on the 
gateway page. 

7. If you want to track your respondents or collect information from them through 
hidden fields, you have to set up the field mapping using the bottom set of drop-
down lists.  The values on the left represent fields in your survey and the values in 
the drop-down lists represent fields in your Mailing List.  

8. On the Template Tab, you can modify the display of the Gateway Page.  Click here 
for more information on editing your gateway template. 

9. Click OK.
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Alert! 
When using a survey gateway, persistence is associated with the user rather than 
the machine.   
 
Example:  
Sue begins a multi-page survey (with a gateway) on her home computer, and part 
of the way through the survey she closes the survey and goes to work.  Once at 
work, Sue will be able to continue the survey on her work computer from the first 
question on the last page she visited.  This is applicable to a multi-page survey 
only because the selected/entered answers are not stored until the user clicks to 
the next page.  
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Editing Your Gateway Template 

You can edit your gateway template to alter the display of the standard gateway page.  This 
option is located on the Template Tab when you select Create New Gateway. 
 
A text editing area is provided where you can make code changes to the standard gateway 
page that normally displays.   
 
You can also enter your own Authentication Error Message to be displayed if the login 
information on the gateway page is incorrect. 
 
There is a default template example that can be displayed and used as a guide for making 
your changes. Click the Insert Template link under the text box to display the code.   
 
Another method to get the HTML code of the standard gateway page is to click the URL of 
the survey so that the standard gateway page is displayed.  You can then right-click on this 
page, select View Source, then Select All the code and copy it.  It can be pasted into the 
text editing area and modified as necessary. 
 
Click OK when your editing is completed. 
 
Note! 
Modifying gateway template code requires that you have a good understanding of 
HTML.   
 
Alert! 
Do not remove the tags <!--WSBFORMACTION--> and <!--WSBGATEWAYERROR--> 
from the gateway page HTML code.
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Gateway Edit Page - Default HTML Code
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Field Mapping a Gateway Page 

When you create a gateway page for your survey, you can track your respondents by 
collecting their E-mail address or a Unique ID, and you can also collect data for them 
through hidden fields in your survey.   
 
Collecting these data values is accomplished through field mapping.  Field mapping links 
your survey fields to the corresponding fields in your mailing list.  When the survey is 
submitted, the data value from your mailing list is displayed in the corresponding field in 
your survey results. 
 
Field mapping for a gateway page is done on the Basic Tab when you create the gateway 
page.  This tab contains fields with drop-down text boxes in the top portion that define the 
login fields for the gateway page itself and the mapping fields and their drop-down text 
boxes are in the bottom portion of the tab.  These login fields can also be defined through 
the Gateway option under the Properties drop-down menu when you Edit your mailing 
list.   
 
Selecting the check box to 'Allow only one response per authenticated user' will ensure 
that respondents cannot submit the survey multiple times. 
The fields listed on the left side of the Basic Tab represent columns in your survey 
results.   
The fields listed in the drop-down text boxes represent columns in your mailing list. 
 
Note! 
Unique ID is a constant column in surveys and mailing lists.  It is only populated 
through field mapping a campaign or field mapping a gateway page. 
 
If your survey has no hidden fields, Unique ID is the only field that will display in 
the mapping dialog. 
 

 

Steps 

1. From the Mailing Lists Home Page, select your mailing list then click Gateway 
Surveys in the Options Pane. 

2. Select an existing gateway page to edit, or click on Create New Gateway.  Field 
mapping is done on the Basic Tab when you are in Gateway Edit Mode. 

3. Mapping a value to be displayed in the Unique ID field in the survey results is 
optional.  However, it is recommended that you map Email to Unique ID.  This will 
capture the respondent's E-mail address and display it in your survey results in the 
Unique ID column. 

4. If your survey contains hidden fields, those hidden field names and their 
corresponding ID numbers will be displayed under the Unique ID field.  Use the drop-
down text boxes to map the corresponding mailing list value to these fields. 

5. Click OK.
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Recipient Filters 

Filtering Your Mailing List 

You can create a filter for your mailing list and send your E-mail campaign to a subset of 
your mailing list based on specified criteria. 
 
Mailing list recipient filters give you the ability to have one central mailing list and define 
filters on that list to help you better manage who your campaign is sent to.   
 
The option is accessed from the Mailing Lists Home Page when you select Edit Recipient 
Filters. 
 
Filter conditions can be grouped using a logical operator (AND/OR).  Conditions can be 
further grouped using the Group Conditions option.  These groupings can be removed 
using the Remove Grouping option.   
 
Conditions can be edited or removed using the respective buttons provided. 
 
Once your filter is created, you will provide a Filter Name and save it.  The filter can then be 
associated with the message when creating your campaign.   
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Create New List Filter 

Filtering your mailing list gives you the flexibility to send your campaign to a specified 
portion of the list.  You can create a simple filter containing only one condition or a complex 
filter that is based on more than one Value. 
 

 

Steps 

1. Select your mailing list from the Mailing Lists Home Page and choose Edit 
Recipient Filters. 

2. Click Create New Filter. 
3. Select the field you wish to base the filter on from the User Defined Field drop-

down list. 
4. Choose the appropriate Conditional Operator from the drop-down list. 
5. Enter the value to filter on in the Value text box. 
6. Click Add To Filter.  Your filter statement is displayed in the Current Recipient 

Filter text box. 
7. Enter a name for your filter in the Filter Name text box at the bottom. 
8. Click OK to save the filter so it can be referenced when you send your campaign. 

 
 
There are buttons at the bottom of the dialog for the following functions: 
 

• Group Conditions - Places parentheses around selected conditions to group them 
together.  Using parentheses will override the default order of evaluation and the 
conditions in the parentheses will be evaluated first. 

• Remove Grouping - Removes the parentheses from selected conditions. 
• Edit Condition - Edit the selected condition. 
• Remove Condition - Removes the selected condition. 
• Clear Filter - Clears any filter conditions in the Current Recipient Filter text box.
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Mailing List Recipient Filter
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Chapter Nine 

Invite People to Take Your Survey (Campaigns) 
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Invite People to Take Your Survey (Campaigns) 

What is a Campaign? 

A campaign is the mechanism that associates your survey with your mailing list.  It is 
where you create the message text that will be sent to the recipients in your mailing list 
inviting them to take part in your survey. 
 
To get started, you will create a new campaign.  
 
When you click Create New Campaign, the Message Tab will be displayed.  Fields that 
will be included in your message are: 
 
From Name The name of the person sending the campaign. 
From Address The confirmed E-mail address of the person sending the campaign. 
New... This link is used to confirm additional E-mail addresses to be used 

in sending your campaigns. 
Reply To Address The E-mail address recipients can send a reply to. 
Associated 
Survey 

The title of the survey you are inviting recipients to submit. 

Subject The subject line of the E-mail message you are sending to 
recipients. 

Message The text of the invitation you are sending to recipients. 
Survey Link 
(|LINK1|) 

The link to your survey that will be included in your message text. 

 
 
By default, the invitation message that is sent is a text message.  However, you can include 
HTML formatting in your messages by selecting the check box for 'HTML formatting 
included in message.' 
 
When creating an HTML message, you may also customize the embedded survey link.  If 
you place a trailing asterisk after LINK1, the E-mail system will not create the HTML anchor 
tags.  You will then be able to define your own anchor tag and pass additional parameters 
into the survey or customize the text portion of the link in the message.  The basic syntax is 
as follows: 
 

<a href="|LINK1*|">Click Here to take my survey</a> 
 
 
Sampling Rate:  You can choose to have the campaign sent to a random sampling of your 
list.  The sampling is expressed as a percentage and is selected from the drop-down list 
provided.  Normally, you will select 100% to send to the entire mailing list. 
 
Once you create your campaign message and send it out to your mailing list recipients, the 
Vovici EFM Feedback application will begin to track the following information.  

• Base count:  The number of recipients in your mailing list. 
• Success count:  The number of E-mails that are successfully delivered from the E-

mail server to the people in your mailing list. 
• Bounce:  The number of E-mails that were not successfully delivered to recipients. 
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• Click:  The number of recipients who clicked your survey URL. 
• Submit:  The number of recipients who completed your survey. 

 
Note! 
Tracking counts may not immediately update until processing has completed.  You 
can refresh your browser screen to see updates in counts. 
 
 
You will also be able to see these parameters: 

• Message Subject:  The subject line you entered for the campaign. 
• Type:  The type of campaign being sent (New, Reminder, Follow Up, Thank You). 
• Start Date:  The date and time the campaign was started. 
• Completed Date:  The date and time the campaign completed. 
• Status:  If the campaign is running or has completed. 

 
Note! 
Once you send your invitation, you are instantly taken to the E-Mail Campaigns tab 
where this information is tracked. 
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Create New Campaign Overview 

The Create New Campaign option is accessed from the E-Mail Campaigns Tab.  To 
navigate to this location select the Mailing Lists Home Page and select a Mailing List from 
the List Pane.  Now click Manage E-Mail Campaigns and you are placed in the E-Mail 
Campaigns Tab.  
 
See related topics:  What is a Campaign?, Create Your Campaign Message Options 
 
Any campaigns that have already been created will be listed on the E-mail Campaigns Tab 
with their status and counts.   
 

 
Campaign Status - Tracking Counts 
 
When you create a campaign, there are four functional tabs that are utilized: 
 

Message Enter your message details here (From Name, From/Reply To 
Addresses, Associated Survey, Subject, Message Text, Sampling 
Rate).  There is default message text displayed in the Message box 
that can be used as a guideline for your message entry. 

Piped Fields This tab is used for field mapping through which you can track 
respondents by a Unique ID or E-mail address.  You can also populate 
hidden field columns in your survey results through this field mapping. 

Message 
Filters 

You can choose options here to filter your list using a filter you have 
defined. 

Send 
Preview 

Send a test message to the E-mail address you specify before sending 
the campaign to the entire mailing list. 
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Setting Up Your Campaign 

Create Your Campaign Message Options 

When you click the Create New Campaign button, by default you are placed on the 
Message Tab.  This tab is where you enter all of the details of the e-mail invitation 
message to be sent to your recipients.   
 
Fields that will be included in your message are: 
 

From Name The name of the person sending the campaign message. 
 

From Address The e-mail address of the person sending the campaign 
message.  Click the down arrow and select the e-mail address from 
the list.  To add e-mail addresses to this list select the "New..." link. 
 

New... This link is used to add additional e-mail addresses to your "From 
Address" drop-down list that can be used in sending out your 
campaign messages. 

• Click New..., enter the e-mail address you want to add, click 
Next. 

• A confirmation message is sent to this e-mail address which 
contains a link that you must click to confirm that you want to 
add this new e-mail address.  Once Vovici receives this 
confirmation message back, the email address is ready for 
use and added to your From Address and Reply To 
address drop down lists.   

Note:  Refresh your screen to view the new addresses.  Right 
click in the message area and select refresh. 

Reply To 
Address 

Select the e-mail address from the drop-down list of where you want 
your survey responses delivered. 
 

Associated 
Survey 

Select the title of the survey you are inviting recipients to take.  This 
list contains your published surveys. 
 

Subject Type in anything you like at this location as you would for any e-mail 
message.  This is the "subject" of your survey e-mail message and 
will be displayed to your survey audience. 
 

Message The Message box will initially contain an example message and 
survey link. 
 
Click inside the box and Replace the example message text and 
survey link with your own personal message and survey link. 
 

Survey Link 
(|LINK1|) 

This is the link to your survey that will be included in your message 
text.  The survey link is placed in the message by clicking Survey 
Link from the Available Fields box. 
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Sampling Rate Normally, you will select 100% to send your survey and message to 
your entire mailing list.  You can also choose to have the campaign 
sent to a random sampling of your mailing list.  The sampling is 
expressed as a percentage and is selected from the drop-down list 
provided.  For example, if you select 25%, then your e-mail message 
and survey link will only be sent to 25% of the people on your 
mailing list.    
 

Send Message The check box for 'Schedule message to be sent in 10 minutes' 
will schedule your campaign e-mail message to be sent automatically 
when checked. You also have the option to schedule the campaign 
to be sent using the calendar icon to specify the date and time. 
Want more details? 
 

 
 
Note! 
E-mail addresses used in 'From Address' and 'Reply To Address' must be previously 
confirmed.  Only confirmed E-mail addresses will display in the drop-down lists. 
 

HTML formatting included in message check box 

By default, the invitation message that is sent is a text message.  However, you can include 
HTML formatting in your messages by selecting the check box for 'HTML formatting 
included in message.' 
 
When creating an HTML message, you may also customize the embedded survey link.  If 
you place a trailing asterisk after LINK1, the E-mail system will not create the HTML anchor 
tags.  You will then be able to define your own anchor tag and pass additional parameters 
into the survey or customize the text portion of the link in the message.  The basic syntax is 
as follows: 
 

<a href="|LINK1*|">Click Here to take my survey</a> 
 
 
See related topics:  Create New Campaign Overview, Steps to Create a New Campaign, 
Available Fields 
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Steps to Create a New Campaign 

To Create a New Campaign 

1. Navigate to the Mailing Lists Home Page and select a mailing list from the List 
Pane.  Click on Manage E-Mail Campaigns in the Options Pane. 

2. From the E-mail Campaigns tab, click Create New Campaign.  
3. On the Message Tab, enter values in the text boxes as specified. 
 

Note! 
On the Message Tab all fields are required except Associated Survey; 
however, omitting this field will prevent you from properly including the 
survey link in your message. 

 
4. Type your invitation message text in the Message box, replacing the example text 

that is shown. 
5. To get your survey link into your message, from the Available Fields box to the 

right, select Insert into: Message and click the first item - Survey Link 
(|LINK1|).  This will place '|LINK1|' in your message at the bottom.  You can cut 
(Ctl-x) and paste (Ctl-v) to move it to the desired location in the message. 

6. Choose a Sampling Rate from the drop-down list.  In most cases, you will choose 
'100% (No sampling)' to ensure that the entire mailing list is included. 

7. On the Message Tab, there is a check box for 'Schedule message to be sent in 
10 minutes' that will schedule your campaign to be sent. You can select this box to 
schedule your campaign, or you can schedule the campaign using the calendar to 
specify the date and time it is to be sent.  See the 'Scheduling a Campaign' section 
below for the details. 

8. On the Piped Fields Tab, perform your field mapping to associate your survey 
fields (displayed on the left) with your mailing list fields (displayed in the drop-down 
lists).  It is recommended that you map E-mail from the mailing list to Unique 
ID.  This will capture the respondent's E-mail address in your survey results.  If you 
have hidden fields in your survey, they will be displayed below Unique ID.  Match 
these fields with those from your mailing list as well. 

9. On the Message Filters Tab, choose a filter status (None or a User Defined Filter). 
10. Choose the appropriate status from Include/Exclude Recipients from previous 

message.  Include or Exclude are used when a filter is applied. 
 

Note! 
When Include or Exclude is chosen and a message(s) selected, 'Include' or 
'Exclude' will be displayed in the Sent Message Filter column on the 
Campaign Messages tab as a link.  When you click the link, the E-mail 
addresses of the recipients being included/excluded are displayed along 
with Date Sent, Message ID and the Message Subject. 

 
10. It is recommended that you send a Preview message to verify the accuracy of your 

campaign message and parameters.  On the Send Preview Tab, enter the E-mail 
address of the recipient and click Send. 

11. When options are selected, click OK. 
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Available Fields 

When setting up your campaign message options, a box containing Available Fields is 
displayed to the right of the Message box.   
 
Survey Link (LINK1) is the direct link to your survey.  Including this link in your message 
is essential.  The other fields are optional, but can be used to add personalized information 
from your mailing list into your e-mail campaign message.   
 

Steps to include your Survey Link 

1. First remove the sample text that is included in the message area.  Highlight it and 
hit your delete button, it is simple as that.  

2. Now, click the "Survey Link (LINK1)" text in the Available Fields box and (LINK1) 
displays in your message area.   

 
Note:  This is the link to the survey that you selected from the Associated Survey 
drop-down list directly above the message area. 
Your survey link will show in your message text as |LINK1|.  This variable will be 
resolved by the application and displayed as an encrypted survey link when the 
message is sent.   
 

How to include a personalized message using Available Fields 

Now add any other text you want to the message area. Type your personal message to your 
survey recipients as you would any other e-mail you would send out to your clients.  See the 
sample text in the Example below. 
 
The example below shows a simple invitation message containing a UDF representing First 
Name (|UDF0|) and the survey link (|LINK1|). 
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Example Campaign Message Text with Available Fields 
 
Any of the Available Fields can be inserted into the Subject line of the message or into the 
message itself by selecting the appropriate option from Insert into: area at the top of the 
Available Fields box.  The most common method is to insert the fields into your message. 
 
When a field is clicked from Available Fields, it is displayed in your message as one of the 
values shown in parentheses (UDF0, UDF1, etc.).  In this case UDFO1 is First Name.  The 
title of the UDF field correlates with the column header name from your Mailing List.   
 
Alert! 
Be aware that by default, User Defined Fields are inserted into your message at the 
bottom after any existing text. 
 
Once a User Defined Field is inserted into your message, you can use your normal cut and 
paste features to move the text to where you want it (Cut (Ctl-x) and Paste (Ctl-v) to place 
the UDF where you desire).  
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Associate Your Survey with a Campaign 

When you create a campaign, you are required to choose a survey to be associated with a 
mailing list.  This means that you are choosing what survey link you want to send out to 
your mailing list recipients.   
 
In the campaign creation process, a field mapping process may be necessary.  Field 
mapping is not required unless you want to track your recipients to know who has 
responded to your survey, or you are passing data values from your list that you want to see 
in your survey results. 
 
Passing data values into your survey results is done through the use of hidden fields in 
your survey so that your respondents will not be required to enter the data.  Each hidden 
field will display as a column in your survey results.   
 

 
Hidden Fields In Survey Results 
 
Field mapping is done on the Piped Fields Tab that is displayed when you create your 
campaign.  Field names will be listed on the left with drop-down lists on the right.  The 
names on the left represent fields in your survey and the fields in the drop-down lists are 
data columns in your mailing list. 
 
In the mapping step, you simply match up the appropriate fields on the left with those in the 
drop-down lists on the right.  
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Campaigns - Field Mapping with Hidden Fields 
 
By default, there will always be a field for Unique ID.  If you do not have a Unique ID value 
in your mailing list, it is recommended that you map Email to Unique ID.  This will 
populate the Unique ID column in your survey results with the respondent's Email address 
from your mailing list and enable you to track submissions without your respondents having 
to enter information. 
 
Note! 
If you do not have hidden fields in your survey, Unique ID is the only field name 
that will display on the Piped Fields Tab.  You can map any available field to Unique 
ID for tracking; however, mapping is not required for Unique ID. 
 
Hidden fields must be mapped in order for those columns to be populated in your survey 
results. 
 

Example 

Assume your mailing list has data values for First Name, Last Name and Department 
and you want to view these values for your respondents in your survey results, as well as 
their E-mail addresses. 

1. Your published survey will need to contain hidden field questions at the top for First 
Name, Last Name and Department.  Assume the names and ID numbers of these 
hidden fields are FirstName (wsb39), LastName (wsb40) and Department 
(wsb38). 

2. On the Piped Fields Tab, you will see Unique ID in the left column.  Directly below 
Unique ID, you will see FirstName (wsb39), LastName (wsb40) and 
Department (wsb38).  The right column will have drop-down lists for each field 
name. 
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3. To collect the E-mail address of the respondent, select Email in the drop-down list 
next to Unique ID. 

4. Map FirstName, LastName and Department to their corresponding values in the drop-
down lists.  

5. Click OK. 
 
 
 
 
 

 
Campaigns - Field Mapping with Hidden Fields 
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Preview Your Campaign 

When you create a campaign, it is recommended that you send a preview message to a 
specified E-mail address before sending the campaign out to the entire mailing list.   
 
Preview messages can be sent to anyone and can be sent as often as necessary. 
 
On the Send Preview Tab, enter the E-mail address of the recipient and click Send.  In 
most cases, you will send the preview to yourself.  The Send Preview option can also be 
accessed through an existing campaign by clicking on the Message Subject name to edit 
the campaign. 
 
 

 
Mailing List Campaign - Send Preview 
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Scheduling a Campaign 

After a campaign is created and all the options are specified, the campaign must be 
scheduled to send it to all the recipients in your mailing list. 
 
See related topic:  Create New Campaign Message 
 
On the Message Tab when you Create New Campaign, there is a check box at the bottom 
for 'Schedule message to be sent in 10 minutes' that will schedule your campaign to be 
sent.  You can select this box to schedule your campaign, or you can schedule the 
campaign (see steps below) using the calendar to specify the date and time it is to be sent.  
 
The campaign will be shown in the Campaign List Pane along with any other campaigns 
you have created. There will be status columns for: 

• Subject - the subject line entered for your message 
• Sent - the date and time the campaign was sent (blank if not yet scheduled) 
• Base count - the number of recipients in your mailing list 
• Success count - the number of Emails that are successfully delivered to recipients 

from the Email server 
• Bounce - the number of Emails that were not successfully delivered to recipients 
• Click - the number of recipients who clicked the survey URL 
• Submit - the number of recipients who submitted the survey 

 

To Schedule a Campaign 

1. Navigate to the Mailing Lists Home Page and select a mailing list from the List 
Pane and select Manage E-mail Campaigns. 

2. From the E-mail Campaigns tab click on the Subject of your campaign from the List 
Pane and the campaign message dialog will display. 

3. Click the Calendar icon in the far right column. 
4. You can type in the date/time in the text box to schedule the campaign, or use the 

Calendar/Clock icons to select a date and one of the predetermined times from the 
list displayed.  Times in this list are specified in 30 minute increments. 

5. Click OK. 
6. You will be returned to the Campaign Messages Tab which now displays updated 

statuses in the columns.  The scheduled date/time is now displayed in the Start 
Date column.  There is also a Stop icon in the far right column that can be used to 
cancel or stop a campaign if necessary.  

7. When the scheduled time is reached, the campaign will begin running automatically. 

  

Campaign Messages Tab 

This tab displays the status of your campaign.  Fields displayed are: 
• Basic Message Statistics - counts that provide status on E-mail delivery and survey 

access (see descriptions above).  
• Survey link - the URL of your survey 
• Message Subject - the subject entered for your message 
• Type - the type of campaign  
• Start Date - the date and time the campaign will be sent 
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• Completed Date - the date and time the campaign completed processing 
• Status - current status of the campaign (Unscheduled, Running, Completed) 
• Calendar - use this icon to specify the date and time the campaign is to be sent 

 

Message Recipient List Tab 

This tab shows a status summary of your campaign recipients and displays information for 
each one in the fields described below:  

• Email - Email address of the recipient 
• Sent - whether or not the invitation was sent to that recipient 
• Clicked - whether or not the recipient clicked the survey link  
• Submitted - whether or not the recipient submitted the survey 
• Bounced - whether or not the invitation to that particular Email addressed was not 

delivered 
• Error - error code and text description if an error occurred during the delivery 

attempt 
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Sending Reminder, Follow-Up, Thank You Jobs 

In addition to sending your initial campaign, you can send Reminder, Follow Up, or Thank 
You campaigns.  
 
Reminder campaigns are only sent to the people that received your invitation but did not 
actually submit the survey you referenced in your message.  
 
Thank You campaigns are sent only to the people on your mailing list that did actually 
submit the survey.  
 
Follow Up campaigns are sent to every person on your mailing list that received the 
mailing, regardless of whether or not they actually took the survey.  
 
See related topic:  Creating a Campaign 

Steps 

1. From the Mailing Lists Home Page, select the name of your original mailing list 
then select Manage E-mail Campaigns. 

2. Click on the Subject of the original campaign from the List Pane. 
3. Click New Message.  
4. Select the type of campaign you want to send.  
5. Click OK. 
6. When you select one of the campaign options above, you are directed to the 

Message Tab. The fields for From Name, From Address, Reply To Address and 
Associated Survey are prepopulated based on the original campaign.  

7. Enter a Subject line for the campaign. 
8. Enter your Message text. 
9. The Piped Fields tab will not display drop-down menus for field mapping as the 

settings for the original campaign will carry over. 
10. On the Message Filters Tab, you can select the check box to Exclude messages 

to addresses that bounced.   
11. Click OK. 
12. The new campaign will now display on the Campaign Messages Tab and the Type 

column will reflect the campaign type (Reminder, Follow Up, Thank You). 
13. Schedule and send the campaign as normal. 

 
See related topic:  Scheduling a Campaign 
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Survey Management 

Managing the Question List 

The Question List Pane is the area where you add, edit, or manipulate your survey 
questions.  The primary controls for managing the questions in your survey appear in the 
Question List Tool Bar.  
 

 
Question List Pane 
 
 
The survey questions are initially displayed in the order in which they were created in the 
Question List Pane.  Information such as the survey name and the language used for 
this survey are also displayed.   
 
Icons/buttons contained in the Question List Tool Bar are shown in the table below. 

 

 Select All Questions 
 

Paste 

 Add New Question 
 

Add To Library 

 
Move Up 

 
Delete 

 
Move Down 

 
Required 

 
Copy 

 
Disabled 

Question List Tool Bar Icons
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The questions can be selected for certain actions by using the check box to the left of the 
question number.  There is also an expansion arrow next to this check box that will allow 
you to compress the question form and see only the question text, or expand it to see the 
question type and response options. 
 

Edit a Question 

Click the question text to be placed in the Question List Edit Pane.  Question options and 
formatting can be set within this pane. 
 

Delete a Question  

Select the check box next to the question then click the Delete icon on the Question List 
Tool Bar.  The Delete confirmation dialog will display. 
 

Move a Question 

Select the check box next to the question, then move up or down using the Arrow icons on 
the Question List Tool Bar. 
 

Copy a Question 

Select the check box next to the question then click the Copy icon on the Question List 
Tool Bar. 
 
To paste the copied question in another location, click the check box next to the question 
where you want to paste your entry, and then click the Paste icon (clipboard) on the tool 
bar.  The copied question will be pasted after the selected question. 
 

Add To Question Library 

Select the check box next to the question you want to add to your Question Library, and 
then click the Add To Library icon (book) on the List Tool Bar. 
 

Require/Disable A Question 

There is a column at the far right of the list indicating whether a question is Required or 
Disabled.  An example is shown below. 
 

 
Required/Disabled Questions Respectively 
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Note! 
Icons only display in this column if you have a question set to Required or Disabled.  
To clear these actions, select the question then click the Required or Disabled 
button in the Question List Tool Bar. 
 

Internal IDs 

Each question and response option in your survey has a unique wsb number (Internal 
ID).  This value appears to the right of the question and will show as 'wsbXX' where 'XX' is 
a number assigned by the application.  These ID values are used to uniquely identify and 
help map data to the proper question/response in your survey.
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Multi-Language Surveys 

You can create your survey in multiple languages and make it available to an audience of 
international respondents.  In order to begin the process of setting up a multi-language 
survey, click the Languages & Messages option in the Properties drop-down menu when 
you select Edit Survey.   
 
A set of related tabs will now be available that pertain to various functions and messages 
that are normally included in your survey.  The tabs are: 
 

 
Languages Tab Bar 
 
 

Add New Language 

By default your surveys will be single language surveys.  A default language of English (with 
the Culture Code of "eng" and Description of "English") is created.  If you would like your 
survey to be available to display in other languages, the appropriate information for each 
additional language must be input through the Add New Language tab. 
 
Note! 
Translation of the survey text and labels is done by the survey author.  There is no 
automatic translation tool at this time. 
 

 

Message Translation 

These are messages and text used for buttons and question options that are commonly 
displayed in your survey.  You can access these messages and edit them through the 
Message Translation tab.  In a multi-language survey, these boxes will be blank and you 
will need to enter the translated text for those items that you will be using in your 
survey.  The most commonly used items are the Next Page, Previous Page, and Submit 
buttons.  If your survey does not utilize a particular button or message, you do not have to 
translate it. 
 

 

Validation Messages 

These messages pertain to various question types and their settings.  You can access these 
messages and edit them through the Validation Messages tab.  They are displayed in a 
popup alert format and will be shown if a respondent's answer to a specific question does 
not meet the specified criteria of the question.  
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Resume Request 

The Resume Request tab contains the basic code for the default page that displays when a 
survey with persistence enabled has been only partially completed.  If the respondent does 
not complete the survey in one sitting, then clicks on the link to return to the survey to 
complete it, this page will display.  The text of the links and their descriptions can be altered, 
however, the links cannot be removed. 
 

 

Language Request 

This tab provides the interface to edit the standard Language Request page that displays 
for a multi-language survey.  A text box is provided if you wish to customize the page 
display by coding your own HTML.  An example template will display in the text box when 
you click Insert Template.  This example code can be used as a guideline when 
customizing this page.
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Persistence in Surveys 

Persistence in surveys is a feature whereby respondents can exit the survey at predefined 
points and return to it later, picking up on the page where they left off.  
 
Persistence becomes 'active' when a page break is inserted between two questions in your 
survey.  Once the respondent clicks Next Page, their responses up to that point are 
stored.  Persistence is enabled by default, but can be disabled by selecting the check box 
to 'Disable persistence for this survey' under Presentation on the General tab.  
 
When the respondent clicks on the survey link again, the Resume Request Page is 
displayed with the following options: 
 

Resume 
Resume an existing survey submission at the last unanswered question. 
 
Resume From First Page 
Resume an existing survey submission at the first page with the ability to review 
existing  
answers. 
 
Delete 
Delete your existing survey submission. 
 
This option deletes answers you have entered previously.  You will be presented with 
the message 'You have no uncompleted surveys.'  You will have to exit out of this 
window and take the survey from the beginning. 

 
Tip! 
Adding page breaks after every screen full of questions is a great way to make 
your survey more usable. 
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Previewing Your Survey 

You can preview your survey easily to see exactly how it will appear to your respondents 
when it is published.  It is a great way to review your layout and to test functionality such as 
conditional page breaks. 
 
To preview your survey, you must be in the Edit Survey option and have a survey open to 
the Question List.  Click the Preview button above the Question List. 
 
Your survey will be displayed as a respondent would see it, and you can navigate through it, 
answering questions just as a respondent would.   
 
Note! 
Answers to questions and submitting the survey from Preview do not post real 
results to the survey.   
 
Tip! 
If your survey has required questions or numeric defined questions, you can check 
the box to Suppress Validation.  This will allow you to navigate through your 
survey without being required to answer the questions.
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Progress Bar 

You can include a progress bar in your survey.  The progress bar gives the respondent a 
real-time status of their progress through your survey. The Progress Bar selection is located 
under Presentation/General Tab on the Properties drop-down menu. 
 
You can select the style of the Progress Bar to be used.  Currently, there are two styles to 
choose from: Simple Text and Graphical Percent. 
 

 
 
The Simple Text progress bar is a page number version that will show the current page the 
respondent is on out of the total number of pages in the survey. 
 
The Graphical Percent progress bar is a percentage bar graph version that will show what 
percent of the survey has been completed. 
 
 
Clicking on either of the styles listed in the Progress Bar editor will update the Progress Bar 
HTML field to contain the necessary HTML for the progress bar selected. Once you've 
selected a style, click the OK button to save the changes to your survey.  
 

Steps 

1. Click on Presentation under Properties. 
2. Select the check box to 'Include progress bar.'   
3. Click on 'Customize the progress bar' to select which progress bar to use. 
4. Click OK to verify the selection. 
5. Click OK to return to the Question List. 

 
Note! 
The default progress bar is the Simple Text (page number) version. 
 
Note! 
If you have a customized Display Template, make sure you have the code included 
that inserts a progress bar into the survey.  Please be sure to insert the code for 
the Progress Bar below the code for the submit button. These codes must be 
enclosed within the <FORM> tags in your survey template. 
 
For example:  
 

<!--WSBSUBMITBUTTON--><br> 
<!--WSBPROGRESSBAR--> 

 
This tag must be included in your display template for the progress bar to render in your 
survey.
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Secure Surveys and SSL 

You can publish your surveys with SSL enabled to provide an extra level of data security. 
 
To publish your survey using SSL, select the check box to 'Ensure survey is accessible 
through SSL' on the Publish Tab, then click the Publish button. 
 

What is SSL? 

SSL is an acronym for Secure Sockets Layer.  SSL is a network protocol that encrypts data 
between the server (the Vovici Hosting Service) and the client application (a respondent's 
browser).  Since the Internet is a public network with many routing points, most data flows 
through a number of computers and can potentially be viewed by technical people with the 
right hardware and software.  SSL uses public and private key encryption techniques as well 
as certificates to determine that the server is who they claim to be.  Most browsers support 
SSL as a means of encrypting data; most Web-based purchases are handled through SSL 
connections. 

Why should I use SSL? 

By securing your survey and connection to the Vovici hosting service, your respondents can 
feel confident that the data they provide will only be viewable by you and not someone else 
on the Internet.  While the raw data that Vovici transfers is almost completely unreadable 
outside of the Vovici application, the data streams may contain names, E-mail addresses and 
phone numbers that someone could view.  

You can use SSL for two purposes:  

1. Securing the connection between the Vovici application and the Vovici server.  
2. Enabling data transferred from surveys to the server to be secured.  

Securing the connection between the Vovici application and Vovici.COM 

The Vovici application communicates with the Vovici.COM servers for the following purposes:  
 

• Checking account information  
• Publishing surveys  
• Managing Account Information  
• Retrieving the Survey Results  

 
In order to secure each of these points of communication through SSL the server that hosts 
the Vovici application will need to have an SSL certificate installed for that Web site.  If you 
are using the Vovici Hosting Service, rather than hosting the Vovici application on your own 
server, then all you will need to do to secure communication between the Vovici application 
and the server is to modify the URL of the application to include "https://" rather than 
"http://". 
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During the survey publishing process, all image references within the survey will be 
converted to relative paths, meaning the images from your display template will reference 
the image directory on Vovici.COM.  
 
Note! 
This may cause problems if you are referencing images from somewhere other 
than the Vovici.COM servers.  If this is the case, your users may get a message 
that indicates the survey contains both secure and non-secure items.  If so, to 
clear out these notices, you have to make all references the same - either 'http' or 
'https' which may mean just resaving your images. 
 
Once a survey is flagged as secure it can be accessed either through SSL or standard 
HTTP.  As an example, if you normally access a survey through the following:  
 
   http://SurveyURL  
 
You can now reference it as:  
 
   https://SurveyURL  
 
Note that the only difference between the two links is the HTTPS reference at the HTTP 
portion of the survey URL.  If you have a respondent that has problems accessing your 
survey through SSL/HTTPS, they can still access the survey through the HTTP version.  
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Delete a Survey 

To navigate to this option, click the Feedback tab and select the survey to be deleted from 
the List Pane.  
 
Deleting a survey requires a three-step confirmation process.  You will be presented with 
options to delete as appropriate for the particular survey selected: 
 

• Delete the survey and all of its responses 
• Delete the working copy of the survey 
• Delete both the survey and the working copy of the survey 

 
Note! 
When you edit a survey, you are in the working copy and edits do not become 
permanent until the survey is published/republished. 
 

Steps 

 
1. Navigate to the Feedback Home Page. 
2. Select the survey to be deleted from the List Pane. 
3. Click the Delete button in the List Tool Bar. 
4. Select the appropriate delete method by clicking the radio button next to it. 
5. Type the word 'Delete' in the text box exactly as shown (no quotes necessary). 
6. Click the Delete Now button.
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Chapter Eleven 

 Survey Editing Properties 
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Survey Editing Properties 

Properties Overview 

The Properties drop-down menu is located on the Question List Pane and is available 
once you create your survey and select Edit Survey.  It includes the following options: 
 

• Title, Text, & Limits 
• Presentation 
• Languages & Messages 
• Survey History 
• Alerts & Triggers 

 

 
Properties Drop-down Menu
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Survey History 

The Survey History option is located under the Properties drop-down menu when you 
select Edit Survey. 
 
The Survey History dialog displays a list of actions that have been taken against the 
selected survey.  It is primarily used as a diagnostic tool to help determine what has 
happened to a survey in the event a problem occurs.   
 
The information contained in the Survey History is organized by date and 
time.  Information presented includes when the survey was created, updating or resetting of 
results, publishing or republishing the survey and whether or not results were kept or 
purged. 
 
Note! 
The only action that can be taken in this option is to Clear History.  However, it is 
recommended that you do not clear history unless the survey is a test survey.
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Title Text & Limits 

Title & Text Tab 

The Title & Text tab is located under the Title, Text & Limits option, and can be accessed 
under the Properties drop-down menu when you select Edit Survey. 
 

 
Title & Text Tab 
 
 
This tab contains basic information for your survey such as: 
 

• Survey Title:  Enter the title of your survey here.  The title will appear at the top of 
each survey page and is inserted through the display template using the <!--
WSBTITLE--> tag.  

• Author:  You can enter a name for survey author.  The name of the author is 
embedded into the survey HTM file and becomes a field that can be displayed on any 
reports that you generate.  The author name is inserted into your report using the 
<!--WSBSURVEYAUTHOR--> tag in the report template.  

• Comments:  You can add comments about the survey. 
• Opening Text:  This is introductory text that will be included at the beginning of 

your survey.  It is generally used to introduce the purpose of the survey to your 
respondents, and offer other explanatory text or requirements as necessary.  This 
field supports HTML coding. 
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• Closing Text:  This text is displayed at the end of the survey before the Submit 

button and is generally used to thank respondents for taking the survey.  This field 
supports HTML coding. 

• Redirect URL:  If you would like survey respondents to go to a specific web page 
after they submit their responses, enter the complete URL (including http://) into 
this space.  

 
Warning! 
If the address you enter into this field is not valid, your survey respondents will 
receive a "Page cannot be displayed" error.  
 
Although respondents receive this error, their responses ARE collected.  The error 
refers to the redirect page.  To correct an invalid redirect URL, you will need to 
enter the correct version of the URL, and then republish your survey.   
 
Note! 
Changes made to any of these fields need to be applied by clicking OK and the 
survey republished to become permanent. 
 
 
Other tab options from this dialog box include Limits,  API and Advanced. 
 

• Limits:  Security settings that can be applied to your survey. 
• API:  You can set up a call to a web service so that function calls can be made 

utilizing our API feature. 
• Advanced:  This area is used to enter codes provided by our technical support team 

for advanced features or for testing purposes.  Please contact our technical support 
team for assistance. 
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Limits Tab (Security Settings) 

The Limits tab is located under the Title, Text, & Limits option, and can be accessed 
under the Properties drop-down menu when you select Edit Survey.  The Limits tab 
contains options for Response Limits that can be enabled to control access to your survey. 
 

 
Limits Tab 
 

Response Limits 

Under Response Limits the following options are available: 
 

Set a cookie that prevents user from loading this survey after it is submitted 
Setting this option will place a cookie on the workstation of the person taking the 
survey.  If they attempt to load the same survey again a message will display 
indicating that the survey has already been submitted from that workstation.  

 
Note! 
This option can be overridden if a survey respondent has disabled the cookies 
feature on their web browser.  
 

Limit the number of responses to 
This allows you to limit the total number of responses a survey will receive.  Once that 
threshold has been reached the survey will be deactivated and any attempts by 
respondents to take the survey will result in a warning that the survey has received 
the required number of responses. 
 
Stop accepting responses after  
You can set a date and time that the survey will stop accepting responses. You can use 
the calendar and time picker provided to set your parameters, or you can enter the 
values.  If you enter the date/time yourself, specify a stop date and time as Eastern 
Time (i.e., effective on the United States East Coast) in 24-hour military format. 
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API Call-back Usage 

The Vovici Server API can call a Web service on an initial survey request and/or after a final 
survey submission.  In addition to having the survey submission data available to an 
application immediately, both of these call-backs also give an external application the ability 
to modify or input data into the survey submission either before the first page is 
rendered or after the last page is submitted.  
 
To enable either call-back, you must implement a Web service.  Any language offering 
Web services support should be acceptable. 
 
Note! 
When implementing a Web service for Vovici Server in MS .NET, you must use the 
namespace "http://desktop.websurveyor.net/WSWebTopSvc".  The service 
filename can be named anything you want, but the namespace must be defined as 
stated above.  If it is not, the Web service will not be able to find the appropriate 
interface function calls.  This may not be required in other environments.   
 

Required Web Service Interfaces 

Specific Web service interfaces that would need to be included for this would be a survey 
request, and a survey submission interface.  
 
The survey request is called BEFORE the first page of the survey is presented to the 
respondent.  Upon the initial survey request, Vovici will call this Web service if defined, 
providing any submission data passed into the survey and the Web service can optionally 
return data to prepopulate the survey submission.  
 
The survey submission is called AFTER the final page of the survey is submitted by the 
respondent.  After the final survey submission, Vovici can call a Web service and provide 
all of the available survey submission data.  Although the submission data can be modified, 
there is no interaction with the respondent.  This call-back is processed after the survey 
Thank You page is rendered to the respondent. 
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API Callback Tab
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Presentation 

Presentation Overview 

The Presentation option is located on the Properties drop-down menu and is available 
once you create your survey and select Edit Survey.  It includes the following tabs: 
 

• General 
• Display Template 
• Logo 

 

 

General Tab 

This tab contains general display options to control the look of your survey.  The default font 
is specified for the overall survey text. 
 
Other options are: 
 

• Suppress question numbers 
• Bold question text 
• Insert 'Select One' into first item of pull-down lists 
• Disable persistence for this survey 
• Include progress bar 

 

 

Display Template Tab 

Select a display template for your survey from the Display template drop-down list.  A 
preview of each template is provided in the Display Template Preview window.  You can 
also customize a display template by clicking on 'Customize the Display Template' and 
editing the HTML code.  Custom templates can be saved for future use. 
 
 

Logo Tab 

You can insert a logo at the top of your survey by selecting the logo from the Company 
Logo drop-down list.  You can control the placement of the logo in your survey by using the 
Alignment drop-down list.  Logos are aligned to the left by default if no selection is made 
from this list. 
 
When a logo is selected, a preview of the logo is shown below the drop-down lists. 
 
See related topic:  Insert/Upload a Logo
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General Display Options 

The General tab contains several options that help control the overall look and feel of your 
survey and how it will appear to your survey respondents. 
 
Default Font Tag.  This is the default font used for your survey text. 
 
Suppress question numbers.  This option prevents the question numbers from displaying 
in your survey. 
 
Bold question text.  This selection makes your question text bold. 
 
Insert 'Select One' into first item of pull down lists.  This option will display 'Select 
One' as the default text that appears in all drop-down lists. 
 
Disable persistence for this survey.  This option turns off the persistence feature. 
 
Warning! 
If persistence is disabled, answers will not be kept if a respondent does not 
complete the survey in one sitting. 
 
Include progress bar.  A progress bar is added at the bottom of each survey page showing 
the respondent how much of the survey has been completed.  You can select one of two 
styles for your progress bar display by clicking 'Customize the progress bar.' 
 
 
Click OK when selections are completed. 
 

 
General Display Options
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Display Template Tab 

Publishing a survey requires you to select a display template.  The display template helps 
determine the way your survey will appear to the user. Templates are selected through the 
Presentation option, which is located in the drop-down menu under Properties when you 
edit your survey.  
 

Steps 

1. Select the Display Template tab. 
2. The Display template drop-down list contains all the predefined display templates 

available.  When a template is selected, a sample version of that template is 
displayed in the Display Template Preview window.   

3. Click OK. 
 

 
Presentation - Display Template Tab 
 
 
Note! 
You can customize a display template and save it for future use by selecting the 
'Customize the Display Template' link directly under the Display Template Preview 
window.
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Customize the Display Template 

To customize your display template, click Customize the Display Template under the 
Display Template Preview window and you are placed in an editor where you can work 
with the HTML code to manipulate the display. 
 
Warning! 
Manually modifying a display template requires that you have a good 
understanding of HTML.   
 
You can save your customized template to be used again if you wish.  Once editing is 
completed, you can click on the Custom Templates drop-down menu at the upper right 
corner of the editor.  Click on Save Template, provide a name in the text box when 
prompted, then click OK. The name of your display template in the Display template drop-
down menu will now read 'Custom.' 
 
Your saved template is now available under the Customize your display template 
option.  Click this link, then click the Custom Templates button and select your saved 
template from the list.  Click OK at the bottom.  When you Preview your survey, it will 
show with the customized template. 
 

Standard Fields 

The following fields (inserted as HTML comments) are placed in a display template. These 
fields will be replaced by the application with the appropriate items when the survey HTM file 
is generated. 
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Warning! 
Do not remove any of the fields listed below which are Required.  Doing so will 
generate numerous errors in the application, and will likely prevent you from being 
able to collect and analyze survey data.   
 

HTML TAG 
HTML 
TAG 

STATUS 
HTML TAG FUNCTION 

<!--WSBTEMPLATELOGO--> Optional 
Placement of the Company Logo in your survey when 
defined in Presentation. 

<!--WSBTITLE--> Optional Inserts the Title of your survey. 

<!--WSBFORMACTION--> Required 
Where the survey will be published to - <form 
method="post" action="<!--WSBFORMACTION-->">  

<!--WSBINTRO-->  Optional Inserts the Introduction to Survey Respondents. 

<!--WSBQUESTIONS--> Required Inserts the items from the Question List. 

<!--WSBCLOSE--> Optional Inserts the Closing Comments to respondents. 

<!--WSBEMAILADDRESS-->  Required Enables the E-mail Security feature. 

<!--WSBSUBMITBUTTON--> Required Inserts the Submit Button. 

<!--WSBPREVIOUSBUTTON--> Required Inserts the Previous Button for multiple page surveys. 

<!--WSBPROGRESSBAR-->  Optional 
This is where the progress bar will be rendered when 
included in the presentation. 

<!--WSBPAGENUMBER--> Optional 
Inserts the current page number for multiple page 
surveys. 

<!--WSBTOTALPAGES--> Optional 
Inserts the total number of pages for multiple page 
surveys. 

<!--WSBPERCENTCOMPLETE--
> 

Optional 
Inserts the percentage complete for multiple page 
surveys. 

<!--WSBPERCENTTOGO--> Optional Inserts the percentage left for multiple page surveys. 
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Insert/Upload a Logo 

You can insert a logo into your survey that will display at the top of each survey page.  To 
utilize this feature, the logo first needs to be uploaded into your account. 
 
If the logo is already in your account, you select it from the Company Logo drop-down 
menu as shown. 
 
You can control placement of the logo in the survey by using the Alignment drop-down 
menu.  Available options are None, Left, Center and Right. If Alignment is set to None, the 
logo will display in the upper left corner of each survey page. 
 
Once selected, the logo will display in the preview window. 
Click OK. 
 
The logo is inserted into the survey through the <!--WSBTEMPLATELOGO--> tag in the 
survey display template. The tag is already positioned properly in the template code. 
 

 
Insert/Upload A Logo
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Tip! 
We recommend using a small image as your company logo to preserve the layout 
of your display template. 
 
If you select a logo from the Company Logo dropdown, a preview will display 
below the 'Alignment' drop-down menu.  You can right-click on it, select Properties 
and find the size of the image in pixels. 
 
 

Uploading a Logo 

Use this option to upload a logo into your account. 
 

1. Click Upload Logo from the Logo tab (see above). 
2. Click Browse... to navigate to the image file you want to upload. 
3. Click on the image filename, then click Open to populate the upload text box. 
4. Click Upload button. 

 

 
Logo Upload
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Languages 

Add New Language 

If you have a multi-language survey, you will need to add a Culture Code for each additional 
language so that your survey will properly display. There are also tabs available on this 
screen for Message Translation, Validation Messages, Resume Request, and 
Language Request.   
 

Add New Language Tab 

This tab allows you to choose a Culture Code that is already available within the application, 
or to add one of your own by clicking Add Language if the desired language is not already 
defined.   
 
When you add a new language, the following attributes are used: 
 

Language ID 
This is the ID that will appear on addresses if you want to send users to a specific 
language page. This should be a short text only word without spaces or 
punctuation.  For example:  eng, fre, span, etc. 
Description 
The Description is the version of the text that appears in the menu for your users. The 
Description is usually the name of the language.  For example: English, French, 
Spanish, etc.  
Culture 
This is the encoding for the language you specify.  The Culture Code defines how the 
characters in your survey will render in a Web browser.  Each language has a specific 
Culture Code associated with it.   
 

To add a new Language/Culture Code 

 
1. Under the Properties drop-down menu, select Languages & Messages. 
2. Select the Add New Language tab. 
3. Click the Add Language button and the Add New Language dialog is displayed. 
4. Enter the Language ID (eng, fre, span, etc.). 
5. Enter the language Description (English, French, Spanish, etc.). 
6. Enter the Culture Code designation from the drop-down menu. 
7. Click OK.
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Add New Language 
 
 

Import 

You can use the Import option to import previously translated text.  The file required is an 
XLIFF (XML Localization Interchange File Format).  XLIFF is an XML-based standard format 
that is used for exchanging localization data. 
 

 
Import Language 
 

Export 

You can use the Export option to export a survey to be translated.  You will select the 
language to base the translation on and the language you wish to translate the survey 
to.  The file produced is an XLIFF file. 
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Message Translation 

 
This tab contains default text labels that pertain to specific question settings, or commonly 
used buttons in your survey.  Each of these labels can be edited to read as you wish, and 
are applied globally throughout the survey.  They cannot be changed on a single page 
basis.   
 
Note! 
In multi-language surveys, these messages will not be prepopulated in the 
additional languages.  You will have to enter text for the labels/buttons for each 
additional language you will be using in your survey. 
 
The most commonly used items will be Next Page, Previous Page, and Submit.  If your 
survey does not utilize a particular button or message, you do not have to translate it. 
 

 
Message Translation Tab
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Validation Messages 

The text fields that are shown under this tab are related to the questions in your survey, and 
are based on the question type and their settings. These warning messages will be displayed 
in the form of popup alert messages to a survey respondent. 
 
Example: 
If you have a Choose One question that is set up to be a required question (meaning the 
survey respondent must answer this question), and the respondent does not answer that 
question and tries to go to a subsequent page or submit the survey, the following message 
will display: 
 

 
Required Question Alert  
 
 
Each of the following messages can be edited to read as you wish, and apply to the survey 
globally. 
 
Warning! 
In the second message below, the variable $VALUE$ cannot be removed.
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Validation Message Tab
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Resume Request 

 
The Resume Request Page displays when a survey with persistence enabled has been 
only partially completed.  This tab defines what will display on the Resume Request Page. 
 
If the respondent completes the survey beyond the first page then exits the survey, they 
can return to the survey at a later time to complete it. When the link is clicked, the Resume 
Request Page will display with the message 'You have uncompleted surveys that you 
may take some action on.'  The three default options as described below will appear on 
the page. 
 
The options are: 
 

Resume 
Resume an existing survey submission at the last unanswered question. 
 
Resume From First Page 
Resume an existing survey submission at the first page with the ability to review 
existing  
answers. 
 
Delete 
Delete your existing survey submission. 
 
This option deletes your existing answers.  You will be presented with the message 
'You have no uncompleted surveys.'  You will have to exit out of this window and 
take the survey from the beginning. 

 
The text of the links and their descriptions can be altered; however, the links cannot be 
removed.   
 
Note! 
Familiarity with HTML is helpful if you plan on editing this page so that necessary 
tags are not deleted. 
 

 

Steps 

1. Under the Properties drop-down menu, click Languages & Messages. 
2. Select the Resume Request tab. 
3. Click the HTML icon (<>) under the display window to edit the HTML code.  Click the 

Design icon next to (<>) to return to the display view. 
4. Click OK. 

 
Note! 
The 'Insert Template' link below the display window will insert the default Resume 
Request Page shown below should it need to be restored.
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Resume Request Tab

June 2007                                                                                                             Page 184 of 291 



EFM Feedback User Guide  Survey Editing Properties 
 

Language Request 

You can edit the appearance of the Survey Language Selection Page by using the text 
editor box provided under the Language Request tab. 
 
Note! 
It is recommended that you have a good understanding of HTML before attempting 
to edit this page. 
 

Survey Language Selection Page 

When a respondent clicks the URL of a survey that has more than one language defined, the 
Survey Language Selection Page is displayed containing links for the different languages 
available for that survey.  The respondent will then choose their preferred language for the 
survey. 
 
The example below shows the default language selection page for a survey that contains two 
languages, English and Spanish. 
 
Note! 
The survey title will be inserted into the question on the Survey Language 
Selection Page. 
 
 

 
Survey Language Selection Page 
 
 

Editing the HTML 

You can use the Insert Template link at the bottom of the tab to insert an example HTML 
template for the default Survey Language Selection Page which can be used as a guide 
for your page, or you can edit this code with your survey URL and language designators. 
 
Your survey language choices on the Survey Language Selection Page will be expressed 
in your template code as shown in the box below: 
 

<a href="%survey_url%renderlang=eng">English</a><br> 
<a href="%survey_url%renderlang=span">Español</a>.<br> 
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Tip! 
As the default Survey Language Selection Page is displayed automatically for a 
multi-language survey, it may be easier to copy the source code of this page, then 
edit it, rather than editing from scratch. 
 

 

To copy source 

1. Click on the survey link to see the default language selection page. 
2. Right click on the page, select View Source to see the HTML. 
3. Copy this source code, then paste it in the text editor box under Language Request. 
4. Make your changes, click OK, republish the survey. 

 

 

Bypass Language Selection Page 

You can send respondents directly to a specific language instance of your survey by 
providing them with an appended survey URL.  A delimiter is used and a parameter is added 
to the end of the survey URL to specify which language version they will access.  The 
delimiter is a '?' and the parameter takes the form of a Name-Value pair.   

Example:  

?renderlang=sp 
 
Using the English/Spanish example above, directing users to the Spanish version of the 
survey would result in the URL appearing as such:  
 

http://surveyURL?renderlang=sp 
 
Respondents who click on this URL, or copy/paste it into their browsers, will go directly to 
the Spanish version of the survey.  This eliminates the step where they have to choose a 
preferred language. 
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Alerts and Triggers 

Alerts & Triggers Overview 

The Alerts & Triggers option is located under the Properties drop-down menu when you 
select Edit Survey. 
 
With this option you can set up a trigger based on a certain condition in your survey so that 
when that condition is satisfied and the survey is submitted, an E-mail notification will be 
sent to you. 
 
When you first select the Alerts & Triggers option, your List Pane will not have any triggers 
displayed and you will have to create a New Trigger. 
 
When you begin the process of creating a trigger, three tabs are displayed: 
 

• Criteria - Define the parameters of the trigger. 
• Message - Compose the message to be sent via email. 
• Web Service - You can specify a Web service to be used to enable proper execution 

of the trigger functionality.
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Criteria 

The Criteria Tab is where the conditions of your trigger will be specified.  You will enter a 
description or name for the trigger in the text box at the top.  There are drop-down lists 
below the tool bar that are used to specify the parameters of the trigger. 
 
The first drop-down list contains all the questions in your survey. 
The second drop-down list contains conditions that are used to test against a response to 
that question. 
The third drop-down list contains the response options to the selected question. 
The fourth drop-down list is the And/Or operator that is used to build compound 
conditions when you want to check against multiple questions. 
 

 
Edit Trigger - Criteria Tab 
 
 

Steps 

1. Select Alerts & Triggers from the Properties drop-down menu. 
2. Click New Trigger. 
3. On the Criteria Tab, provide a description or name for the trigger. 
4. From the first drop-down list, select the question to be used for the trigger.  
5. From the second drop-down list, select the condition to be used. 
6. From the third drop-down list, select the response option you want to check for.  If 

the question is a hidden field or text question, type in the response value you want to 
check for. 

7. For a compound condition, select a value for the And/Or operator. 
8. Click New Criteria and a new line of drop-down lists will display to make selections 

from.  
9. When selections are completed, click OK.
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Copy/Paste Conditions 

Existing trigger conditions can also be copied and pasted to create new conditions. 
 

 

Steps 

1. Select the check box of the condition to be copied. 
2. Click the Copy icon just to the right of the New Criteria button. 
3. Click the Paste icon next to the Copy icon. 
4. The condition is duplicated and displayed below the original selected condition.  The 

new condition can now be edited as necessary. 
5. Click OK.
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Message 

The Message Tab is where you create the E-mail message to be sent to the addressee that 
you specify.  The message will be sent when the specified Criteria are met when a survey is 
submitted. 
 
The information fields that can be specified are: 
 

• Send E-mail check box - Select this option to send the message in E-mail. 
• From Address - Specify the E-mail address the message will be sent from. 
• To Address - Specify the E-mail address the message will be sent to. 
• Cc Address - Specify additional addresses to send a copy of the message to. 
• Bcc Address - Specify additional addresses to send a blind copy of the message to. 
• Subject - Specify a subject line for the message. 

 
The message text will be entered in the main text box at the bottom.  You can use the 
Editing Tool Bar to included standard formatting in the message display. 
 
You can also insert a piped value in your message using the Insert Piped icon to the far 
right of the Editing Tool Bar.   
 
HTML coding is supported in the message.  You can edit the message in HTML format by 
selecting the icon (<>) below the message text box. Click the Design icon next to (<>) to 
return to the display view. 
 
Click OK when editing is completed. 

 
Edit Trigger - Message Tab
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Web Service 

Web services allow different applications from different sources to communicate with each 
other without time-consuming custom coding.  Web services share business logic, data and 
processes through a programmatic interface across a network.  Developers can then add the 
Web service to a user interface such as a Web page or an executable program to offer 
specific functionality to users.   
 
You can use the Web Service Tab to specify that a particular Web service be utilized to 
facilitate trigger functionality and message delivery. 
 
Fields on this tab are: 
 

• Use Web Service - Select this check box to use the particular Web Service specified. 
• Web Service URL - Specify the URL of the particular Web Service to be used. 
• Username - Specify the username to access the Web Service. 
• Password - Specify the password to access the Web Service. 
• Test - Clicking the Test button will test the URL and credentials that have been 

provided.   
 

 
Edit Trigger - Web Service Tab
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Chapter Twelve 

Survey Editing Actions 
 
 
 
 
 
 
 
 
Discussed in this Chapter 

Actions Overview 
Page Break Wizard 
Spell Check 
Find and Replace 
Survey Detail Report 
Download WSX 
Translating a Survey 
Sharing Your Survey
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Survey Editing Actions 

Actions Overview 

The Actions drop-down menu is located on the Question List Pane and is available once 
you create your survey and select Edit Survey.  It includes the following options: 
 

• Page Break Wizard 
• Spell Check 
• Find & Replace 
• Survey Detail Report 
• Download WSX 
• Translate 
• Shared 

 
Page Break Wizard:  Use this tool to create regularly spaced page breaks throughout your 
survey. 
 
Spell Check:  Use this tool to spell check the entire survey. 
 
Find & Replace:  Use this tool to Find & Replace text in your survey. 
 
Survey Detail Report:  Select this option to see a report containing the specifications of 
your survey setup. 
 
Download WSX:  Use this tool to download the actual survey file (wsx). 
 
Translate:  Select this option to translate your survey and message text for multi-language 
surveys. 
 
Shared:  Use this tool to share your survey with other users.
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Page Break Wizard 

The Page Break Wizard option is located under the Actions drop-down menu when you 
select Edit Survey. 
 

 
Page Break Wizard 
 
 
The Page Break Wizard will place a simple page break in your survey incrementally based 
on your selection from the Add a page break drop-down menu.  The increments are: 
 

• after each question 
• after each # questions 

 
Note! 
The '#' represents an incremental number in relation to the number of questions 
you have in your survey.  The maximum number will be the number of questions in 
your survey. 
 
You also designate where to begin placing the page breaks in your survey using the 
starting with question drop-down menu.   

 

Add a Page Break 

1. Select Page Break Wizard from the Actions drop-down menu. 
2. Select the page break increment from the Add a page break drop-down list. 
3. Select the point in your survey where page breaks will be inserted from the starting 

with question drop-down list. 

 

Remove Page Breaks 

You can also use the Page Break Wizard to remove all page breaks in your survey. 
 

1. Select Remove current '#' page breaks.  
2. Click OK.
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Spell Check 

The Spell Check option is located under the Actions drop-down menu when you select Edit 
Survey.   
 

 

Steps 

1. Select Spell Check from the Actions drop-down menu. 
2. Click the Check Spelling button. 
3. The Spell Check window will open and terms that require action will be displayed in 

the Not in Dictionary text box.  Alternative Suggestions are displayed in a text 
box directly under the Not In Dictionary text box. 

4. Select an action button for each term to clear or change it.  Buttons are Ignore, 
Ignore All, Change and Change All. 

5. There are buttons at the bottom to Close the window or Undo an action. 
6. When spell check is completed, a popup alert is displayed.  
7. Click OK to clear the alert and the Spell Check option automatically closes.
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Find & Replace 

The Find & Replace option is located under the Actions drop-down menu when you select 
Edit Survey.  
 

 

Find Term 

1. Enter the text to find in the text box labeled Text to find. 
2. You can select the check box to Match Case to find exactly what you typed. 
3. You can search for the Text to find value in Question Text, Response Text, and Title, 

Text & Limits.  Select the check boxes for the sections to be included in the Find. 
4. Click Find. 

 
 

The Results List 

 
When the Find is completed, a page will be displayed listing each item that matched your 
criteria.  The usage of the term is shown on the left with a check box.  The actual Question 
number or section of the survey where the term is used is shown on the right.  The 
Question number listing is a hyperlink that will take you to that question where you can 
make edits.   
 
 

Replace Term 

1. To replace an occurrence of a term, select the check box of that list item.  To 
replace all occurrences of a term that was found, select the check box in the left 
corner of the list bar just above the questions. 

2. Type in the new term you want to replace with in the text box at bottom. 
3. Click Replace.
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Survey Detail Report 

The Survey Detail Report option is found under the Actions drop-down menu when you 
select Edit Survey. 
 
The Survey Detail Report is a summary report of the settings and parameters contained in 
your survey and can be a useful tool to aid in troubleshooting issues that may arise with 
your survey setup. 
 
Information provided includes: 
 

• Survey ID (used for technical support and troubleshooting) 
• Editable Survey ID 
• Survey title 
• Identifying comments 
• Presentation options for survey display 
• Languages the survey in which the survey is written 
• Title, Text & Limits settings (title, author, opening text, closing text, result URL) 
• Survey Questions and Responses (question type and parameters, actual question text, 

question ID numbers).
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Download WSX 

The Download WSX option is located under the Actions drop-down menu when you select 
Edit Survey.  This option is provided for our legacy desktop version users. 
 
The desktop version of the application is required to open and work with these files.   
 
Note! 
The desktop version of the application is a legacy version and does not contain all 
the functionality in the web version. 
 

To Download a WSX File 

1. From the Actions drop-down menu, click on Download WSX. 
2. Select the Published or the Working version of the survey file to be 

downloaded.  The Published version will contain all edits up to the time the survey 
was last published.  The Working version may contain edits that have not yet been 
published. 

3. Click Download. 
4. Select Open or Save. 
5. If you Save, a default name is given to the file.  You can rename and navigate to the 

folder of your choice to save the file.
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Translating a Survey 

The Translate option is located under the Actions drop-down menu when you select Edit 
Survey. 
 
EFM Feedback currently does not automatically translate the survey for you.  
 
After a new language has been defined, you can begin the process of translating your 
questions to the new language.  When you select a language to display the survey in from 
the Language drop-down list, the application is placed in a language "Mode" which is global 
and covers the Question List, Title & Text, Languages, Presentation and Analysis.  All 
text that has not been translated to the new language will be displayed in red in the 
Question List. 
 
Tabs are shown under the Translate option as follows: 
 

• Survey - This tab contains all your survey questions and response options. 
• Title & Text - This tab contains Survey Title, Opening Text, Closing Text and 

Redirect URL. 
• Messages - This tab contains standard messages related to your survey questions. 
• Validation Messages - This tab contains messages that are used in validation 

popup alerts and are related to various question types. 
• Resume Request - This tab contains the Resume Request Page that displays when 

persistence is enabled on your survey. 
 
There are drop-down lists for Base Language and Translate Language on each of tabs 
listed above.  For each item that is not yet translated, a yellow text box is displayed.  When 
translated text is entered for an item, the yellow highlighting disappears, indicating the 
question has been translated.  If an item is not used in your survey, translation is not 
necessary. 

Steps 

1. In the Actions drop-down menu, select Translate. 
2. On the Survey Tab, enter your translated text for the survey questions and response 

options in the text boxes provided. 
3. On the Title & Text Tab, enter your translated text for the appropriate items in the 

text boxes provided. 
4. On the Messages Tab, enter your translated text for the appropriate items in the 

text boxes provided. 
5. On the Validation Messages Tab, enter your translated text for the appropriate 

items in the text boxes provided. 
6. On the Resume Request Tab, enter your translated text for the appropriate items 

in the text boxes provided. 
7. Click OK. 

 
Note:  Remember that any items that you want to use in your survey and wish to 
view in the additional language need to be translated.  This includes fields under 
Title & Text, Message Translation, Validation Messages, Resume Request and 
Language Request.  
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Sharing Your Survey 

Sharing Your Survey Overview 

The Shared option is located under the Actions drop-down menu when you select Edit 
Survey. 
 
A survey can be shared with those users who are assigned seats within your workgroup on 
the Group Users tab under Administration.   
 
A user can be granted full access or share for analysis access for a particular 
survey.  Full access provides the user full editing and publishing rights to the shared 
survey.  Share for analysis provides the user access to analysis and reporting 
features.  Sharing a survey is useful for colleague review, giving another user the ability to 
view up-to-date results, and for collaborated survey creation.  
 
It is important to note that the level of share access available (full access or share for 
analysis) is dependent upon the type of account you have.  This table shows each account 
type and share access. 
 

Account Type Share for Analysis Share for Full Access 

Hosted 
• TRIAL 
• NOW 
• Standard 
• Professional 
• Professional 

Developer 
• Team 
• Team Developer 

  

Private Hosted 
• Enterprise   

Server (Installed) 
• Server 
• Server 

Developer 
  

Share Access Based on Account Type 
 
 
Alert! 
A survey shared to a user within your workgroup cannot be reshared by that user. 
A survey shared to a user within your workgroup cannot be downloaded. 
A shared survey cannot be published.  
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How to Share a Survey 

Steps 

1. In the Actions drop-down menu, select Shared. 
2. Associated Users will be listed in the box on the left.  The right side will display 

boxes for Full Access and Share For Analysis. 
3. Click the user name to highlight it. 
4. Click the right arrow button for the appropriate level of sharing you wish to grant to 

the selected user. Their user name will be placed in the box to the right. 
5. Click OK. 
6. A page will be displayed confirming the survey has been shared and an E-mail will be 

sent to that person with the confirmation message. 
7. Click OK. 

 
The user who shared the survey will now see the Share icon displayed next to that survey in 
the Surveys List Pane.   
 
The user who the survey was shared to will see the survey displayed in their Surveys List 
Pane with the Share icon grayed out next to it. 
 
 
Note! 
If the original survey is altered after it has been shared, those changes will not 
appear in the shared version(s).  For the users with shared versions to have the 
most up-to-date information the survey would have to be shared again with those 
users.   
 
 
Alert! 
If you choose to share the same survey with a user that you had previously shared 
this survey with (reshare the same survey), any edits made by that user to their 
version of this shared survey will be overwritten.   
 
 

Additional Sharing Options  

Editing a Shared Survey 

A shared survey can be edited the same as any other survey.  However; if the original owner 
reshares this survey with you, you will lose your edits.  A shared survey cannot be 
downloaded or published.  
 
You can copy a shared survey and save it as a new survey; however, the data will not 
transfer to the new survey. 
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Viewing the published survey  

If a survey is shared during creation, then edits are made and the survey published, the 
shared version will not include any edits that are in the published version made by the 
original owner.  The user the survey was shared to will only see the unpublished version. 
 
 
Tip! 
It is recommended that you complete all edits and publish your survey prior to 
sharing it to another user. 
 

Remove a survey that has been shared to you 

If a survey has been shared to you and you would like it removed from your Surveys List, 
the survey owner will have to remove the share for you. 
 

Remove Share Status 

1. In the Actions drop-down menu, select Shared. 
2. Click the user name in the Full Access box or Share For Analysis box to highlight it. 
3. Click the left arrow button and their user name will be placed in the Users box to the 

left. 
4. Click OK. 
5. The Share icon is removed from the selected survey in the list. 
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Chapter Thirteen 

Analyzing and Reporting Your Results 
 
 
 
 
 
 

 
Discussed in this Chapter 
 
Analyzing and Reporting Your Results 

Analyzing Your Results 
Analysis Text/Export Version Text 
Chart Display 
Chart Properties 
Export Chart 
Cross Tabulation Analysis 
Purge Survey Results 
Exporting Your Results 
Filter Data 
Notes 
Reset Results 
View-Edit Data 
View Response History 

Reports 
Generating Reports 
Executive Summary 
Cluster Report 
Customizing Report Template 
Public Report 
Exporting Your Report
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Analyzing and Reporting Your Results 

Analyzing Your Results 

 
Use:  The Analyze tab provides the user with information and options that allow them to 
analyze and manipulate their survey results. 
 
The Analyze Page is accessed by selecting the Feedback navigation tab and selecting a 
survey from the List Pane.  Next, click Analyze Data from the Options Pane and you are 
placed on the Analyze tab.   
 
Note! 
In order for the 'Analyze Data' option to be available from the Feedback Page, your 
survey must be published. 
 
The List Pane on the Analyze tab contains the Question List from your survey as well as 
the question type.  The Options Pane is where charts will display for the questions.  It 
contains buttons for Analysis Text, Properties and Notes, as well as a drop-down menu 
for Chart Type. 
 
The Info Pane contains Quick Tips links and Account Messages. 
 
In the Options tool bar, there are drop-down menus for Properties, Actions and 
Languages.  There are also buttons to Update Results, view the Raw Data and Export 
Chart.  
 

Properties Drop-Down Menu 

Notes - The Notes field is used to add summary text for a question which will be 
included in your report.  The text is placed directly under the graph for that question. 
Survey History - The survey history is a list of actions that have been taken against 
your selected survey.  Information presented includes when the survey was created, 
updating or resetting of results, publishing or republishing the survey and whether or 
not results were kept or purged. 
 

Actions Drop-Down Menu 

Filter Data - You can set a filter to display a subset of the results.  A basic filter is 
based on a particular response option to one of your questions, or it can be based on 
any of five (5) system fields.  Compound filters can also be created to include 
response options from more than one question at a time.  Only those results that meet 
the criteria of the filter will be displayed. (Show Me) 
Crosstab Wizard - Allows you to manage your crosstab analysis settings across 
applicable questions in your survey.  If crosstabs are already set, the wizard can be 
used to clear them. 
Export Data - Export all or part of your survey results to a CSV file or to a file 
compatible with SPSS. 
Reset Results - Clears your local view of the data and sets your results count to 0.
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Response History - Allows you to look at survey results grouped by the date each 
response was received using the following groupings: 
 

• Daily  
• Monthly  
• Annually  

 
 

Purge Results - Use this option to delete all of your survey data.   
 

Language 

If your survey is in multiple languages, you can choose another language to display 
here.  The menu item is disabled (shown in light gray) if the survey uses only one language. 
 

Update Results 

Update Results will download any new results from the server that have been received 
since the last time you updated your results.  If this is the first time you've updated results, 
you'll get all the data received for that survey.  The Update Results button will display in 
red when there are new results that have not yet been downloaded. 
 

Raw Data 

You can use this option to view and edit the raw data collected by the survey. 
 

Export Chart 

You can save your question chart to a file through this option.  You can adjust your chart 
size by changing the width and height then clicking Set Chart Size.  To save the chart to 
your computer, right-click on the chart and choose 'Save Picture As,' then provide a name 
for the file and navigate to the folder where you want to save the file. 
 

Question List 

This pane is a scrollable list of all the questions contained in your survey.  When a question 
is highlighted in the list, the chart for that question is displayed based on your Properties 
and Analysis tab settings.   
 

Analysis Text 

You can create an abbreviated version of your question and responses text to be displayed 
on the graph or in the exported data file.  Lengthy text will be truncated on graphs and in 
exports.  
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Properties Button 

This pane displays your chart according to specified parameters selected under the available 
sections for that question type.  The major properties areas are Style, Background, 
Advanced, and Statistics.  The properties areas that are available are dependent on the 
question type.   

Notes 

You can add summary text for a question which will be included in your report directly under 
the graph for that question.  You can also access this option under the Properties drop-
down menu on the Analyze tab. 

View 

This option is used to specify the view for the selected question.  You can view the Chart, 
responses entered for those questions that are set up with a 'Comments' field or an 
'Other' field.  The drop-down menu will only show those options that are enabled for the 
selected question. 
 

• Chart - view the graph for the selected question. 
• Comments - view the text entered for questions with the 'Comments' option 

enabled. 
• Other - view text entered for questions with the 'Other, please specify' option 

enabled. 

Chart Type 

There are seven different chart types available: 
 

• Pie 
• Bar 
• Horizontal Bar 
• Area 
• Line 
• Scatter 
• Text Only 

 
Note! 
The charts available in the drop-down list are dependent on the particular question 
type. 
 
Information that is displayed along the bottom of the Analyze screen:  

Last Updated - date/time the survey was last updated. 
Analyzed - number of responses being analyzed at a given time. 
Received - number of responses that have been received. 
Filter - whether or not there is a filter set against the data (active/inactive). 
 

Note! 
Remember that having a filter set will affect the response counts and what is 
shown on the graphs.
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Analysis Text/Export Version Text 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Analyze Data from the Options Pane and the Analyze tab is displayed. 
 
Analysis version text and export version text boxes are both available under the 
'Analysis Text' button.  Both of these options are useful when you have lengthy text for a 
question or response.  You can use these options to define an abbreviated version of your 
regular question and/or response text.  Lengthy text will not wrap on the graph in Analysis 
and will truncate.    
 
Note! 
When data is exported, the question and response options become column headers 
in the CSV file and similar truncation could occur.   
 

Question Tab 

Analysis version of the question:  You can type in a shortened version of the question 
text that displays on the graph.  
Export version of the question:  You can type in a shortened version of the question text 
that displays when you export the survey data to a CSV file.   
Export values for 'other':  You can designate a value to be used if you have the 'Other, 
please specify' option enabled and would like the column header to display a different value 
than 'Other' when you export the data to a CSV file. 
 

1. Select the question in the List Pane. 
2. Click the Analysis button. 
3. Enter Analysis version and/or Export values. 
4. Click OK.
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Responses Tab 

The Response options for the selected question are displayed on this tab.  You can edit a 
response option here to alter its display in Analysis as well as in your exported data. 
 
Response:  This column displays the normal text of your response options. 
Analysis Text:  You can type in a shortened version of the response text that displays on 
the graph. 
Export Text:  You can type in a shortened version of the response text that displays when 
you export the survey data to a CSV file. 
Score:  Score values are used in weighting and averaging your response options.  You can 
assign a score value that will be attributed to that response option during Analysis.  By 
default, score values are assigned by the application beginning with '1'. 
Color:  You can change the color of the response option display on the graph.  You can 
choose the color from the palette using the icon or type in the HTML hexadecimal number of 
the color. 
 

1. Select the question in the List Pane. 
2. Click the Analysis button. 
3. Select the Responses Tab. 
4. To change or add values, click Edit in far right column. 
5. Enter Analysis text, Export text, Score and Color values. 
6. Click OK to apply changes. 
7. Click OK to close window and return to Analyze Tab.



EFM Feedback User Guide  Analyzing and Reporting Your Results 
 
 

June 2007                                                                                                             Page 209 of 291 

Chart Display 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Analyze Data from the Options Pane and the Analyze tab is displayed. 
 
The center Options Pane under the Analyze tab is where your charts will display.  There 
are various parameters that can be enabled that control the display of the chart.  The 
options are: 
 

Analysis Text:  Use this option to manipulate your question and response option text 
that will be displayed on the graph. 
 
Properties:  Set up parameters that control the Style of the graphical display, the 
Background color(s) of the graph, include Statistical calculations and set Advanced 
options for response display.  
 
Notes:  Enter notes and comments that will be displayed under the graph when a 
report is generated. 
 
View: This option is used to specify views for the selected question.  The View drop-
down menu is only visible if you have set up the selected question with a 'Comments' 
field or an 'Other' field.  The View options are Chart, Comments and/or Other. 
 

Note! 
In addition to the Chart, the View drop-down menu will only show those options 
that are enabled for the selected question.  For example, if you have only enabled 
'Comments' you will see View and Comments. 

 
Chart Type:  You can set the Chart Type using the drop-down menu above the chart 
display.  The chart types available for a selected question depend on the question type. 

 
The chart displayed is specific to the question that is currently selected.  You will normally 
see the question text at the top of the chart, and the legend in the upper right corner 
containing the response options and number of responses for that option. 
 
The graph will be presented with labels that correspond to the response options in the 
legend.  
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Analysis - Chart Display
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Chart Properties 

The Properties button on the Analysis tab is used to set up most of the display parameters 
for your charts.  The available options and Chart Type are dependent on the question type. 
 
To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Analyze Data from the Options Pane and the Analyze tab is 
displayed.  Click the Properties button to display the Chart Properties dialog below.   
 
Display options can be set for all questions that are of the same question type by selecting 
the check box for 'Apply to all QuestionType' on the Chart Properties dialog once you click 
the Properties button.  All questions will have Style and Background options but other 
available options depend on the question type. 
 
Display options for Style and Background can be applied to all questions by selecting 
the check box for 'Apply to all questions' on the Chart Properties dialog once you click the 
Properties button. 
 

 
Properties - Chart Properties Dialog
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Style 

Select Show Title if you want the question to show on the graph. 
Select 3D Effect if you want to see the graph displayed with more definition. 
Use the drop-down menus for Display Legend and Display Marks to control the 
appearance of the legend or labels on your overall chart.  
 
 

Statistics 

Check the appropriate boxes for Mean, Mode, Median, Standard Deviation, Calculate 
closest response option and Display score next to response options.  See the chart 
below for a more detailed explanation of statistical values.  
 
Note!   
The statistical options are not available for all question types. 
 
When a Score value is added to a Response Option, it is this value that is used for the 
statistical calculation.  If no values are entered, the Score is set to 1 for the first response 
option, 2 for the second, etc.  
 

MEAN The mean is the average value. The mean is calculated by the 
sum of the values divided by the total number of values. 

MEDIAN 
 

The median is the middle value. The median is the number in the 
middle of a set of numbers; that is, half the numbers have values 
that are greater than the median, and half have values that are 
less. 

MODE The mode is the most frequently occurring value. 
STANDARD 
DEVIATION 

The standard deviation is a measure of how widely values are 
dispersed from the average value (the mean). The standard 
deviation is the square root of the sum of the squares of the 
difference in each value from the mean divided by the total 
number of responses. 

Statistical Explanations 
 
 
An example of Standard Deviation: 
EFM Feedback computes the sample standard deviation (using N-1).  The statistic is 
computed by counting the number of non-'other' responses that are submitted for a specific 
question. 
 
Example:  Consider a survey for which 10 total submissions were received.  On question #1, 
responses received were 1, 2, 1, 3, 4, no answer, 1, other, 1, 3.  N-1 for this question is 7 
('no answer' and 'other' are not counted).  On question #2, we received responses 1, 2, 3, 1, 
2, 3, 1, 2, 3, 1.  N-1 for this question is 9. 
 
For more detailed examples of standard deviation calculations see: 
 
http://en.wikipedia.org/wiki/Standard_deviation
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Background 

This section controls the background color on the graphical display.  It can be set as a solid 
color or as a gradient.  Use the color palettes to select the colors you want to use, or enter 
the HTML color number.  
 

Advanced 

You can use Enable Top N Display to display only the desired number of responses (top 3, 
top 5, etc.).  Using the Sort Responses by drop-down menu, you can sort responses 
according to Numeric by Top Count, Original Order, or Alphabetically.  You can also Invert 
Sort Order.  
 
Tip! 
If you have a number of questions that have the same set of response options, 
using the Chart Properties to Sort Responses by their Original Order will help 
maintain consistency of the colors used to represent each response option 
throughout your charts.  
 
 

Number 

The Number option is displayed if your question is a numeric value style question.  It 
contains the Step Value that your responses will be grouped by.  Step Value normally 
defaults to 10.  You may change the Step Value to whatever you wish to apply against the 
question.  If you have a large numeric range, it is recommended that you increase the Step 
Value.  
 
Warning! 
The Step Value plots each point within the numeric range that is defined for the 
question.  As an example, if you have a numeric range of 1 to 10,000 and you set 
the Step Value to 1, 10,001 individual points will be plotted on your chart.  This 
may give you the impression that the application has frozen, when, in fact, it is 
actually trying to sort and plot the values. 
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Export Chart 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Analyze Data from the Options Pane and the Analyze tab is displayed. 
 
The Export Chart button is located on the Analyze tab above the Options Pane.  
 
You can save the chart for the selected question to a file using this option.  
 

Steps 

1. From the Analyze tab, click the Export Chart button. 
2. Specify a chart size in pixels by entering a number for Chart Width and Chart Height.  
3. Click Set Chart Size. 
4. With your cursor over the chart, right-click and choose 'Save Picture As...' from the 

menu. 
5. Navigate to the location you want to save the file to. 
6. Provide a file name or use the default file name the application provides. 
7. Click Save. 

 

 
Analyze Tab - Export Chart 
 
 

 
Export Chart Option
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Cross Tabulation Analysis 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Analyze Data from the Options Pane and the Analyze tab is 
displayed.  Click the arrow next to the Actions drop-down menu and select Crosstab 
Wizard.  
 
Cross Tabulation gives you the ability to compare two questions to each other and 
evaluate relationships between the responses of those questions.  You can review the 
frequency and assess the statistical significance in that relationship. Cross tabulation is 
particularly useful when you want to assess whether there is a relationship between how 
your entire respondent base, or a specific subset of respondents, answered two questions. 
 
Crosstabs can be set manually through a particular question, or by using the Crosstab 
Wizard. 
 
You can perform a Crosstab analysis by selecting a chart type of Text Only on Choose 
One questions.  A Crosstab cannot be set to or from any other question types.  
 
 

Crosstab Wizard 

Crosstabs can also be set by using the Crosstab Wizard found under the Actions 
dropdown on the main Analysis screen.  To set crosstabs In the wizard: 
 

1. Select Crosstab Wizard from the Actions drop-down menu.  
2. Choose the question to base the cross tab on from the available questions in the 

Cross tabulate with question drop-down menu. 
3. Check the boxes to select other available questions to be included in the cross 

tabulation.  You can click on Select All to include all the available 
questions.  Choosing Select None will remove the questions from cross tabulation. 

4. Click OK. 
 
The crosstab analysis is displayed in a chart showing the Base Question the crosstab is set 
from with its response options down the left column, and columns for the response options 
for the related question across the top of the chart.  The data will be presented in 
percentages and counts, with a row of Total Counts along the bottom. 
 
 

Setting a Crosstab Manually 

1. Select the question that you want to base the Crosstab from. 
2. In the Chart Type drop-down list select Text Only as the type. 
3. Click Properties. 
4. Select Enable cross tabulation. 
5. Select the related question to crosstab with from the Cross tabulate with question. 
6. Click OK.
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Purge Survey Results 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Analyze Data from the Options Pane and the Analyze tab is 
displayed.  Click the arrow next to the Actions drop-down menu and select Purge Results.  
 
In most cases, purging survey results should only be done when clearing out test results 
before the survey goes out to your live audience. 
 
Warning! 
This process purges all survey results! 
 
 

Steps 

1. Click the Actions drop-down menu. 
2. Select Purge Results. 
3. Type the word 'Delete' in the text box as shown (initial caps). 
4. Click the Delete Now button. 
 

 
Analysis - Purge Results
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Exporting Your Results 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Analyze Data from the Options Pane and the Analyze tab is 
displayed.  Click the arrow next to the Actions drop-down menu and select Export Data.  
 
Survey data can be exported to a CSV (Comma Separated Values) file or to a file to be used 
in SPSS (Statistical Package for the Social Sciences) which is a statistical and data 
management software package for analysts and researchers. 
 
 

Export to CSV 

When data is exported to a CSV file each survey response generates a line in the file.  The 
column headers contain the questions of your survey. Multiple part questions such as a 
Choose All That Apply Matrix will show the question text followed by a particular answer 
option in the column headers.  The exported file will contain Yes or No in the answer 
column by default with Yes meaning that answer option was chosen and No meaning it was 
not. 
 
 

Steps 

1. From the Actions drop-down menu, select Export Data/CSV. 
2. Select the questions you would like included in this export.  To select only 

certain questions, hold down the Control (Ctrl) key and click the desired questions 
with your mouse.  To select all the questions, click the first question, hold down the 
Shift key, and then click on the last question. 

3. Export Format Options.  Select a date format from the drop-down list.  The 
alphanumeric representation of the date is recommended so that date values 
display properly in the exported file. 

4. You can change the values for replacing commas in text responses and the 
default answer displays for multiple choice questions if necessary. 

5. Under Multiple Language Options select a character set to be used.  Unicode is 
recommended. 

6. Select the file format to export to (default is CSV).  You can export to a Tab 
Delimited Text File as well.   

7. Click Export. 
8. A dialog will display where you can Open or Save the export file. 
9. If you Save, a default name is given to the file.  You can rename and save to the 

folder of your choice. 
 
Note! 
A Comma Separated Values (CSV) file is the most common format.  This file type 
can be used with the widest range of database and spreadsheet applications. 
 
A tab delimited text file is another option for the file format.  Rather than using 
commas, the tab character (ASCII #9) delimits each data point. 
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Export to SPSS 

Survey data can also be exported to be used in SPSS (Statistical Package for the Social 
Sciences) for analysis. 
 
 

Steps 

1. From the Actions drop-down menu, select Export Data/SPSS. 
2. A dialog is displayed with an option to Get the latest results before export? 
3. Click Export. 
4. A dialog will display where you can Open or Save the export file. 
5. If you Save, a default name is given to the file.  You can rename and save to the 

folder of your choice.
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Filter Data 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Analyze Data from the Options Pane and the Analyze tab is 
displayed.  Click the arrow next to the Actions drop-down menu and select Filter Data.  
 
With filtering you can view and analyze a particular subset of your data and report on that 
data as well.  There are two tabs under the Filter Data option: 
 

• Filter Data 
• Analysis Limits 

 

Filter Data Tab 

This tab is where you specify the parameters of the filter to be applied to your survey 
data.  The filter is based on the response or responses to a particular question in your 
survey, or on any of five SYSTEM fields listed with your survey questions.  You can also build 
compound filters using the and/or Operator to combine multiple parameters. 
 
 

Steps 

1. From the Actions drop-down menu, select Filter Data. 
2. Select the Question or SYSTEM field you want to base the filter on from the drop-

down list.  When the question is selected, its response options will be displayed 
beneath the question text.  You will have to choose an action (selected, did not 
select). 

3. If your filter question is a text question or hidden field, a text box is provided for you 
to enter the value to base the filter on.  You will also have to choose a condition 
(contains, does not contain, begins with, ends with). 

4. Click Add To Filter.  The filter statement is displayed in the Current Filter text 
box.   

5. If it is necessary to remove a filter, you will click Clear Filter. 
6. Click OK. 

 
 
Tip! 
If you are comfortable with query languages such as SQL you can manually modify 
the Current Filter text. To manually edit your filter text, select Advanced View from 
the drop-down list to the right.  The most common reason to manually modify the 
filter is to add parenthetical operators to improve the logic of your 
filter.  Example:  (this and that) or (blue or green).   
 
Tip! 
If you are filtering on a date value always assume the date has an associated time 
of midnight, 00:00:00. This means a filter of "(DateRcvd > '20060101')" includes 
any survey submission received after midnight January 1st 2006 and beyond. So if 
you want to only show surveys submitted after January 1st 2006 your filter needs 
to be "(DateRcvd >= '20060102')". 
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Analysis Limits Tab 

Analysis Limits are options that can be selected to filter your data in various ways.  These 
settings take effect when you Update Results.  To have these limits apply to all of your 
existing analysis data, you will have to Reset Results first.  
 
Allow only one response for each E-mail address 
Selecting this check box option inserts a question at the end of your survey prompting 
respondents to enter their E-mail address.  An entry is required for this 
question.  Multiple responses can be submitted from the same E-mail address 
entered.  However, when the responses are downloaded for analysis, only the first 
submission will be visible.  Removing the setting will remove the E-mail question from the 
survey (if republished) and all submissions will then be viewable.  
 
Allow one response per UniqueID 
You can pass a Unique ID into your survey.  By passing an ID parameter, any value passed 
in will automatically be inserted into the UNIQUE ID column in the survey 
responses.  Multiple responses can be submitted from the same unique ID.  However, when 
the responses are downloaded for analysis, only the first submission will be 
visible.  Removing the setting and republishing will allow all responses to be viewable.  
 
Allow only one response for each IP address 
The IP address is one of the standard captured SYSTEM fields that show in your actual 
data.  Using this setting will only allow one response for a particular IP address to come 
through.  
 
Warning! 
Since many ISPs pool their IP addresses, using this feature may eliminate people 
from your response set even though they had only taken the survey one time.   
 
Respondent IP addresses must contain one of the following 
Use this option if you know the range of IP addresses of your survey respondents, and would 
like to limit submissions to only those users with IP addresses in this range.  Selecting this 
option causes the screen to expand and another entry box to appear where you input the IP 
information.  
 
Example:  206.152.90 will only allow respondents with an IP address from 206.152.90.0 
through 206.152.90.255 to submit the survey.  Any surveys submitted from IP addresses 
that do not fall within the specified range will be discarded. 
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Notes 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Analyze Data from the Options Pane and the Analyze tab is 
displayed.  Click the arrow next to the Properties drop-down menu and select Notes.  
 
You can also use the Notes button located directly above the chart display window. 
 
The Notes option provides a text box where you can enter comments that will be displayed 
in your report directly under the graph of the selected question.  
 

1. Select Notes from the Properties drop-down menu or click the Notes button above 
the chart display window. 

2. Enter your comments in the text box. 
3. Click OK.
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Reset Results 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Analyze Data from the Options Pane and the Analyze tab is 
displayed.  Click the arrow next to the Actions drop-down menu and select Reset Results.  
 
When you analyze your survey data, you are working with a local copy of the data rather 
than accessing the database on the server directly. Selecting Reset Results clears your 
local copy of the data and sets your results count to zero (0).  Selecting Update Results 
will then download a copy of your survey data in its entirety. 
 
 
Note! 
Results are not deleted when you Reset Results.   
 
Warning! 
If you have manually edited your survey results in any way, these edits are 
temporary because they are made in your local copy of the data and not in the 
actual server database.  If you wish to save these edits, it is suggested that you 
export your data before resetting your results. 
 
 
Be aware that republishing your survey can also reset your results if you have edited 
your survey in such a way that ID numbers of the questions or response options changed. 
 
Example:  If you delete a question or response option, the application would then reset 
your results during republishing and you would have to Update Results to see your data 
again.
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View/Edit the Data 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Analyze Data from the Options Pane and the Analyze tab is 
displayed.   
 
You can view and/or edit the actual survey results by clicking the Raw Data button located 
on the Options Tool Bar.   
 
The responses will be displayed horizontally in spreadsheet format.  The column headings 
are comprised of six built-in system fields, followed by the survey questions/response 
options. 
 
The system fields are: 
 

• Submission Key:   Each request for the survey (the survey URL is clicked) is 
assigned an identifier by the server for recording responses properly to the results 
database.  The Submission Key indicates the request number of the respondent's 
submitted survey.  

• Date Submitted:  The date and time a survey submission was received by the 
server.  

• Unique ID:  If a value is passed into the Unique ID field, the data will appear in this 
column.  

• Language:  The language selected by the respondent when the survey was taken is 
displayed in this column.  

• IP Address:  The IP address the response was submitted through.  
• Email Address:   If the Analysis Limit is selected to 'Allow only one response 

for each E-mail address,' the text the respondent entered is listed in this column.  
 
You can view your survey data in a format that more closely resembles that of the survey 
itself by clicking on the Submission Key.  The data will be displayed in a vertical format 
with the system fields at the top followed by the questions and responses.  Response can be 
edited from this page. 
 
 
Alert! 
Manual edits to your responses are temporary because you are editing your 'local 
view' of the data.  Data cannot be edited on the server.  
 
If you have made manual changes to the results and then Reset Results your 
changes will be lost.  
 
If you have changed the survey by adding or removing questions or responses and 
then republish the survey your changes will be lost.  
 
Resetting local results or republishing because the survey was changed has the 
effect of zeroing out your local view of the results.  You then have to Update 
Results which downloads a fresh copy of all the data in its original state from the 
server. 
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Response History 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Analyze Data from the Options Pane and the Analyze tab is 
displayed.  Click the arrow next to the Actions drop-down menu and select Response 
History.  
 
Survey results are grouped by the date each response was received using the following 
groupings: 
 

• Daily  
• Monthly  
• Annually  

 
Selecting one of these options will display a chart that represents when the actual responses 
were received by the server.  
 

 
Analysis - View Responses
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Reports 

Generating Reports 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Create Basic Report from the Options Pane and the Report tab is 
displayed.   
 
The Report Tab is displayed by default when you select Create Basic Report.  Most of the 
parameters to be included in your report are specified on this tab. 
 
The Properties drop-down menu contains: 
 

• Executive Summary - Comments and/or summary text about the contents of your 
report. 

 
The Actions drop-down menu contains: 
 

• Cluster Report - Generates a report based on a specific question/response in your 
survey. 

• Public Report - Generates a report URL that can be used by others to view your 
report. 

To generate a report:  

1. On the Report Tab specify the questions to be included in the report by selecting the 
appropriate check boxes in the List Pane.  To include all of the survey questions 
select the check box in the List Pane next to 'Questions to Include in the 
Report.'   

2. Choose Content Options by selecting the appropriate check boxes in the Options 
Pane to include Text Responses, Include Page Breaks between charts, Include 
Notes/Executive Summary, or Include question numbers. 

3. Select an option for Chart sizes when printing (also located in the Options 
Pane).  The default is Use window size.  You can designate a specific size for your 
charts by selecting Use specific size and entering numbers for width and height of 
the graphs.  These numbers designate the chart size in pixels. 

4. Select a Report Template from the drop-down list (also located in the Options 
Pane) under the title 'Report Template.'  You have the option of customizing a 
report template and saving it for future use. 

5. Click Apply. 
6. Click the Generate Report button.
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Executive Summary 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Create Basic Report from the Options Pane and the Report tab is 
displayed.   
 
The Executive Summary option is located under the Properties drop-down menu.  The 
Executive Summary option provides a text box where you can write your executive 
summary which will be displayed directly after the Executive Summary section at the 
beginning of your report.  
 

1. Select Executive Summary from the Properties drop-down menu. 
2. Enter your comments in the text box. 
3. Click Apply. 

 
 

 
Executive Summary Included in Report
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Cluster Report 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Create Basic Report from the Options Pane and the Report tab is 
displayed.   
 
The Cluster Report option is located under the Actions drop-down menu. 
 
This option uses a specific question in your survey to base the report on and then sets a 
filter for every unique response option for that question in your data. 
 
When you select the Cluster Report option, you will be presented with a list of the available 
questions to base the report on.  Select the desired question and click Next.  Reports will be 
produced for each individual response option (Department in our example) and each will be 
shown as a hyperlink.  When you select a response link, the report for that response option 
will be displayed.   
 

Steps 

1. Select normal report options on the Report Tab. 
2. Click Apply. 
3. On the Reports drop-down menu at top, select Cluster Report. 
4. Select the question to use for the report from the list displayed in the text box. 
5. Click Next. 
6. The reports are generated and displayed as links.  Click the links to see the reports.   

 
 
Example: 
 
Assume you have a question requiring you to select a Department.  Response options for 
that question are: 
 

• Sales 
• Marketing 
• Research 

 
Set your basic report parameters on the Report Tab. 
Select Cluster Report from the Reports drop-down menu. 
Choose the question for the report and click Next. 
There will be reports generated for Sales, Marketing, and Research.  Each of these 
reports will be displayed as links.   
Click on the links to see the report.
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Customizing Your Report Template 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Create Basic Report from the Options Pane and the Report tab is 
displayed.   
 
When you select the parameters to be included in your report from the Report Tab, you 
have to select a Report Template to use to display the survey.  There are various standard 
report templates included in the application and these are available to select from the drop-
down menu under Report Template.    
 
Your Report Template can be customized in the same manner as your survey display 
template.  Selecting the option to Customize HTML under Report Template will place you 
in the Report Template Edit dialog.  It is a simple text editor which can be used to modify 
the HTML code of the Report Template to produce customized templates that can be saved 
for future use. 
 
Warning! 
Manually modifying a Report Template requires that you have a solid 
understanding of HTML.  
 

 

Steps 

1. From the Report Tab, select Customize HTML... under the Report Template 
option. 

2. Edit the HTML code as necessary.  You can use the Format HTML drop-down list to 
help apply specific formatting in your code. 

3. When editing is complete, click Save Template and you will be prompted to give the 
template a name. 

4. Click OK. 
5. The saved template is now available in the Custom Templates drop-down list.  It 

can also be selected from there, or selected from the Report Template drop-down list 
on the Report Tab. 

6. If you want to delete a customized template, you can do this from My Account/My 
Library/My Report Templates.
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Standard Fields 

The following fields (inserted as HTML comments) are placed in a Report Template.  These 
fields will be replaced by the application with the appropriate items when the survey HTM file 
is generated. 
 
Warning! 
Do not remove any of the fields listed below which are Required.  Doing so will 
generate errors in the application and may prevent you from being able to analyze 
your survey data. 
 
 

<!--WSBSURVEYNAME--> 
 

Optional 
 

The title of the survey will be placed here. 
 

<!--WSBSURVEYAUTHOR--> Optional 
 

The author of the survey will be placed here. 

<!--WSBRESPONSECOUNT--> 
 

Optional 
 

This will display the number of responses the survey 
received taking into account any filter you may have 
set. 

<!--WSBVERBOSEFILTER-->  
 

Optional 
 

This will show any filter you may have set limiting 
your data. 

<!--QUESTIONLIST--> Required 
 

This is where the actual report will be displayed in 
the template.  

<!--GENERATETIME-->  Optional This will display the time the report was generated. 
<!--WSBDATE--> Optional The current date in a formal, presentation style 

format. Example: Monday, November 28, 2005. 
<!--
WSBFIRSTRESPONSEDATE--
> 

Optional 
 

The date of the first response to the survey, in a 
formal, presentation style format. Example: 
Wednesday, November 23, 2005.  

<!--
WSBLASTRESPONSEDATE--> 

Optional The date of the last response to the survey, in a 
formal, presentation style format. Example: 
Wednesday, November 23, 2005.  

<!--WSBSURVEYDURATION--
> 

Optional The number of days from first survey response to the 
last survey response. 

<!--WSBEXECSUMMARY-->  Optional You can enter your own executive summary in the 
Analysis portion of the WebSurveyor interface, and it 
will be placed at this location. This will be done only if 
you have selected "Include user analysis" in the 
Report Options page. 

<!--WSBTEMPLATELOGO--> Optional Placement of the Company Logo in your report when 
defined in Presentation. 
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Public Report 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Create Basic Report from the Options Pane and the Report tab is 
displayed.   
 
The Public Report option is located under the Actions drop-down menu.  This option 
creates your report and produces a URL to access the report.  You can optionally require 
authentication to access the report.   
 
 
Password 
Entering a value in the Password text box will require everyone to first enter the password 
before accessing the Public Report. 
 
Automatically Update Results 
The Public Report will be generated with updated results, giving the report "live" data.  The 
data will be updated each time the Public Report is accessed.   If this option is not selected 
your Public Report will be generated with data from the last time you performed 'Update 
Results.' 
 

Steps 

1. Select all your report options on the Report Tab. 
2. Click Apply. 
3. On the Actions drop-down menu, select Public Report. 
4. Select the check box to Allow Public Report.  The public report URL is then 

displayed. 
5. Select Automatically Update Results if you want results to be updated each time 

the link is accessed. 
6. Enter a Password if you want to require authentication to access the public report. 
7. Click OK.
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Exporting Your Report 

To navigate to this location, click the Feedback tab and select a survey from the List 
Pane.  Next click Create Basic Report from the Options Pane and the Report tab is 
displayed.   
 
Once you have created your report, you can export it and save it as a file in any of three 
different applications: 
 

• MS Word  
• Adobe PDF  
• MS PowerPoint 

 
 
Icons for each of these file formats are located on the Report Tab. 
 

Steps 

1. On the Report Tab set up the parameters for your report and click Apply. 
2. Click the icon for the application you wish to export your report to. 
3. A dialog displays and provides Open or Save options. 
4. When you select Save you can rename the file and save it to the folder of your 

choice.
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Chapter Fourteen 

 My Account 
 
 
 
 
 
 
 
 
Discussed in this Chapter 

My Account Overview 
My Profile 
My Preferences 
My Library 
My Images
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My Account Home Page 

My Account Overview 

Use:  The My Account Page provides the user with information specific to their account 
including their personal user profile, question preferences, question and template libraries, 
and images that are uploaded to their account. 
 
My Account is one of the main tabs that is displayed when you login to EFM Feedback.  You 
simply click the My Account tab and the My Account Page displays and defaults to the My 
Profile tab. 
 

 
My Account Tab 
 
 
There are four tabs under My Account: 
 

• My Profile: You can update your user profile information or password here.  
• My Preferences:  Specify preferred default settings for your questions and your 

survey. 
• My Library:  View and manage your personal libraries. 
• My Images:  Manage images in your account.
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My Profile 

The My Profile tab contains current profile information such as your username, E-mail 
address and point-of-contact information.  Under this tab, you have the option to update 
your user profile or password information as necessary.   
 
 
Update Profile:  Allows you to update your first and last names, your E-mail address and 
your secret question and answer. 
 
Update Password:  Allows you to create a new account password. 
 
Note! 
Passwords cannot contain the User ID or email address. 
 
Click OK when finished editing. 
 

 
My Profile Tab 
 
 
See related topics:  My Preferences, My Library, My Images
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My Preferences 

The My Preferences tab is located under My Account and consists of five main sections, 
Choose One and Choose All That Apply Questions, Fill In The Blank Questions, 
Numeric Value Questions, Matrix Questions, and Advanced.  The first four sections are 
the settings used for particular types of questions when adding new questions to a survey. 
 
Advanced covers default behaviors for previewing, publishing and editing a survey.  
 
When all options are set, click Apply at the bottom. 
 
Note! 
Existing questions in a survey will not be affected by changes in the Preferences 
settings.  Question Preferences will apply only when a new question is added to a 
survey, or a new survey is created.   
 

 
My Preferences Tab 
 

Choose One and Choose All That Apply Questions  

The settings for "Other text length" and "Comment length" will set the default length in 
characters for Other and Comments fields.  Users will only be able to type in as many 
characters as you specify here when providing Other responses or Comments.
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Fill In the Blank Questions  

These settings determine the default length for text entry, and min/max values allowed in a 
response to a numeric question. 
 
 

Numeric Value Questions 

Specify the default minimum and maximum values for Numeric Value questions. 
 
 

Matrix Questions  

You can set the default length of the Comments field (in characters).  You can also set the 
default colors to be displayed when new matrix questions are created.  Clicking on the icon 
will bring up a color palette to choose from, or you can type in the HTML hexadecimal 
value.  Color selections will apply to rows or columns as designated. 
 
 

Advanced 

Do not perform validation during previews will initially suppress the validation 
option when previewing your survey.  This will allow you to scroll through your survey 
in Preview mode without having to answer the questions. 
 
Ensure surveys are accessible through SSL will initially set the "Ensure survey is 
accessible through SSL" option when Publishing a survey. SSL is an acronym for 
Secure Sockets Layer.  Surveys can be published with SSL enabled to provide an extra 
level of data security.  Your survey URL will begin with 'https' instead of 'http'. 
 
Hide wsbid's in Question List will cause the internal id numbers (wsb numbers) of 
the questions to not show in the Question List.
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My Library 

The My Library tab is located under My Account.  The My Library tab lists any personal 
libraries you have saved in the following categories: 
 

• Question Library:  You can add questions to your survey from a Question Library. 
• Response Library:  You can add responses to your survey from a Response Library. 
• Display Template Library:  You can customize your survey display template and 

save it in this library to use for future surveys. 
• Report Template Library:  You can customize your report display template and 

save it in this library to use for future reports. 
 
You can click on each of these library options and see a listing of libraries you have 
created.  The only action that can be taken against the libraries from this tab is to delete 
them. 
 
To delete a library, select the check box of the library you want to remove, then click the 
delete icon on the List Tool Bar.
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My Images 

The My Images tab is located under My Account.  You can use the My Images tab to 
manage the images in your account.  You can upload, preview and delete images from this 
tab. 
 
The tab is divided into two panes.  The left pane lists all images that are uploaded to your 
account.  The filename of the image, the size of the image and a Preview link are 
provided.  The Preview pane at right shows you the selected image when you click 
Preview. 
 

Delete an Image 

Images can be deleted from your account by selecting the check box of the image in the left 
pane, then clicking the delete icon in the tool bar just above the image list. 
 

Preview an Image 

An image can be previewed by clicking the Preview link that follows the image size in the 
left pane.  The image is then shown in the Preview pane on the right. 
 

Upload an Image 

1. Use the Browse button at the bottom of the tab to navigate to the image file that 
you want to upload. 

2. Click on the image title to place it in the Browse text box. 
3. Click Upload.
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Chapter Fifteen 

  Administration 
 
 
 
 
 
 
 

 
Discussed in this Chapter 

Administration Overview 
Report Users 

Group Users 
Assign New Seat 
Reassign Existing Seat 
Edit Seat 
Clear Seat 

Group Roles 
Roles Description 
Permissions 
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Administration Home Page 

Administration Overview 

 
The Administration Pane is broken down into three main tabs: 
 

• Group Users 
• Group Roles 
• Report Users 

 
You can manage the seats attached to the account through these options, and the specific 
permissions or roles the users have within the account.  Group Administrator level access is 
required to be able to create roles and assign permissions. 
 
The default screen is the Group Users view. 
 

 
Group Users Tab 
 
 
The Properties drop-down list contains: 
 

• Name Edit - This dialog displays your WorkGroup ID number and presents a text 
box where you can change your WorkGroup Name. 

 

 
Properties - Edit Name 
 
 
The number of Total Seats is displayed as well as the number of Available Seats. 
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Actions that can be performed against any seat are: 
 

• Assign New Seat 
• Reassign Existing Seat 
• Edit 
• Delete 

 
Columns are displayed that show: 
 

• Assigned User 
• Display Name 
• Email 
• Security Role 

 
See related topics:  Roles Description, Report Users
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Report Users 

The Report Users Tab is located under the main Administration page. 
 
This option displays a report listing of your total seats and available seats.  
 
Actions that can be performed against any seat are: 
 

• Assign New Seat 
• Reassign Existing Seat 
• Edit 
• Delete 

 
Columns are displayed that show: 
 

• Assigned User 
• Display Name 
• Email 
• Security Role
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Group Users 

Assign New Seat 

If you have available seats on your account, you can assign a seat to a new user easily. 
 
From the Administration tab, click the Group Users tab at the top of the screen.  Your 
seats and their assigned users will be displayed. 
 
 

Steps 

1. Click the Assign New button. 
2. Click the Add New User tab. 
3. Enter the First Name, Last Name and E-mail Address of the user.  The E-

mail address will become the User ID. 
4. Enter a password of your own choosing, or click Generate Password and the 

application will generate one for you. 
5. You can force a password change, which will cause the user to have to 

change the password immediately upon logging in, and/or you can select E-
mail password which will forward the password to the user in email. 

6. Click OK. 
 
 

 
Assign New Seat - Add New User Tab
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If the information for the text box fields is not properly filled in on the Add New User tab, 
an alert will be shown as follows: 
 

 
 

 
The Find Existing User tab contains a simple email check to see if a user is 
validated.  Upon clicking OK, a confirmation or rejection message should be displayed. 
 

 
Assign New Seat - Find Existing User Tab 
 
 
If the User ID field is left blank on the Find Existing User tab and you click OK, an alert 
will be shown as follows: 
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Reassign Existing Seat 

If you need to reassign an existing seat on your account to another user, follow the steps 
below. 
 
From the Administration tab, click on the Group Users tab at the top of the screen and 
your seats and their assigned users will be displayed. 
 
 

Steps 

1. Click the Reassign Existing button. 
2. Click the Add New User tab. 
3. Enter the First Name, Last Name and E-mail Address of the user.  The E-

mail address will become the User ID. 
4. Enter a password of your own choosing, or click Generate Password and the 

application will generate one for you. 
5. You can Force password change, which will cause the user to have to change 

the password immediately upon logging in, or you can select E-mail password 
which will forward the password to the user in email. 

6. Click OK. 
 

 
Reassign Existing Seat - Add New User Tab 
 
 
If the information for the text box fields is not properly filled in on the Add New User tab, 
an alert will be shown as follows:
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The Find Existing User tab contains a simple email check to see if a user is 
validated.  Upon clicking OK, a confirmation or rejection message should be displayed. 
 

 
Reassign Existing Seat - Find Existing User Tab 
 
 
If the User ID field is left blank on the Find Existing User tab and you click OK, an alert 
will be shown as follows: 
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Edit Seat 

Use this option to change the role assigned to the currently selected seat on your account. 
 

Steps 

From the Administration tab, click the Group Users tab at the top of the screen.  Your 
seats and their assigned users will be displayed. 
 

1. Click the Edit button on the Editing Tool Bar. 
2. Current User Information will be displayed for the selected seat including 

User ID, Name and E-mail. 
3. A drop-down list for Role is displayed. 
4. Choose the appropriate role for this user from the list.  See a brief description 

of these roles under the Group Roles tab, or see Roles Description for more 
information. 

5. Click OK. 
 
 

 
Edit Seat Dialog
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Delete Seat 

You can remove a user from the selected seat through this option.  You are asked to select a 
new user to assign to this seat. 
 
From the Administration tab, click on the Group Users tab at the top of the screen and 
your seats and their assigned users will be displayed. 
 

1. Click Delete on the toolbar. 
2. Select a user from the Seat List drop-down menu.  
3. Click OK. 

 
 

 
Delete Seat Dialog
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Group Roles 

Roles Description 

Roles determine what actions a particular user can perform with the application.  Roles are 
accessed by selecting the Administration tab at the top of the page then selecting the 
Group Roles tab. 
 

 
Group Roles Tab - Roles Description 
 
 
There are predefined default roles for Survey Author, Poll User, Report User, Expired 
Workgroup, Group Administrator and Survey Publisher and the permissions associated with 
these roles cannot be changed. The specific settings of the default roles can be viewed by 
clicking on the Name of the role.   
 
 

Create a New Role 

1. Click on the Create Role button. 
2. Enter a Role Name and Role Description in the text boxes provided. 
3. Select the check boxes for the desired permissions 
4. Click OK.
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New Role Dialog - Setting Role Permissions 
 

 

Copy an Existing Role 

1. Select the role to be copied by clicking the check box. 
2. Click the Copy icon in the upper left corner of the tool bar. 
3. Click the Paste icon. 
4. The new role is inserted in your list, labeled as 'Copy of OriginalRole'. 

 

 

Remove a Role 

1. Select the role to be deleted by clicking the check box. 
2. Click the Remove button.
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Permissions 

Permissions for a specified user role are set in this dialog when a role is created.  Editing of 
permissions is done in the same dialog by selecting or clearing the check boxes. 
 
The Role Name and Role Description are entered and displayed in text boxes at the top of 
the dialog. 
 

 
New Role Dialog - Setting Role Permissions 
 

Actions 

The Actions are shown as column headers at the top of the window.  The options are: 
 

• View:  Controls the ability to view the specified item. 
• Create:  Controls the ability to create the new item. 
• Edit:  Controls the ability to modify the item. 
• Delete:  Controls the ability to delete the item. 
• Translate:  Controls the ability to perform a translation of the item. 
• Import:  Controls the ability to import data into the item. 
• Export:  Controls the ability to save the specified item remotely.
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Note! 
Some actions cannot be performed on certain features.  If this is the case these 
items do not have a check box. 
 
 

Survey Administration 

• Surveys:  Controls the permissions for actions related to Surveys. 
• Mailing Lists:  Controls the permissions for actions related to Mailing Lists. 
• Invitations:  Controls the permissions for actions related to Invitations. 
• Responses:  Controls the permissions for actions related to Responses. 
• Reports:  Controls the permissions for actions related to Reports. 

 

 

Advanced Reporting 

• Portfolios:  Controls the permissions for actions related to Portfolios. 
• Reports:  Controls the permissions for actions related to Reports. 

  

Group Administration 

• Users:  Controls the permissions for actions related to Manage Seats. 
• Roles:  Controls the permissions for actions related to Roles. 

 

 

Miscellaneous 

• Images:  Controls the ability to upload images and delete images. 
• Surveys:  Controls the ability to open surveys and close surveys. 
• Invitations:  Controls the ability to send invitations. 
• Administration:  Controls the ability to view all surveys.
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Chapter Sixteen 

  Polls 
 
 
 
 
 
 
 

Discussed in this Chapter 
Polls Overview 
Polls Getting Started 
Create New Poll 
Select a Shared Poll 
Poll HTML 
Adding a Poll to a Web Page 
Tracking the Poll Results
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Polls 

Polls Overview 

Use:  The Polls option is used to create and work with your polls.  It is accessed by 
selecting the Polls tab from the navigation tabs at the top of the page. 
 
A poll is a quick and easy tool to enable people visiting your website to place a vote, or 
answer a single question, as well as see the results of the poll, allowing you to gain feedback 
from your visitors instantly.   
 
Go to the Polls Getting Started section for more information. 
 
The first time you view your poll workspace, it will be empty and you will be presented with 
the following options to choose from:  
 

• Create New Poll - You can define your own question and responses, as well as 
customize the presentation of the poll and results.  

• Select A Shared Poll - You can select from a list of predefined polls (the question 
and responses have already been created) and customize the presentation of that 
poll and results for your Web site. The Shared Poll combines votes from your Web 
site with votes from other Web sites that are using the same Shared Poll, giving you 
a larger base of votes no matter how much traffic your Web site receives.  

 
The Polls List Tool Bar contains options to Delete, Filter and Sort, as well as additional 
information on each poll including the Poll Title, the date it was updated and the number of 
responses. 
 
Using the Filter and Sort drop-down menus, you can control the display of your polls in the 
Polls List. 
 
The Filter drop-down menu contains the following categories to view your polls: 
 

• All 
• Shared 
• User 
• With Responses 
• Without Responses 
 

The Sort drop-down menu contains these options to sort your polls: 
 

• Title 
• Response Count 
• Last Updated

June 2007                                                                                                             Page 255 of 291 



EFM Feedback User Guide  Polls 
 

For each Poll you are able to perform the following actions:  
 

• Edit Poll - Edit that poll's content or style options.  
• Delete Poll - For both Regular Polls and Shared Polls, this action removes the poll 

from your Polls List.  For the user who created the poll this action permanently 
deletes the poll. 

• Preview Poll - Displays your Poll as it will appear to respondents.  
• View HTML - Provides the HTML code snippet of your poll to be inserted into your 

Web site.   

 

Requirements 

To include a poll into your Web page the following requirement must be met:  
 
Page edit rights - You must have rights to edit the Web page where you are placing the 
poll. 
 
JavaScript enabled - JavaScript is used to handle the poll vote submission, as well as 
poll/results display.  Browsers that do not support JavaScript will receive the following 
message "Your browser does not support JavaScript, therefore the poll cannot be 
rendered."  
 
Cookies enabled - Cookies are used to track voting.  When you vote, a persistent cookie is 
created on your machine.  This controls what you see once you have taken the poll.  If you 
have voted for a specific poll, then the results are displayed, otherwise the poll is 
displayed.   
 
Multiple polls can be placed on the same Web page and will act independently of each 
other.  Each poll has its own cookie value.  By default, one vote per respondent per poll is 
allowed. 
 
If you enable the View Results feature on the poll display, a cookie is created when they 
click View Results.  The results will then be displayed, but they will not be able to vote 
again until that cookie has expired. 
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Polls Getting Started 

A poll is a quick and easy tool to enable people visiting your website to place a vote, or 
answer a single question, as well as see the results of the poll, allowing you to gain feedback 
from your visitors instantly.   
 
You can Create A New Poll or Select A Shared Poll. 
 
The primary steps to getting started are:  
 

• Creating/Editing a Poll 
• Adding your poll to a Web page  
• Tracking your poll's results  

 
The first time you view your poll workspace, it will be empty and you will be presented with 
the following options to choose from:  
 

• Create New Poll - You can define your own question and responses, as well as 
customize the presentation of the poll and results.  

• Select A Shared Poll - You can select from a list of predefined polls (the question 
and responses have already been created) and customize the presentation of that 
poll and results for your Web site. The Shared Poll combines votes from your Web 
site with votes from other Web sites that are using the same Shared Poll, giving you 
a larger base of votes no matter how much traffic your Web site receives.  

 
The Polls List Tool Bar contains options to Delete, Filter and Sort, as well as additional 
information on each poll including the Poll Title, the date it was updated and the number of 
responses. 
 
Using the Filter and Sort drop-down menus, you can control the display of your polls in the 
Polls List. 
 
The Filter drop-down menu contains the following categories to view your polls: 
 

• All 
• Shared 
• User 
• With Responses 
• Without Responses 

 
The Sort drop-down menu contains these options to sort your polls: 
 

• Title 
• Response Count 
• Last Updated
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For each Poll you are able to perform the following actions:  
 

• Edit Poll - Edit that poll's content or style options.  
• Delete Poll - For both Regular Polls and Shared Polls, this action removes the poll 

from your Polls List.  For the user who created the poll this action permanently 
deletes the poll. 

• Preview Poll - Displays your Poll as it will appear to respondents.  
• View HTML - Provides the HTML code snippet of your poll to be inserted into your 

Web site.   
 
 
 
Note! 
When you remove or delete a poll from your account, be sure to remove the HTML 
snippet from any Web page(s) where you have included the poll.  If you do not 
remove the HTML snippet, users will see the error message: "WSPoll exception: 
Invalid Poll Display ID:"  
 
If you vote from the preview window, the vote will be stored and the results will 
then be displayed.  
 

 

Requirements 

To include a poll into your Web page the following requirement must be met:  
 
Page edit rights - You must have rights to edit the Web page where you are placing the 
poll. 
 
JavaScript enabled - JavaScript is used to handle the poll vote submission, as well as 
poll/results display.  Browsers that do not support JavaScript will receive the following 
message "Your browser does not support JavaScript, therefore the poll cannot be 
rendered."  
 
Cookies enabled - Cookies are used to track voting.  When you vote, a persistent cookie is 
created on your machine.  This controls what you see once you have taken the poll.  If you 
have voted for a specific poll, then the results are displayed, otherwise the poll is 
displayed.   
 
Multiple polls can be placed on the same Web page and will act independently of each 
other.  Each poll has its own cookie value.  By default, one vote per respondent per poll is 
allowed. 
 
If you enable the View Results feature on the poll display, a cookie is created when they 
click View Results.  The results will then be displayed, but they will not be able to vote 
again until that cookie has expired. 
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Create New Poll 

You can Create a New Poll quickly and easily by following the steps below.  
 

 

Define Your Core Poll Information 

1. Click the Create New Poll button. 
2. The first Create/Edit Poll dialog is displayed where you will define your core poll 

information. 
3. Enter the poll question. 
4. Enter the answer options for the poll question.  There are Count values next to the 

answer options with default values of zero (0).  You can change these Count values if 
you want your poll to appear initially with data counts rather than zeroes. 

5. Vote Button Text and View Result Button Text control what text shows for these 
buttons, and can be edited to suit your needs. 

6. Select the Style of Poll.  A poll can be "Choose One" or "Choose All That Apply." 
7. You can set a closing date for the poll at the bottom of the dialog by selecting the 

check box and entering the date on which you wish the voting to close. 
8. Click Next. 

 

 

Select Style Options 

1. Select the Font and Size of the text to be used in your poll from the drop-down 
menus. 

2. Select the Font Color.  You can type in a basic color name or use the color palette 
icon to select a color. 

3. Select the Background Color.  You can type in a basic color name or use the color 
palette icon to select a color.  A predefined background color can also be selected 
from the drop-down menu at the top of the dialog. 

4. Select the Result Bar Color.  You can type in a basic color name or use the color 
palette icon to select a color. 

5. Select the Border Color.  You can type in a basic color name or use the color palette 
icon to select a color. 

6. Select a Border Style and Width from the drop-down menus if you want your poll 
to have a border. 

7. You can define the size of your Poll/Chart Width in pixels.   
8. Select an option to display your results as percentages, counts or both. 
9. To see the total results count on the Results view of the poll, select the check box 

for 'Include total response count in chart.' 
10. To include a View Results link on the poll, select the check box to 'Include option to 

jump directly to results.' 
11. Click Finish to create the poll. 

 
Tip! 
If you desire a color that is not shown, you can enter the HTML hexadecimal value 
of the color in the text box.  A selection labeled 'custom' will be added to the drop-
down of defined colors at the top of the dialog.
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Note! 
Including a link to jump directly to the results from the poll page allows 
respondents to skip directly to the results without casting a vote. Respondents 
who click this link will continue to see the results until the poll is closed, or their 
cookie for that poll is deleted.   
 
The poll is now created and shown in the Polls List Pane.  You have the options to Edit the 
poll, Preview the poll, or go the Poll HTML. 
 
You must now add the poll to your Web page for voters to have access to it.
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Select a Shared Poll 

A shared poll is a predefined poll that includes votes taken from your Web site, as well as 
votes from other Web sites that are using that shared poll, giving you a larger base of 
respondents for your results no matter how much traffic your Web site receives. 
 
 

Steps 

1. Click the Select a Shared Poll button. 
2. Select a predefined poll from the list. 
3. Click Next. 
4. Customize the poll display options as needed.
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Poll HTML 

HTML to include in your Web page 
 
This is the HTML code you insert into your Web page that enables your poll to display.  You 
can copy it to your clipboard, then switch to your HTML editor for your Web site and paste 
this code into the appropriate location.   
 

<script language="javascript" type="text/javascript" 
src="http://desktop.vovici.net/wspoll.aspx?wsp_pollid=108"></script><noscript>Your 
browser does not support JavaScript, therefore the poll can not be 
rendered.</noscript><a target="_blank" id="WSPID_108" 
href="http://www.vovici.com/efmpolls"><font size="-2">Vovici Online Survey 
Software</font></a> 

 
 
Note! 
If you do not copy the entire HTML code snippet, or if you edit the HTML code 
snippet, your poll may not perform as desired.  
 
 
Alert! 
It is strongly suggested that you do not edit the HTML snippet for a poll though we 
realize that you may need to change the formatting of the HTML to a 
degree.   Please keep in mind that if you do edit the HTML snippet for a poll, each 
poll's script tag (<script>) must have an associated anchor tag (<a>) with an ID 
attribute matching the poll's id.  The text 'Vovici Online Survey Software' must also 
be included as part of the anchor.  If any of these required items are omitted, the 
voters will not be able to submit their votes.  
 
If you experience any problems with your poll functioning incorrectly, we suggest 
that you copy the HTML snippet "as is" from the Polls HTML page, and paste it into 
your web page.  This usually solves any issues of the poll working incorrectly.
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Adding a Poll to a Web Page 

When a poll is created, the application produces HTML code that must be added to your Web 
page to display your poll.  
 

Steps 

1. From the main Polls Page, select the specific poll you wish to add to your Web page. 
2. Click the HTML option to the right of the polls list. 
3. The HTML code snippet for your poll will be shown in the text box. 
4. In the text box, click and drag (or use Ctl-a) to select all of the script code. 
5. With ALL of the code selected, right-click and copy (or use Ctl-c) the HTML script 

snippet. 
6. Open the HTML page where you would like the poll to appear and paste the code 

snippet in the desired location.  
 
 
Once you have copied your poll into your Web page, it is ready to collect votes.  You can 
track the results in the main Polls Page.  When you wish to end your poll, simply remove 
the poll HTML snippet code from your Web page.  
 
Note! 
Once you have added your poll to your Web page, you can alter your poll (change 
the display style, add/remove options, etc.) without having to add the HTML code 
snippet into your Web page again as long as it is the same poll (i.e., the poll was 
never deleted).  
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Tracking the Poll Results 

Once your poll is active and you begin collecting responses, you can check your results from 
the main Polls Page.   
 
The Current Poll Statistics will be displayed for the currently selected poll in the Info 
Pane to the far right of the page. 
 
You can view the total number of responses and the percentage breakdown of each response 
option for that poll. 
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Chapter Seventeen 

  How Do I Login? 
 
 
 
 
 
 
 
 
Discussed in this Chapter 

Account Login 
Forgot Your Login?
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How Do I Login? 

Account Login 

To gain access to your account, you must enter your User ID and Password.  Both of 
these fields are case sensitive!  Click Login once information is entered. 
 

 
Login Dialog 
 
 
Access to the account is allowed from one workstation at a time.  Accounts should not be 
shared by users and logins should be unique to an individual.  If the account has multiple 
seats, the account holder should reassign the seats to individual users. 
 
If you cannot remember your User ID and/or Password, you can click the Forgot Your 
Login? link and the system will prompt you for information and will guide you through the 
reset process through email. 
 
 

 
Register For An Account Dialog 
 
 
If you don't have a User ID and would like to register for an account select the link to Sign-
up today - it's free!
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Forgot Your Login? 

If you have forgotten your User ID and/or Password, the system can provide your User 
ID to you through E-mail along with a request to reset your password. 
 

Steps 

1. Click Forgot Your Login? 
2. Enter your E-mail Address in the text box. 
3. Click Submit.  You are redirected back to the application Login Page.  An E-mail will 

be sent to you containing your User ID and a link is provided along with instructions 
about how to reset your password. 

4. Enter your User ID and click Submit.  Your new password is generated by the 
system and sent to you in an E-mail. 

5. Copy (Ctl-C) the new password from the E-mail and then click the link provided in the 
E-mail to get back to the Login page. 

6. Login with your User ID and paste (Ctl-V) or type in your new temporary password, 
click Submit. 

7. A Password Expired screen will be displayed.  Enter the information as 
required.  For Current Password, use the password the system just generated for 
you. 

8. In the text boxes below the Current Password, you will assign a new password and 
confirm it. 

 
 
Note! 
Passwords are case sensitive and must be at least 6 characters in length. 
Passwords cannot contain the User ID or E-mail address.
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Chapter Eighteen 

  Frequently Asked Questions (FAQs) 
 
 
 
 
 
 
 
 

Discussed in this Chapter 
FAQs Overview 
Survey FAQs 
Polls FAQs 
Mailing Lists FAQs 
My Account FAQs 
Administration FAQs
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FAQs 

Frequently Asked Questions (FAQ) Overview 

Welcome to our Frequently Asked Questions (FAQ) section.  The FAQs are listed 
according to major functional areas.  You can view the questions for the specified areas by 
visiting the topics below: 
 

• Surveys FAQs 
• Polls FAQs 
• Mailing Lists FAQs 
• My Account FAQs 
• Administration FAQs
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Surveys FAQs 

What is a required question?   A required question is a question in your survey that must 
be answered before the respondent can leave the current page or submit the survey.  The 
question can be set to Required from the Question List Pane Tool Bar or from within the 
question itself when editing.    
 
How do I change my survey display template?   You can change your display template 
under the Presentation option on the Display Template tab.  Navigate to the Feedback Home 
Page and select a survey title in the List Pane.  Now select Edit Survey from the Options 
Pane.  Click the down arrow next to Properties and select Presentation.  Click the Display 
Template tab and select a template to use for your display from the drop-down list.    
 
How do I preview a specific page in my survey?   While in the Edit Survey option (Edit 
tab under Feedback), you can click Preview to see how your survey will appear to your 
respondents.  Once in Preview, you can navigate to a specific page by using the Preview 
Specific Page drop-down list in the right corner just above the survey display.  
 
How do I restrict access to my survey?   There are two main methods to restrict access 
to your survey.  One method is through the Title, Text & Limits option on the Limits 
Tab.  Navigate to Feedback/Edit Survey (Edit Tab)/Properties drop-down menu/Title, Text & 
Limits/Limits Tab. Another method is to add a gateway to your survey.    
 
Can I use conditional logic in my survey?   You can implement conditional logic that 
directs your respondents to specific parts of your survey based on their answers to a 
particular question(s).  See the Page Break/Conditional Logic topic for more details.   
 
How do I test my conditional logic question?   You can test your conditional logic by 
Previewing your survey and answering the questions where the conditional logic is 
used.  To navigate to a specific page, use the Preview Specific Page drop-down 
list.  Select the page where the question is located and that page will display.  This will 
eliminate scrolling through the entire survey.  
 
How do I require a matrix question in a survey?   You can require the entire matrix 
question by selecting the check box next to the specific matrix question in the Question List 
and clicking the Required button in the Editing Tool Bar.  You also have the ability to 
Require only certain categories when you edit the question by going to the Advanced Tab 
and selecting the check box for the category you want to Require.  
 
How can I get a printed copy of my survey questions?   There are two ways you can 
print your survey questions.  From the Feedback/Edit tab, while editing your survey, you can 
click the Print icon, or you can export your survey to MS Word or Adobe PDF and print from 
those files. Note: Exporting to Word and PDF are available from this same screen.  
 
How do I export my survey to MS Word or Adobe PDF?   From the Feedback/Edit tab, 
click the icon (Word or PDF) for the file type you desire. A dialog is displayed with options to 
Open or Save the file.  When saving the file, name the file as necessary and browse to the 
directory of your choice.  
   
Once I finalize my survey, how do I publish it?   The Publish Tab is located under 
Feedback/Publish when you select Edit Survey.  Once you navigate to this location, simply 
select the 'Publish' button.  You can also access Publish from Feedback/Publish Survey.  Click 
the Publish button in the upper left corner.   
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How do I invite people to take my survey?   The most common method (which is also 
highly recommended by Vovici) is to use the Mailing Lists feature and send a 
campaign.  You can also set up different methods through your Web page that will take 
people directly to your survey, or display a popup asking them if they would like to take the 
survey.    
 
How do I change my chart display in Analysis?   The chart type is changed by using the 
Chart Type drop-down list on the Analysis Tab. Navigate to Feedback/Analyze and select 
the down arrow next to Chart Type.  Note: The chart types available for each question are 
dependent on the type of question.  
 
How do I create a filter in Analysis?   Filters are created in Analysis using the Filter 
Data option located under the Actions drop-down menu. You will specify the parameters of 
the filter and when implemented, only those results that meet the filter criteria will be 
displayed.    
 
How do I export my data to Excel?   Navigate to the Feedback/Analyze tab and from the 
Actions drop-down menu, select Export Data/CSV and select the questions you want 
included in this export.  To select only certain questions, hold down the Control (Ctrl) 
key and click the desired questions with your mouse.  To select all the questions, click the 
first question, hold down the Shift key, and then click on the last question.  See the 
Exporting Your Results topic for more information.    
 
How do I generate a report?   Reports are generated from the Report Tab when you 
select Edit Survey from the Feedback Home Page.  The report includes options that are set 
on the Analysis Tab as well as those set on the Report Tab.  Select the report type to 
generate from the Actions drop-down menu.    
 
Is EFM Feedback 508 Compliant?   Yes, but when creating surveys with Vovici’s EFM 
Feedback application you must ensure that any graphic contained in the survey uses an Alt 
Tag description of the graphic.  In addition, some users of screen reader applications have 
difficulty with table-oriented structures such as those used in a matrix question.  Technically, 
while the matrix questions are still 508 compliant, Vovici recommends that you do not use 
this type of question if you need to adhere to a strict usage of 508 compliance.  The Vovici 
interface itself has not been reviewed for technical 508 compliance.  
 
How do I add an Alt Tag Description?   When a logo is inserted through the display 
template to show at the top of each page, an alt tag which reads ‘Logo’ is automatically 
inserted.  If an image is inserted elsewhere in the survey, i.e., in a question, the alt tag 
must be manually inserted in the HTML code of the question. 
 
Steps to insert Alt Tag manually 

1. Click the question text to edit it. 
2. Click the <> icon in the lower left corner directly beneath the question text         

 box.  This displays the question in HTML format. 
3. The alt label is inserted in the code describing the image.   

Look for <img  alt=””…… 
Insert your alt label text inside the quotation marks. 
Click OK. 
Example: <img alt="ccb logo" src="/images/users/16828/ccb_logo.gif">

June 2007                                                                                                             Page 273 of 291 



EFM Feedback User Guide  Frequently Asked Questions 
 

 
How do I move my survey from Survey Solutions into EFM Feedback?   First export 
your survey from Survey Solutions to a MS Word file.   
 
To export 
1. Select the survey from the Survey Pane. 
2. From the Actions menu, select Export Questionnaire. 
3. Choose MS Word as the format. 
4. Save the MS Word file to the desired location on your computer. 
 
Next format the questions and responses in MS Word according to the requirements 
described in the topic Creating Survey Questions Using MS Word.  Once this is 
completed the survey can then be imported into EFM Feedback from MS Word.  
 
Will my survey data transfer from Survey Solutions into EFM Feedback?   If your 
survey has collected responses in Survey Solutions, the data will not transfer to the EFM 
Feedback application automatically.  However, it is possible for our Services Department to 
perform this operation for you. Please contact Services for further details.  
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Polls FAQs 

How do I create a poll?   Navigate to the Polls Page by selecting the Polls tab.  Your 
options are 'Create a New Poll' or 'Select a Shared Poll.'  
 
How do I change the colors of my poll?   Poll colors are specified when you create or 
edit your poll.  For example:  Navigate to the Polls Page, select a Poll from the Polls List 
Pane and select Edit Poll.  The Create/Edit Poll dialog displays and you select your core 
information.  Once you select 'Next' another dialog appears that contains a drop-down menu 
labeled 'Select a Style.'  Click this arrow and your color options display.  
 
How many response options can I have for my poll question?   The response options 
are specified when you define your core poll information. You can specify up to ten (10) 
response options for your poll.  
 
Can a respondent select more than one answer when answering my poll?   A poll 
can be set up as either Select Only One or Select All That Apply.  This option is specified 
on the first dialog under Create New Poll.  
 
How are my poll results displayed?   Poll results are displayed on the poll itself and are 
also displayed on the main Polls Tab for the particular poll that is selected.  Results can be 
shown as a Percentage, Count, or both.  
 
Can I change the display size of my poll?   You can specify the size of your poll by width 
on the second dialog during the create/edit process where Style options are set.  Width is 
specified in pixels and defaults to 150.  
 
Can I preview my poll before it goes 'live'?   You can preview your poll by selecting it 
from your Polls List Pane and selecting the Preview Poll option.  
 
Can I have more than one poll on my web page?   Multiple polls can be placed on the 
same Web page and will act independently of each other.  
 
How do I remove a poll from my web page?   You will select the Poll from your Polls List 
Pane and click the Delete icon.  A verification dialog will be displayed before the poll is 
deleted.  You also have to remove the HTML code of the poll from any Web pages that were 
displaying the poll. 
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Mailing Lists FAQs 

What is a Mailing List?   A Mailing List is the list of recipients that will be invited to take 
your survey.  It will contain the E-mail addresses of the recipients as well as any other 
information that may be passed into the survey results.    
 
How do I create a Mailing List?   Creating a mailing list involves two main steps.  You 
create the list structure and give it a name, and then you add data to the list.  See the 
How To Create A Mailing List topic for more information.    
 
How do I add data to my Mailing List?   Data can be added to your mailing list manually 
or by importing data from an external CSV (Comma Separated Values) file, usually viewed in 
Excel.  There is also an option to Add Multiple E-Mails which can be used to easily add E-
mail addresses to your list.    
 
What is a campaign?   A campaign is the mechanism that associates your survey with 
your mailing list.  It is where you create the message text that will be sent to the recipients 
in your mailing list inviting them to take part in your survey.  
 
How do I create a campaign?   Navigate to the Mailing List Page and select your Mailing 
List from the List Pane.  Next select the Manage E-mail Campaigns option and click 
Create New Campaign to set up the parameters and text for your message.    
 
What is a gateway survey?   A gateway survey page allows you to place limits on who 
has access to your survey by requiring them to log in before taking your survey.  The login 
values on the gateway page are verified against the values in your mailing list.  See the 
Create New Gateway topic for more information.     
 
How do I create a gateway survey?   From the Mailing List Home Page, select a mailing 
list from the List Pane and select the Gateway Surveys option from the Options 
Pane.  From the Gateways Tab you select Create New Gateway to begin the process of 
building a login page for your survey.    
 
How do I track the respondents who submit my survey?   You can capture an E-mail 
address or specific information from a column in your mailing list through the campaign 
field mapping process.  If you are using a gateway page, tracking is done through field 
mapping during the gateway page setup.    
 
Can I send a test message before I send the campaign to my entire mailing list?   It 
is recommended that you send a test message before scheduling your campaign.  Select the 
Send Preview tab to send a test message to the E-mail address you specify.    
 
How do I send my campaign?   There are two ways to send your campaign.  One way is 
to select the check box next to “Schedule message to be sent in 10 minutes” on the 
Campaigns Message Edit dialog, which will send your message out ten minutes from the 
time you click OK.  Or you can schedule it for a later day and time by using the calendar 
icon on the Campaign Messages dialog.   To access the scheduling dialog for your campaign, 
navigate to the E-mail Campaigns tab and click the title of the campaign that you want to 
schedule.  It is located in the List Pane (under the Subject column).  The Campaign Message 
dialog displays.  Under the schedule column, select the calendar icon and choose the date 
and time you want to send out your invitation.    
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Why hasn’t anyone received my invitation?   E-mail addresses must be in the 
predefined E-Mail column for the invitation to be sent.  To check this, select your list from 
the List Pane on the Mailing Lists Home Page and click Edit Mailing List.  When your 
mailing list opens, verify that the E-Mail addresses are in the E-Mail column.  You can also 
check the campaign by selecting your list from the Mailing Lists Home Page and clicking 
Manage E-Mail Campaigns.  On the E-Mail Campaigns tab, select your campaign (from the 
Subject column) then click on the Message Recipient List tab.  Status counts for the 
invitations will be displayed that track whether invitations were sent successfully or if an 
error occurred. Error messages will be displayed on this tab.  
 
How do the Reminder, Follow Up and Thank You features work?   A Reminder 
campaign sends a message to everyone in the mailing list that has not yet submitted the 
survey.  A Follow Up campaign sends a message to everyone in the mailing list.  A 
Follow Up campaign might be sent to recipients to provide additional information or make a 
correction to the original campaign message.  A Thank You campaign sends a message to 
everyone who has submitted the survey.    
 
How do I check the status of my invitation?   There are a series of counts that track 
status of different aspects of your campaign delivery. The counts are Base, Success, 
Bounce, Click and Submit.  These counts are displayed for the selected list when you 
choose Manage E-mail Campaigns.  They are also displayed on the Campaign Messages 
dialog when you select a specific campaign to view.    
 
How do I use hidden fields with my Mailing List?   Hidden fields can be used to pass 
data from your mailing list into your survey results.  The hidden fields must be contained 
in your published survey.  They are added as questions at the top of your survey.  The field 
mapping in the campaign then associates the survey with the mailing list. When the 
survey is submitted, the respondent's values are retrieved from the mailing list to populate 
the hidden fields.  The data values will then be displayed in your survey results.  
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My Account FAQs 

How do I change my profile information?   Your profile information is located on the My 
Profile tab under the My Account Home Page.  You can change personal account 
information for first and last names, your E-mail address and your secret question and 
answer.  
 
How do I change my password?   You can reset your account password on the My 
Profile tab under the My Account Home Page.  Enter your current password, then specify 
and confirm the new password.  
 
How do I change my question Preferences?   Question preferences are specified on the 
My Preferences tab under the My Account Home Page. These default settings are 
applied when you create a new survey.  They do not apply to existing surveys.    
 
How do I change the default colors for my matrix questions?   Default colors for 
matrix questions are specified under My Preferences.  You can change the header color, 
odd column color and even column color.  Use the color palette icon to choose your colors or 
type in the HTML hexadecimal value for the color if you know it.    
 
Can I change the fixed length of text responses or comments?   The default length for 
comments and text questions is specified under My Preferences.  Specify the desired 
length in characters up to a maximum of 250.  
 
Can I suppress question ID numbers from displaying in my Question List?   Each 
question and response option has a unique internal ID number (wsb number) associated 
with it.  You can suppress the display of these ID numbers under My Preferences by 
selecting the check box to 'Hide wsbid's in Question List.'  
 
How do I view and manage my personal libraries?   Personal libraries are listed on the 
My Library tab under the My Account Home Page. They are divided into four 
categories:  My Questions, My Responses, My Survey Templates and My Report 
Templates.  You can view any saved personal libraries in these categories and delete them 
from the My Library tab if necessary.  
 
How do I upload a logo into my account?   You can upload a logo into your account 
using the My Images tab under the My Account Home Page.  Images can be previewed 
and deleted from this tab as well.    
 
How do I preview a logo in my account?   Click on the My Images tab from the My 
AccountHome Page to see a list of logos that are uploaded into your account.  Each logo 
will have its name, size, and a Preview link displayed.  Click the Preview link to display the 
logo. 
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Administration FAQs 

How do I assign a new user to an available seat?   You can assign a new user to an 
available seat on the Group Users tab under the Administration Home Page.  Click on 
the Assign New button and enter the requested information.  
 
How do I remove a user from an assigned seat?   You can remove a user from an 
assigned seat on the Group Users tab under the Administration Home Page by selecting 
Reassign Existing or Delete.  
 
How do I change the role assigned to a particular user?   Navigate to the 
Administration Home Page and select the Group Roles tab.  If the role is not a default 
role, you can click on the Role Name and edit the permissions of the role.  Default roles 
cannot be edited.  
 
How do I create a new role?   On the Group Roles tab under the Administration Home 
Page, click Create Role.  You'll enter a name, description and select the desired 
permissions for the role.    
 
How do I set up permissions for a new role?   Permissions for a new role are specified 
when you create a new role.  Select Create Role from the Group Roles tab and simply 
select the check boxes for the desired permissions.    
 
Can I edit permissions on a role that is already created?   You can edit the 
permissions on an existing role if it is not a default role.  
 
How do I remove a role?   All the roles are listed on the Group Roles tab.  Select the 
check box of the role you want to remove and click the Remove icon.  
 
How do I see a listing of all my users and their assigned roles?   Go to the Report 
Users tab under the Administration Home Page to see a list of all your users and their 
assigned roles. 
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Glossary 

A 
Analysis text: An abbreviated version of the question text to enable complete display on an 

analysis graph without truncating. 

API: Application Programming Interface 

B 
Base count: The total number of recipients in your mailing list. 

Bounce count: The number of E-mails that were not successfully delivered to recipients in 
your mailing list. 

C 
Campaign: The mechanism that associates your survey with your mailing list. It is where 

you create the message text that will be sent to the recipients in your mailing list 
inviting them to take part in your survey. 

Click count: The number of recipients who clicked on the survey URL. 

Closing text: Text that shows at the end of your survey just above the Submit button. 
Generally used to thank respondents for taking the survey. 

Cluster report: Uses a specific question in your survey to base the report on and then sets 
a filter for every unique response option for that question in your data. Reports for 
each response option are produced as links. 

Conditional logic: Logic is set up through a page break. The user is branched forward in 
the survey to a particular location based on the answer(s) to previous question(s). 

Conditional page break: The mechanism used for defining conditional logic. This is a 
question type that is first added to your survey then your branching logic is added. 

Cross tabulation: In Analysis, this is the ability to compare two questions to each other 
and evaluate relationships between the responses of those questions. 

CSV file: Comma Separated Values file used to import data into a mailing list. Usually 
created and saved from Excel application. 

D 
Data piping: Passing the value of a response to a survey question forward in the survey to 

be displayed in another location. 

Display template: Predefined HTML template that controls the display of your survey. 

E 
Executive summary: Comments or summary text that can be entered in Analysis to be 

displayed in your report.
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Export data: Download the survey data from the application into a CSV (Comma Separated 
Values) file or a file compatible with SPSS (Statistical Package for the Social 
Sciences). 

Export text: An abbreviated text version of a question or response option that is used in 
the export data process to avoid truncation of lengthy text. 

F 
Field mapping: A method to associate values in a mailing list and campaign. In a mailing 

list, field mapping ensures the data is imported into the proper columns. In a 
campaign, data in the mailing list is associated with certain fields in the survey to 
ensure values from the mailing list will be displayed in the survey results. 

Filter data: Set a conditional filter against your survey results so that you view a specified 
subset of your data. 

Follow Up campaign: A campaign that sends a message to everyone in your mailing list. 
This might be used to provide additional information or corrections after the initial 
campaign has been sent. 

G 
Gateway survey: A gateway survey has a login page so that you can restrict access to your 

survey. Login values are validated against the data in your mailing list. 

H 
Hidden field: A question type that is added at the top of your survey. The hidden field is a 

variable that is used to collect data values from your mailing list so that respondents 
do not have to enter those values in the survey. 

HTML: (HyperText Markup Language) Programming code that is used to markup pages for 
display on the Web. 

Hyperlink: Any standard HTML link that you click on to view an image or a Web site. 

I 
Image Manager: An icon on the Question Editing Tool Bar that enables you to browse, 

select or upload images into your survey. 

M 
Mailing list: The list that contains all the recipients E-mail addresses and other related 

information that is used to send your survey invitations out. 

Mean: A statistical calculation that is the average value. It is the sum of the values divided 
by the total number of values. 

Median: A statistical calculation that is the middle value. The median is the number in the 
middle of a set of numbers; that is, half the numbers have values that are greater 
than the median, and half have values that are less. 

Mode: A statistical calculation - the mode is the most frequently occurring value.
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O 
Opening text: Introductory text that is displayed at the beginning of your survey. It is 

usually used to welcome respondents and provide instructions or information about 
the survey. 

P 
Page Break Wizard: A tool that enables you to automatically insert simple page breaks at 

equal intervals throughout your survey. 

Permissions: Settings for actions or abilities that are specified by an Administrator that 
control what accesses you have in the application. 

Persistence: The ability to resume a survey on the page where you left off and have your 
previous responses stored in the event that you could not complete the survey in one 
sitting. 

Piped field: A response value that is passed through a variable from one survey question to 
be displayed at another location in the survey. 

Poll: A tool that allows you to post a single question with up to 10 response options on your 
Web site. It is best used for quick simple queries when you need immediate feedback. 

Post-Field text: User-defined text that will display after the text box in the item. 

Pre-Field text: User-defined text that will display before the text box in the item. 

Preview: The ability to view an individual question or an entire survey to see how it will be 
displayed before it is deployed to your survey audience. 

Progress bar: A real-time status bar in your survey that provides information to the user 
on how much of the survey has been completed. It can be expressed as 'page x of x' 
or as a percentage complete. 

Public report: A report option in the application that creates your report and produces a 
URL to access the report for users outside the application. 

Publish survey: Publishing your survey permanently saves your changes and produces the 
URL to be used to access the survey that you will provide to your survey respondents. 

Purge results: The act of deleting your survey data. This option deletes ALL survey results. 

Q 
Question library: Contains predefined questions with response options in various 

categories that can be selected and imported into your survey. 

R 
Raw data: The actual responses submitted by your survey respondents. Raw data can be 

viewed and temporarily edited. 

Recipient filter: A user-defined filter on your mailing list so that only a specified portion of 
the list receives E-mail invitations to take your survey.
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Redirect URL: A web address that can be entered under Title, Text & Limits that will send 
the user to the specified address when they submit your survey. 

Reminder campaign: A campaign that sends a message to everyone in your mailing list 
that has not yet submitted your survey. 

Report template: Predefined HTML template that controls the display of your report. 

Republish: Republishing updates your published survey with any changes you have made 
since the last publish. Changes are initially contained in a working version of the 
survey until it is republished. 

Reset results: When you analyze your survey data, you are working with a local copy of 
the data rather than accessing the database on the server directly. Selecting Reset 
Results clears your local copy of the data and sets your results count to zero (0). 

Response library: Contains predefined response options in various categories that can be 
selected and imported into your survey question. 

Response option: A possible answer option that is defined for a particular question in your 
survey. 

Role: Roles determine what actions a particular user can perform with the application. For 
example, if your role is Survey Author, you can create but not publish surveys. Roles 
are managed by a Group Administrator. 

S 
Sampling rate: Sampling is used in campaigns to enable you to send to your entire mailing 

list (100% sampling), or to a random percentage sampling of your list. Example: If 
you select a sampling rate of 25%, the application will send the campaign invitation 
to a random 25% of your mailing list. 

Seat: A slot (subaccount) under an account that entitles the user to access the account. A 
seat is assigned a specific role and permissions within the account. 

Shared poll: A shared poll is a predefined poll that includes votes taken from your Web site, 
as well as votes from other Web sites that are using that shared poll, giving you a 
larger base of respondents for your results. 

Simple page break: A question type that is added to your survey to create a new page 
(screen). A simple page break has a specified action but is not based on a specific 
answer to a previous question. 

SSL: SSL is an acronym for Secure Sockets Layer. Publishing your survey with SSL enabled 
provides additional security and data encryption. 

Standard deviation: The standard deviation is a measure of how widely values are 
dispersed from the average value (the mean). The standard deviation is the square 
root of the sum of the squares of the difference in each value from the mean divided 
by the total number of responses. 

Step value: Step value is accessed through the Number option on numeric value defined 
questions. The Step Value plots each response point within the numeric range that is 
defined for the question. A larger step value can be assigned for questions with a 
larger numeric range to make analysis more efficient. 

Subaccount: Synonymous with "Seat". 

Submit count: The number of recipients in your mailing list that submitted your survey.
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Success count: The number of addresses in your mailing list that were successfully 
delivered. 

Survey Detail Report: A summary report of the settings and parameters contained in your 
survey. 

Survey history: A archived list of actions that have been taken against the selected survey. 

Survey URL: (Uniform Resource Locator) This is the link to your survey that is produced by 
the application through the publish process. 

T 
Text mask: A user-defined format that requires responses for that field to be in the 

designated format. 

Thank You campaign: A campaign that sends a message to everyone who has submitted 
your survey. 

U 
UDF field: User Defined Field that is utilized in an E-mail campaign to pass in data values 

from your mailing list to personalize your message. 

Unsubscribe recipients: This option applies a text file containing E-mail addresses that 
you want to remove from your mailing list and deletes the E-mail addresses from 
your mailing list. 

Update results: Downloads results from the server into the application for analysis. The 
option will download any new responses that have been received since the last 
Update Results. 

W 
WSB number: Vovici Internal ID Number (Question/Response Options). 

WSX file: The actual survey file (.wsx) produced from the legacy desktop version of the 
application. 
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Add New Question..52, 54, 78, 92, 97, 

150 
Add New Survey Gateway .....107, 125 
Add To Filter ..............................219 
Add To Library icon .....................150 
Administration ...... 244, 246, 248, 249 
Advanced Tab....................... 92, 101 
Allow Public Report...............225, 230 
Analysis 

navigating.................................14 
Analysis.......................................14 
Analysis.......................................98 
Analysis.....................................199 
Analysis.....................................204 
Analysis.....................................215 
Analysis.....................................228 
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Count .................................146, 259 
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148 
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View/Edit ................................223 

Data ...........................................89 
Data .........................................217 
Data .........................................223 
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Gateway Surveys .. 107, 125, 127, 129 
Generate Reports.... 50, 225, 227, 230 
Getting Started...........................257 
H 
Help System.................................17 
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www.vovici.com

About Vovici

Vovici is the leading provider of Enterprise Feedback Management (EFM) solutions,

online survey software and research services to decision makers in the enterprise,

research and government markets. As a leader and visionary in the EFM space, the

company offers innovative solutions and a clear consistent path to EFM adoption.

Organizations worldwide rely on Vovici to help them better identify employee,

customer and partner needs and act on that information in order to create long-

term relationships, increase profitability and facilitate time-critical actions that

drive business results. Vovici has been named to the Inc. 500, Software Magazine’s

Software 500, Deloitte Fast 500 and Deloitte Fast 50. The company operates in five

countries, with a customer base that includes more than half of the Fortune 500.

Visit http://www.vovici.com for more information.
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